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Introduction to
VersaCAR/VersaIMAGE

Welcome to VersaCAR™  for Windows, VersaIMAGE™  or VersaVIEW™ !

This family of products, brought to you by VersaIMAGE Software Corporation, provides you with a complete hybrid document 
storage and retrieval system.

VersaCAR for Windows is a full featured networked or stand alone PC Microsoft Windows based microfilm CAR indexing
and retrieval system which may be expanded at any time to include electronic image management.  External database
information from other computer systems can be utilized using VersaCAR's easy to use import and export utility. VersaCAR for
Windows includes a request spooler for processing microfilm print requests from end users over a network.  Requested
document prints are routed via VersaCAR to fax, mail or internal mail facilities for distribution.  Microfilm scanners may be
used in conjunction with VersaCAR to produce scanned microfilm images for fax, print, E mail and image storage (TIFF G4)
off-line (on-line with VersaCAR-PLUS and VersaIMAGE).

VersaCAR for Windows contains software drivers for popular micrographics cameras and most micrographics retrieval
controllers on the market.  Depending on the sophistication of these controllers, VersaCAR may provide some or fully automatic
film control.  VersaCAR offers a user friendly application generator for unlimited applications and a fully functioning auxiliary
microfilm controller keyboard which is displayed on the computer monitor screen.

VersaSCAN II is an additional software module which is available for manual or automatic filming including Bar Code
recognition with automatic indexing right into VersaCAR's database. Two types of Bar Code systems are available: 1. Full RS-
232C control or 2. Keyboard Wedge type interfaces.  Currently available for: Minolta DAR 2800/Alos 42 cameras, Minolta
1600, Canofile 100 and others.

VersaIMAGE for Microfilm: Extends VersaCAR for Windows to allow electronic image input from microfilm scanners. Full
microfilm (Roll/Frame) and electronic image (TIFF Group-4) management is maintained.  VersaIMAGE may be used with all
ISIS compatible microfilm scanners.  The system may be configured to limit microfilm retrievals to first time only events.
Because microfilm scanners scan all images, be it for fax, print, image view or data entry purposes, all such scanned images
may be stored and cross referenced in the VersaIMAGE database.  Thus VersaIMAGE allows continued conversion of microfilm
images to digital images in normal daily use.  Significant time savings can be achieved with the elimination of microfilm
retrievals of the same image(s) in the future.  External images and data may be imported and exported by the system.

Automatic Film Conversion Mode: This mode allows automatic scanning of microfilm rolls.  Entire rolls or sections of rolls
may be scanned and / or printed (for quality control purposes) by range. file blips or via manual intervention.  The use of
intelligent microfilm controllers is required in order to perform these automatic scanning functions.

Automatic electronic file folder generation:  Certain microfilm controllers (Canon FS-1&2, Minolta MARS 3 & 4, 3M
PageSearch, Kodak IMT 350, Bell & Howell IMAGE SEARCH/VISCO, etc.) have the ability to respond back to VersaIMAGE
with file/page information.  VersaMAGE is then able to automatically create electronic file folders on multi level, blipped
microfilm with automatic insertion of scanned images into appropriate new electronic folders.  Most unblipped microfilm may
also be converted automatically with the addition of a microfilm controller and an image / page sensor on the microfilm screen.

Hybrid VersaIMAGE for Paper, or Paper and Microfilm scanning and retrieval applications:  Extends VersaCAR for
Windows to allow electronic image input from ISIS compatible paper scanners with full microfilm (Roll/Frame) and electronic
image (single and multi image TIFF Group-4) management.  Single or batch scanning modes with batch cards are supported.
External indices are easily appended to image files with VersaIMAGE’s append module.  VersaIMAGE allows optional image
input from microfilm scanners as well as paper scanners and external image and data files.  Image indexing from predetermined
bar code or OCR “zoom” zones and automated re-scan management increases indexing productivity.  For image distribution
from active microfilm applications VersaIMAGE offers full microfilm image edit functions with integrated Fax/E-Mail image
management.
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VersaVIEW is an inexpensive image viewer which allows the expansion of VersaIMAGE users on a network or stand alone PC
systems.  It can be used on the same network or off-line on independent PC systems for later import of images and
corresponding data into VersaIMAGE data bases.

Summary:

VersaIMAGE is the true fully hybrid image management solution which arrived from the microfilm management sector.
Microfilm has been effectively used to manage large paper files for over twenty  years.  This thorough experience in dealing
with paper and microfilm records is readily apparent to the VersaIMAGE user.  VersaIMAGE provides excellent flexibility
and top records management performance at a very reasonable price.

The founders of VersaIMAGE Software have significant experience in the imaging industry.  Micrographics experience was 
gained through the invention, development, sale and distribution of VISCO— industry’s first microprocessor-controlled
microfilm controller— in 1975.  Many VISCO intelligent microfilm controllers for Canon, Minolta, Bell & Howell, 3M
and Kodak are still in active use today around the world.  The development of several major electronic imaging service bureaus
rounded out this experience in the last 20 years, resulting in the development of CAR, service bureau, and check 
retrieval management software products for both microfilm and electronic imaging applications.
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  Features

VersaCAR is an extremely flexible program.  It adapts to your organization’s needs and accommodates everything from a single
user running a computer that is directly attached to a microfilm reader to a multi-user system with microfilm libraries in remote
locations.  The image integration capabilities provided by VersaIMAGE provides further flexibility by keeping copies of your
documents at your fingertips.

VersaCAR VersaImage VersaView
INDEXING:

Indexing at Microfilm Reader a  a
Indexing at Microfilm Camera a  a
Indexing from Paper a  a
Indexing Images a
Automatic Scanner Indexing a

   Bar Code Indexing
   OCR Indexing
DOCUMENT RETRIEVAL:

Hardware Software
a

Exact, Starts With, Contains Text
Searching

a  a  a

Wild Card Text Search a  a
Numeric Range Search a  a  a
Date Range Search a  a  a
Reader/Printer Print a  a
Document Image Print a  a
Document Image Faxing a  a
Document e-mail a  a

   Retrieval Requests a  a  a

IMPORT/EXPORT:
Flat Ascii Import a  a
Comma Separated Import a  a
Flat Ascii Export a  a
Comma Separated Export a  a
Image Import a

IMAGING FEATURES:
Multi Level TIFF support a  a
Document Rotate a  a
Document Deskew a  a
ISIS Film Scanner Support a
ISIS Paper Scanner Support a
TWAIN Support avail. 2003

OTHER FEATURES:
Multi-level Security System a  a  a
QC Module to easily correct entry
errors

a  a

Database Creation a  a  a
Database Compact a  a  a
Database Repair a  a  a
CD Pre-Mastering a
Online Help a  a  a
VersaScan II Option availability a  a



2b       VersaImage/VersaCAR/VersaView User’s Guide

  System Requirements

VersaCAR, VersaImage and VersaView can run on either a single-user system or on a network. Basic system requirements are:

VersaCAR for Windows VersaIMAGE / VersaView

486 or above IBM PC or compatible Pentium PC recommended

32 MB RAM  256 MB RAM

200 MB hard drive 500 MB for average systems  (1GB or more for
larger systems)

High density floppy drive,

CD for Win-95, 97, 98, NT

CD for Viewing, CD-R, DVD-R.

Windows™   3.1 Windows for Work Groups™  or
Windows 95, 97, 98, NT™

Windows  98, ME, NT™ , 2 0 0 0 , X P - P R O

VGA monitor Super VGA monitor or higher resolution.

  Peripherals

• Microfilm reader/printer with controller interface (see Appendix for a list of supported devices)

• Microfilm camera with controller interface (see Appendix for a list of supported devices)

• Laser printer (must be a Windows supported device)

• ISIS or TWAIN paper and microfilm scanners

• Fax and e-mail (must be Windows supported)

• CD-R and DVD devices (VersaIMAGE provides pre-mastering of data files)

  Support

VersaIMAGE Corporation offers SITE LICENSE PLUS Service.  This enables you to call our support line between 9:00 AM and
5:00 PM Eastern Standard Time.  You will also receive all upgrades to your software on an annual basis:

Additionally, you may purchase on-line modem support.  This permits VersaIMAGE support personnel to call directly into your
computer and allows for a more timely resolution of problems than standard telephone support.



1  Installing
the Software

The VersaCAR/VersaImage/VersaView software programs are self-initializing. You need not run
the program from the Start Menu. Even if you have never used Windows before, you should be
able to do it easily. If you are unfamiliar with Windows, the next few paragraphs should help you
get started. If you have used Windows before, you can skip them.

You will see two kinds of “cursors” on the screen during the installation process:

ç
Mouse Pointer Insertion Point

The mouse pointer is for selecting items or actions. Just use your mouse to move the mouse pointer
to the items you want to select and click the first (left) button.

The insertion point is found in text boxes, which are used for entering information. When you see an
insertion point in a text box, you can type information in that box. If you need to enter or change
information in a text box and don’t see an insertion point, move the mouse pointer to the box and
click.

If there is already information in the box, or if you made an error in the information you have
typed, you can change it. Use ""  and !!  to move your insertion point (or just click the place you
want to be with your mouse). To delete characters, use Del  to delete the character in front of your
insertion point or use backspace to delete the character behind it.

 Running the Setup Program

Single-user installation

Insert your VersaCar/VersaImage/VersaView CD into your CD-ROM drive and wait for the
installation screen to appear.

1. In the Versa 32 Installation window click on Install VersaImage 32 Single User.

2. After reading the Welcome, screen select .

3. Enter your user information and select .

4. Check the box for Install Demoblue Database and select the destination folder where you would
like your VersaCar/VersaImage/VersaView software installed.

5. Select .

6. In the Backup Replaced Files window select  and choose the destination directory where
you would like to create the backup file.

7. Select .

8. Select  again to begin installation.

9. When installation is complete, select  to begin using the program.

2
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Network installation (from workstation to server)—recommended for all Novell/NT
installs

Insert your VersaCar/VersaImage/Versaview CD into your CD-ROM drive and wait for the
installation screen to appear.

1. In the Versa 32 Installation window click on Install Versa 32 Network.

2. After reading the Welcome screen select .

3. In the Choose Destination Location screen, select Remote Install (Workstation to Server).

4. Select Map a Network Drive and do the following:

• Select the Network Drive where you would like your software installed on the server.

• Select the path from the Directories Window and click .

5. In the Choose Destination Location window, select . In the dropdown box select the
mapped drive and path you selected in step 4.

6. Select .

7. Select the type of network you will be installing on.

8. Select .

9. Select  again to begin installation. (This will install the VERSAIMG.EXE on your server.)

• If you selected installation to a Novell Server, follow the instructions in the Novell
Installations Only! window.

• If you selected installation to an NT Server follow the instructions in the Windows NT
Installations Only! window.

10. When installation is complete, select .

Licensing

Installation of a network license (NT installations only)

1. Take your VersaCar/Image CD to the server.

2. In the Versa 32 Installation window, select Install a Network License.

3. In the Choose Destination Location window, select .

4. Select the directory where the Versaimg.EXE is located (e.g. C:\Versaimg\Ivision).

5. Click .

6. Click .

7. Click .

8. Return to the workstation to complete the installation and follow the instructions for
Workstation Licensing.

Workstation licensing

1. At the workstation, enter Explorer and do the following:

• Double click on the newly mapped network drive.
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• Double-click the Versaimg folder.

• Locate the SetViNet.EXE and double-click.

2. In the Versa 32 First Time Installation Window, select Yes.

3. Click .

4. After reading the Welcome window, click .

5. In the Display Registration Window, enter your user information.

6. Select .

7. In the Backup window, select Yes to Create a Backup.

8. Click .

9. Click  to begin installation of Workstation License.

10. When install is complete, select .

Running your VersaCAR\Image program

1. Double click the VersaImage 32 icon.

2. You will be supplied with an 18- digit Site Code.

3. Call the Support number supplied for your Site Key.

4. After entering your Site Key, select Authorize.

5. You are now fully licensed to run VersaCAR\Image.



White Text



3   Walking
through Windows

This chapter is designed for people who are new to the Windows environment. It covers all the basic
functions and features of Windows you will need to run your application. If you are new to
Windows, or if you do not use Windows programs very often, you will find many helpful hints in
this chapter. If you are already a Windows “pro,” you can skip this chapter.

Basic Mousemanship

If you did your own software installation, you have already mastered a number of mousing basics.
However, even if you are a total novice, it probably only took you about 30 seconds when you first
saw the Windows main screen to figure out that the arrow on the screen is the mouse pointer and
that it moves whenever you move the mouse. If you are new to mousing, you may want to move it
around some so you can get the feel of it.

Your mouse has two buttons—a primary button, which is the left button and a secondary button,
which is the right one. In this manual, we will refer to them simply as your left mouse button or
right mouse button. Sometimes, for brevity’s sake, we may tell you to left-click (instead of “click
your left mouse button”) or right-click (instead of “click your right mouse button”). For most func-
tions in VersaImage, VersaCAR, or VersaView, all you need is your primary or left button. A few
special operations will require both buttons. You will be told what those are in the instructions for
these operations. In this manual, unless you are told otherwise, you can assume that when you are
told to simply “click your mouse” or “click a button”, we mean the primary or left button.

Note: By default, the primary button is the left one, but lefties can swap them through the Windows
control panel so that they can use the index finger of their left hand on the primary button if they
want (consult your Windows documentation if you want to do this).

You select the actions you want to perform by simply pointing the mouse pointer at a “button” or
“field” or “selection” on the screen and clicking the button. Most of the time a single click is all you
need. Sometimes you will need to use a double-click. For some actions, you will need to hold the
mouse button down and “drag” your mouse to make a selection. You will, of course, still need to
use the keyboard occasionally to enter data as mice have a limited vocabulary. However, we
promise to leave the letters on the keys and we won't tell if you use only two fingers.

The instructions in the rest of this chapter contain (among other things) hints for using the mouse in
your Windows operations. You really don’t have to know anything more about mousing than you
find in this chapter to run VersaImage, VersaCAR, or VersaView. If you are an old keyboard artist
who’s afraid of mice, don’t despair. After a few point and click operations, you’ll start to feel like
an old pro. However, if you prefer to key, we will also provide you with some keyboard
information. Actually, most real “power users” learn both and use the mouse and keyboard
interchangeably—whichever is most efficient for the operation they are performing at the time.

Starting a Windows Application

Your Windows main screen is referred to as your desktop. Usually, your desktop contains a number
of icons that are shortcuts to applications you run often. Some programs create these shortcuts
automatically. You can also create them yourself (we’ll discuss this later). At the bottom of the
screen is a task bar. In the bottom left corner, you will see a  button. The  button is
used to access the programs in your system.

3
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} To start an application

1. Click  to display the Start menu.

2. Move your mouse to Programs and the Program menu will magically appear.

3. Move the mouse to the application group in the list that contains your application (e.g., 
VersaIMAGE Software Corporation). The menu for the application group will appear.

4. Click your mouse on the program name.

The Application Window

When you access VersaImage, VersaCAR, or VersaView, its main screen will appear. This is
referred to in Windows “talk” as the application window. Applications can run in a window or in
full screen mode. When they run in a window, the application window is somewhat smaller than the
screen and you will be able to see your desktop and other application windows. When an application
runs in full screen mode, it occupies the whole screen.

All application windows have a title bar at the top of the screen and usually a menu bar just under
the title bar. Nowadays, most application windows also have a tool bar. The other attributes vary
with the application.

The title bar buttons

The title bar (see fig. 3.1) contains the name of the program. In addition to the program name, you
see several buttons. You could find out what these buttons do by trial and error. However, if you
want to avoid some puzzling surprises, you may want to read the information below:

Minimizes the application. When you minimize an application, it disappears from the
screen but its name will still be displayed in the task bar at the bottom of the screen.
To restore the application, just double-click on its “button” in the task bar.

Switches from full screen to a window. Most people prefer to run their applications
in “full screen” mode, so many applications open automatically with a full screen
display. This button will only appear if you are using a full screen display.

Switches the application to a full screen display. This button will appear only if
you are running your application in a window.

Closes (i.e., exits from) the application.

In the upper left corner is the VersaImage icon. Clicking on it opens the control menu. To select one
of the options on the control menu, just “point and click.” The options on this menu are explained
briefly below so that you’ll know what you are getting into if you select one.

The control menu

The control menu (fig. 3.2) contains commands that control your application window display:

Restore Changes application to a window size. This command performs the same actions as
.

Fig. 3.1. Program Manager title bar

Title BarControl
Menu Button

Menu Bar

Control Buttons

Tool bar
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Move Permits you to move an application window with your
keyboard (will say more about moving windows later).

Size Lets you size the application window with your
keyboard (more on this later also).

Maximize Enlarges your application window to full screen display.
This command performs the same actions as .

Minimize Minimizes your application. This command performs
the same action as .

Close Closes the application window. This command performs the same action as .

The control menu is primarily designed for people who prefer to use the keyboard. With this menu,
you can perform all of the actions the title bar buttons perform:

• To open the control menu, press Alt . Then press the space bar.

• To select an operation, press the underlined letter in the command or use ##  and $$  to move
the highlight to the selection and press Enter .

If you are a new user, you will not need the control menu often as most of the operations can be
done with your mouse. However, you can open the menu and make your selections with your mouse
if you prefer.

Switching Among Applications

One of the real reasons for using Windows is that it allows you to run several applications at once
and to switch back and forth among them. You could, for example, be writing a letter to a customer
in your word processor program, switch to VersaImage or VersaCAR to retrieve and view a related
document, then switch back to your word processor and finish the letter.

All of the applications you are running will be displayed on “buttons” on the task bar at the bottom of
your screen. The button for the active task will appear to be pushed in. You can switch from applica-
tion to application with your mouse or with the keyboard.

} To switch applications with your mouse

Click on the application’s “button” on the task bar.

} To switch applications with the keyboard

1. Press Alt  + Esc . You will move to another “button” on the task bar.

2. Continue pressing Alt  + Esc  until you reach the button for the application you want.

3. Press Enter . The application will be activated in the state you last left it (window or full screen).

Menus

Windows menus can be one of two types—menu bars or drop-down menus. Menus are used in
Windows programs to select the operations you want to perform. When you make a selection from a
menu, one of three things can happen:

n A dialog box will be displayed.

n Another menu will be displayed.

n The operation you selected will be performed.

Fig. 3.2. Control menu
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Menu bars

When you first request VersaImage or VersaCAR (or any application for that matter), you will see a
menu bar at the top of the screen. Menu bars offer you a set of options to select from.

} To select from a menu bar with your mouse

1. Move the pointer to the selection you want.

2. Click the left mouse button once to make your selection. The menu will drop down.

} To select from a menu bar with the keyboard

1. Press Alt  to move to the menu bar.

2. Use ""  and !!  to move the highlight to the menu selection you want and press Enter . The menu
will drop down.

Drop-down menus

Drop-down menus are used to display submenu functions. They often appear when you make a choice
from a menu bar. They may also appear when you make a choice from another drop-down menu:

n When a menu item has a submenu, you will
see a  at the right of the box (see Prefer-
ences in fig. 3.3). When you click on one of
these items, the submenu will “cascade”
from the item you selected and be displayed
next to it (see Maintenance in fig. 3.3). If a
drop-down menu item has a submenu,
another  will appear on its right.

n When a menu item has an ellipsis (…) after
it (see New Database in fig. 3.3), this
means that it opens a dialog box.

n If no  or … is displayed, the selection
will perform an action.

n If an item is “grayed out,” it is “inactive”
and not currently available. For example,
some options cannot be selected until you
open a database, so those items are grayed
out until you select one.

} To select from a drop-down menu with your mouse

1. Move the pointer to the selection you want.

2. Click the left mouse button.

} To select from a drop-down menu with the keyboard

1. Use ##  and $$  to move the highlight to your selection.

2. Press Enter .

DOS-style menu selection

If you are an old DOS user, you probably got used to making menu selections by typing the
underlined (or capitalized) letter in the menu command you want to select. Years ago (perhaps you
even remember) it used to always be the first letter. Then, as applications became more complex, it

Fig. 3.3. A drop-down menu
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got difficult to think of commands that began with a different letter and were still “logical,” so
capitalizing and, later, underlining became the norm. The Windows environment kept this
convention as an option so, if you are used to it, or if you would just prefer to use this type of
keyboard selection, you can do so.

} To use DOS-style menu selection

1. Press Alt  to activate the menu bar.

2. Type the underlined letter—e.g., F for File—of each command you want to select.

• To select Compact Database from the menu displayed in fig. 3.3, you would press F M C.

• To select Repair Database from the menu displayed in fig. 3.3, you would press F M P.

Dialog Boxes

Many operations are performed through dialog boxes. Menu options often call dialog boxes.
Sometimes an option in a dialog box will open another dialog box. Dialog boxes are “mini”
windows with their own title bars. They may also have control buttons. Dialog boxes contain
structures known in programmer’s jargon as “controls”. They are used to get input from you and
consist of text boxes, various kinds of list boxes, and various types of buttons. In the next few
sections, we will explain how each of these “controls” work. Once you become familiar with them,
you will be able to use just about any Windows dialog box without further instruction.

Dialog boxes also contain a mythical beast know as a “position cursor.” To select from a list, enter
text in a text box, or activate an option, the position cursor must be positioned on that item.
Unfortunately, the “shape” of the position cursor varies with the type of control, so we’ll try to give
you some clues in the instructions below as to what you will see for each type.

Text Boxes

Text boxes are used for entering data in dialog boxes. If a text box
already contains data, you can make changes to it. In a text box, the
position cursor becomes an insertion point (fig. 3.4). If the box already
contains text, the text will be highlighted (fig. 3.5) and the insertion
point will be positioned at the end of the highlight.

} To move the insertion point

The following keys are used to move the insertion point in a text box:

!! Moves the insertion point to the left one character.

"" Moves the insertion point to the right one character.

Ctrl  + !! Moves the insertion point to the left one word.

Ctrl  + "" Moves the insertion point to the right one word.

Home Moves the insertion point to the beginning of your entry.

End Moves the insertion point to the end of your entry.

Note: You can always position the insertion point by pointing the mouse at the place you want to be
and clicking it once.

To enter or change text in a text box, you must move your position cursor to the text box. You can
do either with the mouse or from the keyboard.

Fig. 3.4. Empty text box

Fig. 3.5. Filled text box

Label

Insertion Point
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} To move your position cursor with your mouse

1. Move your mouse pointer to the box.

2. Click your mouse.

} To move your position cursor with the keyboard

1. Use Tab  to move forward or Shift  + Tab  to move backward among the items.

2. When you see the insertion point or highlighted text in the box, your position cursor is in the
box.

Hint: Unless you are an absolute klutz on the keyboard, you will probably find it easier in dialog
boxes with several text boxes to use Tab  to move from box to box and the keyboard keys to place
your insertion point, etc., instead of the mouse. That way you won’t have to take your hands off the
keyboard all the time.

Entering text

To enter text in an empty box, just type it in. If the information in the box is highlighted (fig. 3.5)
and you type new text, your new text will replace the old text. If you want to edit the highlighted
text instead of replacing it, press !!  or ""  or click your mouse in the box.

Basic editing

With a few simple inserting and deleting techniques you can easily modify your text entries to
correct mistakes or make changes to default information.

} To insert characters into the existing text

1. Move the insertion point to the place where you want to insert the characters.

2. Type the characters in. The text in front will move right.

} To delete text

Use any of the following keys:

Del Deletes the character in front of your insertion point. Everything else moves left.
To delete several characters at once, just hold the key down.

Back Space Erases the character to the left of your insertion point. To erase several characters
at once, hold the key down.

Ctrl  + Del Deletes all characters to the right of your insertion point. If you move the insertion
point to the beginning of the field, you can erase the whole field.

Advanced editing

Simply inserting and deleting characters is often enough for minor edits. However, for more
efficient operation, you may want to try some of these advanced editing techniques after you are
more familiar with Windows.

Selecting text

All of the advanced editing techniques are based on text selection, so you must know how to select
parts of your text entry before you can use them.

} To select text with your mouse

1. Place the mouse pointer in front of the first character you want to select.
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2. Press the left mouse button and hold it down.

3. Keeping the button pressed, drag the mouse pointer to the last character you want to select (you
can select in either direction). Then release the button.

} To select text with the keyboard

1.  Use !!  and ""  to move the insertion point to the first character you want to select.

2. Hold Shift  down and use !!  and ""  to move the highlight and select your text. (Use Ctrl  with
the arrow keys to select an entire word.)

3. Release Shift .

} To “deselect” text with your mouse

Click the mouse elsewhere in the field.

} To “deselect” text with the keyboard

Press an arrow key (make sure Shift  is released).

Deleting and replacing text

} To replace or remove text

1. Select the characters you want to remove.

2. Do one of the following:

• Type the “replacement text.” The selected text will be deleted and replaced by the text you are
typing.

• Press Del  to delete the selected text without replacing it.

Cutting, copying, and pasting

You can cut and paste text in dialog text boxes just like you can in a word processor. After you
“cut” your text, you can paste it anywhere in the text box, in another text box in the dialog box, or
even in another dialog box. The “cut” text remains on the Windows “clipboard” so you can paste it
in as often as you want until you cut another piece of text to the clipboard.

You can also copy text without cutting it to paste it in another place. Since the text you copy is
placed on the Windows clipboard, you can past it in any text box in either this or another dialog box
(or in another window program that accepts text for that matter).

} To cut and paste text

1. Select the text you want to move.

2. Press Shift  + Del  to remove the text and copy it to the clipboard.

3. Move the insertion point to the place you want to put the text and press Shift  + Ins  to insert the
text.

} To copy and paste text

1. Select the text.

2. Press Ctrl  + C  to copy the text to the clipboard.

3. Move the insertion point to the place you want to paste the text and press Shift  + Ins .
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Caution: All Windows programs use the same clipboard. Therefore, if you leave VersaImage or
VersaCAR and copy an item to the clipboard in another application, it will replace your
VersaImage/VersaCAR text on the clipboard. If you come back to VersaImage or VersaCAR and
try to paste cut or copied text in a dialog text box, the last text you placed on the clipboard will
appear and not the text you originally copied in VersaImage or VersaCAR. Fortunately, if you find
you have placed an entire paragraph from your word processor into a text box, you can easily
undo it (see below).

Undoing edits

Windows dialog boxes allow you to undo your last edit (with some limitations). This is very handy
if you realize that you accidentally wiped out an entry or made changes you didn’t want (or
accidentally pasted in a spreadsheet or 20 pages of a document from your word processor).

} To undo your last edit

Press Ctrl  + Z  before doing anything else. This will do any of the following:

• Restore a selection you have cut or deleted.

• Remove a selection you have pasted.

• Remove characters you have inserted as long as you have not moved your insertion point.

• Restore characters you have deleted individually as long as you have not moved your insertion
point.

You should note, however, that, once you have left the text box (i.e., moved your position cursor),
undo will no longer work.

List Boxes

List boxes allow you to make a selection from a list of items or options. They are easily recognized
because they contain a list of items. Sometimes the items in a list box will change depending on a
previous item you have selected. For example, in the Open dialog box (which we will discuss in
detail in Chapter 4), the list of folders will change if you select a different drive and the list of files
will change when you select a different folder.

Selecting an item

In a list box, the position cursor is technically a highlight in
“reverse video” (see fig. 3.6). Unfortunately, it is rather invisible
because the selected item is always highlighted—even when you
are not positioned in the box! For this reason, selecting from a
list with a mouse is usually easiest, because you do not have to
move your position cursor to the box first.

} To select from a list box with your mouse

1. Move the pointer to the selection you want.

2. Click your left mouse button. The highlight will move to that item to show that it is selected.

} To select from a list box with the keyboard

1. Use Tab  or Shift  + Tab  to move the position cursor to the box.

2. Use $$  and ##  to move the highlight to your selection. (If the $$  and ##  do not work, your
position cursor is not in the list box.)

3. Press Tab  to leave the box.

Fig. 3.6. List box

Highlighted
Selection

Scroll Bar

Scroll
Box
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Scrolling

Some list boxes may have a list that is too long for the box. If a list contains more items than can be
displayed in a box, you may use the scroll bar at the side of the box (see fig. 3.6). The scroll box
(sometimes called an “elevator”) in the middle tells you approximately how much of the list or text
is displayed and what part of the list is displayed. If it is at the top, you are at the beginning of the
list. If it is in the middle, you are in the middle of the list.

} To scroll through the selections with your mouse

1. Place the pointer on the arrow in the scroll bar that scrolls in the direction you want to go.

2. Do either of the following:

• To scroll continuously, press the left mouse button and hold it down. The list will scroll in the
direction you selected. When you want to stop, release the mouse button.

• To scroll one item at a time, click the mouse on the arrow. Each time you click, you will
move down (or up) one line.

Note that the highlight does not move with you when you scroll. It remains on the last selection. The
selection will not change unless you click on another with your mouse.

} To scroll through the list from the keyboard

Use the ##  and $$  keys:

• To scroll continuously, hold the key down which scrolls in the direction you want to go.
When you want to stop, release the key.

• To scroll one item at a time, just press the key. Each time you press the key, you will move
down (or up) one line.

When you use the ##  and $$  keys, the highlight moves with you so you can simply make your
selection by pressing Tab .

Note: You can also scroll through a list by positioning your mouse pointer on the scroll box, holding
your mouse button down and dragging the scroll box. This is particularly efficient for long lists.

Combo Boxes

Combo boxes are a combination of list and text boxes (see fig.
3.7). They allow you to either select from the list or type
something else in the box. Combo boxes have a “text box” on
top for entering values and a list box below for selecting values.
When you first open a dialog box, the text box will usually be
blank, although it may contain a default value.

Selecting an item from the list

The list box operates fundamentally like a standard list box.

} To select from the combo box with your mouse

1. Move the mouse pointer to the item in the list you want to select. Use the scroll bar if necessary
to look for the item you want, just like you would in a standard list box.

2. Click your mouse button to select the item. Your selection will be highlighted and will also be
placed in the text box (see fig. 3.8).

Fig. 3.7. Combo box

Text Box
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} To select from a combo box with the keyboard

1. Use Tab  to move to the combo box. When your position cursor is in the
box, you will see an insertion point.

2. Press Tab  to move from the text box to the list box.

3. Use the ##  and $$  to move the highlight to the item you want to select.
As you scroll thought the list with the arrow keys, the item that is
currently selected will be displayed in the text box (fig. 3.8).

4. Press Tab  to leave the box.

Entering an item in the text box

The combo box text box operates like a standard text box. To enter or edit text you use the same
editing keys to move the insertion point. You can delete, replace, cut, copy, and paste text just as
you can in a standard text box.

} To enter text in a combo text box

1. Move the position cursor to the text box by doing either of the following:

• Click the box with your mouse.

• Use Tab  and Shift  + Tab .

When you see the insertion point, you are positioned in the text box.

2. Type your entry or edit the entry in the box.

Note: When your own text is entered in the box, there will be no highlight in
the list box as no item is selected (see fig. 3.9).

Drop-down Lists

Drop-down lists are another type of list box and are often used when several
list boxes are needed and there is not room for all of them. They appear as a
single field with  at the right (see fig. 3.10). They may either be standard
list boxes or combo boxes. Standard list boxes will display the current value.
Combo boxes may be blank if there is no current value.

Selecting from a drop-down list

} To select an item from a drop-down list with your mouse

1. Click on  and the list will appear (see fig. 3.11). The current selection
will be displayed in the field and will also be highlighted.

2. Move the pointer to your selection. Use the scroll bar if necessary to
find the item you want, just as you would with a standard list box (see
page 15).

3. Click your mouse button. The box will close and your selection will be
displayed in the field.

Fig. 3.8. Combo box with
item selected

Fig. 3.9. Combo box
with text entered

Fig. 3.10. Closed drop-
down list box

Fig. 3.11. Open drop-
down list box
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} Selecting from a drop-down list with the keyboard

1. Press Tab  to move the position cursor to the box. When the position
cursor is in the box, you will see one of the following:

• A highlighted selection (fig. 3.12) if the box contains an entry or
selection.

• An insertion point if it is an empty combo box.

2. Press the $$  key to open the box.

3. Use the ##  and $$  keys to find your selection.

4. Press Tab . The box will close and your selection will appear in the field.

Note: Some drop-down lists do not open when you use the arrow keys. You can still scroll through
the list and make your selection without opening the box. However, if you want to see the whole list
first, you will need to click on  with your mouse.

Entering a value

If the drop-down box is a combo box, you will also be able to type your own value in. You do not
need to open the box to do so.

} To enter a value in a drop-down combo list

1. Either click on the box with your mouse or use Tab  to move the position cursor to the box. You
will see one of the following:

• An insertion point in an empty box.

• A highlight with an insertion point at the end in a box with text.

2. Enter or edit the text just as you would a regular text box (see page 11). The same function keys
are valid and you can insert delete, replace, cut, copy, and paste text just as you can in a text
box.

Push Buttons

Push buttons (sometimes called “command” buttons) are used to select actions and appear in all
dialog boxes. In fact, sometimes it seems as if Windows programs run on push buttons. The name of
the action the button performs appears on the button. The standard buttons used are , ,
and :

“Approves” what you have entered or selected in the dialog box. What
happens after you click  depends on the operation. Sometimes the box
may simply close and perform an operation. Sometimes it may display a
dialog box for another action or a message.

Cancels the current operation and takes you back to the previous level. It does
not cancel everything you have done, only whatever you did in the dialog box
you press it from.

Closes the box without doing anything else except what you have already done
while the box was open.

In addition to the above, there are a number of custom buttons that are used for dialog-specific
actions. These vary from box to box. Many of the dialog boxes in VersaImage, VersaCAR, and
VersaView have custom buttons.

Fig. 3.12. Drop-down
box with highlight



18      VersaImage/VersaCAR/VersaView User’s Guide

Some buttons perform an action immediately when they are pushed. Others may display an
additional dialog box. Those that display dialog boxes have an ellipsis (…) after the label.

} To select a push button with your mouse

1. Move the mouse pointer to the button.

2. Click your mouse and the action will be performed.

} To select a push button with the keyboard

1. Use Tab  to move the position cursor to the button. When your
position cursor is on the button, you will see a dotted line around the
button (fig. 3.13).

2. Press Enter  and the action will be performed.

Hint: When you open a dialog box, one of the push buttons (usually ) will be selected as the
default button. It will be highlighted and will appear brighter than the others. You can activate that
button by just pressing Enter  even though the position cursor is not on it.

Option groups and “radio” buttons

Option groups present you with a choice of several items (see fig. 3.14).
Option buttons, which are round circles, allow you to select only one item
out of the group. In an option group, one button is always pressed or
selected. This button will have a · in its center and is the current value for
the group. When another is selected, the one that is currently selected will
be “deselected.” Option buttons are sometimes called “radio” buttons
because they work like selection buttons on a radio—when you “press” a
new selection, the old one pops out.

} To select an option with your mouse

1. Move the pointer to the circle or the item name.

2. Click your mouse. A · will appear in the center of the circle.

} To select an option with the keyboard

1. Use Tab  to move the position cursor to the group. When you arrive,
the position cursor (which is a box) will appear around the label of the
selected item (see fig. 3.15).

2. Use ##  and $$  to move the position cursor to the item you want.

3. Press Tab  to leave the option group.

Note: Some option groups may not have a group label or a group box. They still operate the same
way.

Check boxes

Check boxes are square and operate individually, although they may appear to be part of a group.
They are much like option buttons except that you can select (or deselect) each individual box. You
may “check” as many as apply.

Fig. 3.13. Push button
with position cursor

Fig. 3.14. Option buttons

Fig. 3.15. Option button
with position cursor
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} To select a check box with your mouse

1. Position your mouse pointer on the box or item you want to select or deselect.

2. Click your mouse:

• If the item was unselected, a “3” will appear to show that it has been
selected (see fig. 3.16).

• If the item was previously selected, the “3” will be removed.

} To select a check box with the keyboard

1. Use Tab  to move your position cursor to the item you want to select or deselect. When you are
positioned on the item, you will see a box, which is the position cursor, around the item label
(fig. 3.16).

2. Press the space bar:

• If the item was unselected, an “3” will appear (see fig. 3.16) to show that it has been selected.

• If the item was previously selected, the “3” will be removed.

Moving Around in a Dialog Box

If you have read all of the above information on dialog boxes, you probably have a good idea of
how to move around from item to item. Often, it is easiest to just use your mouse and point and
click. However, there are many times, particularly when you have a number of text boxes to fill in,
when even die-hard mousers will want to use the keyboard. To summarize, let’s review what you
have already learned:

1. To move from item to item, use Tab :

• Press Tab  to move the position cursor forward to the next item.

• Press Shift  + Tab  to move the position cursor backward to the previous item.

2. To move through a list of items (e.g., a list box or an option group), use the ##  and $$  keys.

By the way, the “next” item may not always be the next physical item but instead may be the item
the programmer thought was the next “logical” one to fill in or push. Sometimes the “logic” is
merely the order in which the programmer defined them. (VersaImage and VersaCAR’s, of course,
are always logical.)

There is also a “short cut” way to move from item to item, although it does not necessarily apply to
all items. You may notice that, in some boxes, the item labels will have underlined letters. If this is
the case, you can move directly to the item via the keyboard by simply typing the letter, just as you
can for menu selection. If an item does not have an underlined letter, this will not work. You will
have to use Tab  or the mouse.

Active and Inactive Items

Dialog boxes often contain items or options that are activated or displayed only under certain
conditions, just like menus. These elements are made “inactive” and are activated only when a
particular option is selected. Inactive items generally appear “grayed out” and nothing will happen
when you click on their boxes. Whenever you see a field or selection that is grayed out, that means
that it is not applicable under current conditions. An item that is inactive when a dialog box opens
may become active because of an option you have chosen or vice versa.

Fig. 3.16. Check
boxes
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Due to the dynamic nature of dialog boxes, the options you select may not only activate or
deactivate other elements in the box. They may also change the items that are actually displayed. As
a result of a selection, the items in a list box may change or new items (such as additional text boxes
or option groups) may appear. Do not be alarmed if the display changes because you select an
option. It is doing what it is supposed to do. If you feel uneasy about what you see on the screen,
just press . Then check the instructions for the dialog box in the manual or in on-line help.

Message Boxes

Message boxes are special dialog boxes that contain only a
message and push buttons for your response. Status mess-
ages, which report the progress or completion of an action
(fig. 3.17), and error messages, which report errors in your
input (fig. 3.18), are for information only and have only an

 button.

When you click , the box
will close and you will return
to the application. If the message was an error message, you will
generally return to the dialog box where you made the error so that
you can correct it before you continue. You must correct your input
before you can close the dialog box with an . You can, how-
ever, always use  to cancel the operation.

Other message boxes may require your
confirmation (see fig. 3.19) and will have but-
tons such as , , or . They
appear before an action that is to be performed
makes a crucial alteration to your data or your
system. If you do not give your confirmation,
the operation is terminated.

Moving Your Windows Around

You can move an open dialog box, message box, or window anywhere you want on the screen. You
may find this convenient when you have more than one open window on the screen or when you
want to move a dialog box out of the way so that you can see something on the main screen or in a
box that is underneath.

} To move a window

1. Place the mouse pointer in the title bar.

2. Press the left mouse button and hold it down.

3. Keeping it pressed, drag the pointer. As you drag your mouse, an outline of the dialog box will
move with you on the screen.

4. When the outline is where you want the window to be, release the mouse button. The box will
move to that position.

Fig. 3.17. Message box with status
message

Fig. 3.18. Typical error message

Fig. 3.19. Confirmation message



4 VersaImage/
VersaCAR Basics

If you know how Windows works, you will have no trouble running VersaImage or its siblings
VersaCAR or VersaView. Most of the controls and other features on the screen will be familiar to
you. This chapter will give you an overview of the main features and functions of your application
screen. You should be familiar with all the information presented here before you try to run your
application.

Starting the Program

You start your application from the Windows Start menu. If you want, you can place a shortcut to
the application on your desktop. Then all you need to do is click on the shortcut icon to run the
program. If you use this application a lot, this is a good idea.

} To start the application from the Start menu

1. Click the  button in the bottom left corner of the screen.

2. Select Programs from the Start menu.

3. Select VersaIMAGE Software from the Programs menu.

4. Double-click on your application name
(VersaImage 32, VersaCAR 32, or VersaView
32) in the VersaIMAGE Software group.

5. The sign-on dialog box (fig. 4.1) will appear in
the middle of your screen:

• If your system is set up to use passwords,
Name and Password fields will appear in
the dialog box. Enter your sign-on name and
password. Then click .

• If your system does not use passwords, the
Name and Password fields will not be
present in the dialog box. Just click  to
start the application.

 Note: For security reasons, your password will not appear on the screen when you type it. Instead,
you will see a * for each letter.

6. After you click , the main application window (fig. 4.2 on page 22) will appear.

} To place a shortcut on your desktop

1. Click  to display the Start menu.

2. Select Settings from the Start menu and double-click on Taskbar.

3. In the Taskbar Properties dialog box, click on the Start Menu tab.

4. Click  and a Windows Explorer screen will appear.

5. In the left pane, double-click on Programs. Then double-click on Image Vision.

4

Fig. 4.1. Sign-on dialog box for a password-enabled
system
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6. In the right pane, click your right mouse button on the application name (VersaImage 32,
VersaCAR 32, or VersaView 32). A “popup” or “context” menu will appear.

7. Click Copy on the context menu.

8. Move your mouse pointer to your desktop and click your right mouse button again.

9. Click Paste Shortcut to place the icon on your desktop.

Note: You can drag this icon to any position you want on your desktop.

} To start your application from your desktop

1. Double-click on the shortcut icon. The sign-on dialog box will appear.

2. Sign on to your application the same way you would if you started from the Start menu.

Application Window Features

On the application screen (see fig. 4.2) you will see the following:

• At the top of the screen are the standard Windows title bar and menu bar.

• Directly under the menu bar is the tool bar. The tool bar will contain buttons that are used for
starting frequently performed functions.

• At the bottom of the screen is the status bar, which is used for displaying reader and camera
statuses. (VersaView does not have a status bar.)

Fig. 4.2. Initial application screen

Menu Bar Title Bar

Tool bar

Status
bar
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Menu and title bar

When you open a database, the database name will appear in the title bar in addition to the program
name, and additional options will appear on the menu (see fig. 4.3). Each of these menu options
contains a menu of commands and functions. If a menu or menu option does not apply to the current
database or operation, it will be grayed out. For example, if the database is not enabled for images,
Scan will be grayed out. Some options will be grayed out because they are not available in the
product you are using or because your security level does not give you access to them.

Note: Some items on the menu are for VersaImage only and will always be grayed out in VersaCAR
and VersaView.

The tool bar

The buttons available on the tool bar depend on what functions are available at the time. When you
first start your application, the tool bar will only contain one button as shown in fig. 4.2. After you
load a database, several more buttons will appear (see fig. 4.3). Depending on the option you have
chosen and the database you have loaded, other buttons may appear. If your database is enabled for
scanned images, an additional tool bar that contains annotation tools for drawing and highlighting
images will appear. If a button you expect to see disappears or does not appear, it is because that
function is currently not available. It will reappear again when the function is enabled.

Tool bar buttons usually contain icons that represent the action they perform. When you position
your mouse pointer on a tool bar button, a “tool tip” will appear below it to tell you what the button
is used for. To execute the function performed by the button, click your mouse.

Fig. 4.3. Application screen with database and record loaded

Title bar with database
name displayed

Menu Bar with
expanded options

Tool Bar

Reader Controller Reader Status

Camera Controller

Camera Status

Roll Number

Blip (Frame) Number
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Status bar

The status bar in VersaImage and VersaCAR is used to display your reader and camera status.
These fields are not applicable when you are using a paper scanner. VersaView will not have a
status bar since it does not support microfilm controllers. Fig. 4.3 shows what is displayed in each
area of the status bar:

Reader controller The name of your reader controller.

Reader status The current status of your reader.

Camera controller The name of your camera controller.

Camera status The current status of your camera.

Roll The number of the roll you are currently reading or filming.

Blip The number of the frame where your reader is positioned or the frame you
have just filmed.

The first time you run your application, both the reader controller and the camera controller will
read None. After you configure your system as instructed in Chapter 5, the name of your controller
will appear. More will be said about the status display and the roll and frame numbers later.

The Screen Area

The screen area is used for displaying your database information. You will use the screen to search
your databases and to index your film and images. Scanned images associated with your records will
also be displayed on the screen.

Screen fields

The screen fields appear as rectangular boxes. They are used for entering and displaying data from
the fields in your databases:

The fields displayed will be the ones you define for your database. Each database will have its own
set of fields. (More will be said about defining databases in Chapter 7.) Each field has a label that
tells you what is entered in the field. Included in the label is the field type and maximum length:

A Alphanumeric. Will accept virtually any character.

N Numeric. Will accept only numbers. Decimal points may be entered if the format permits
but no other characters. The entered values will be displayed in the proper format (e.g.,
with $ or correct number of decimal places).

D Date. Displayed as MM/DD/YY. May be entered in either MM/DD/YY or Month Day
Year format.

R Roll number field. Alphanumeric.

B Blip or frame field. Must be numeric and in the correct format for the type of database
you are displaying.

Label

Field type
and length

Field
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Entering information in screen fields is much like entering values in text boxes in Windows dialog
boxes (see Chapter 3). All of the same function and control keys described in Chapter 3 work in the
screen fields. You may enter, delete, replace and insert text, and copy text from one field to
another. To leave a field and move to the next field, you press Tab  just as you do to go from item
to item in Windows dialog boxes. Shift  + Tab  backs up to previous fields.

Note: If you are not sure how to do some of these functions in Windows text boxes but skipped
Chapter 3 because you are already a Windows user, you may want to return to page 11 and read
about text boxes anyway, even if you do not need to read the rest of the chapter.

Other controls

VersaImage and VersaCAR use some of the same “controls” you see in dialog boxes in their
application windows. Push buttons, for example (see fig. 4.3), are used for performing many
standard functions. In fig. 4.3 you also see a drop-down list box in the middle of the tool bar. You
will also see “list-like” screens with scroll bars, etc. In general, if you see an item that looks like a
familiar control from a Windows dialog box, you can expect it to function in the same way.

Common Dialog Boxes

VersaImage, VersaCAR, and VersaView make use of the Windows Open and Save common dialog
boxes. These dialog boxes are common to many applications and function fundamentally alike across
applications. While some applications add a few additional “bells and whistles”, such as additional
push buttons, etc., the basic components always work the same way. (Sometimes the box title will
be different, but it will essentially be the same box.) Because these boxes are used so often in
VersaImage, VersaCAR, and VersaView, it is important that you know how they operate (if you
already know how they work, you can skip to page 28).

Open dialogs

The Open box (fig. 4.4) is used for selecting and opening data files. VersaImage, VersaCAR, and
VersaView use it to open databases and other files that are needed, such as selecting a file for an
import.

The box contains the following:

Fig. 4.4. Open dialog box
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“Look in” field The Look in field displays the current folder or, in some cases, the
current drive. They used to always be called directories, but now we
mostly call them folders. (You can still call them directories if you
want.) The default folder for VersaImage is VersaImg. This field also
contains a drop-down list that shows the complete path to the current
folder and all the accessible drives for your computer.

List of folders and files The list of folders and files contains the contents of the current folder.
Items with a folder in front of it are folders. The others are files.

“File name” field If a file is selected, its name will be displayed in this box. Otherwise, it
will be blank.You can also use this box to type all or part of a file
name you are looking for to narrow down your search.

“Files of type” list Files of Type is a drop-down list box that contains a list of the file
types that are legal for the operation. In cases where more than one file
type is legal, selecting the one you want to see is a good way to reduce
the size of long lists.

} To open a file

1. Find the folder where your file is located:

• To open a folder in the current directory, double-click the  in the list.

• To back up to the previous folder, click the  tool at the top of the box.

• To go to a different drive, click the  by the Look in field to display the list of available
drives for your computer and click the drive you want.

2. After you find the folder, locate the file in the list.

3. Either double-click on the file or highlight the file and click .

} To narrow down the list to a specific file type

1. Click the  to open the Files of Type drop-down list.

2. Select the file type from the list.

3. When the list box closes, the list of files will be narrowed down to the selected type.

} To narrow down the list to a specific extension

1. Click the  to open the Files of Type drop-down list.

2. Select the All Files option.

3. Enter a * followed by the extension you want to search for in the File Name field. For example,
if the data file you want to import has the extension .DAT, you would enter the following:

*.DAT

4. Click  or press Enter  to narrow down the list.

} To look for a specific file name, regardless of extension

1. Click the  to open the Files of Type drop-down list.

2. Select the All Files option.

3. Enter the file name followed by .* in the File Name field. For example, if the data file you want
to import has the name Invoices, you would enter the following:

Invoices.*
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4. Click  or press Enter .

} To look for a file that starts with a specific character or characters

1. Click the  to open the Files of Type drop-down list.

2. Select the All Files option.

3. Enter the starting character or characters of the file name, followed by *.*:

pr*.*

4. Click  or press Enter .

Save dialogs

The Save dialog box (fig. 4.5) is used for such things as creating new databases, saving import
templates, or designating the database you want to export to in the Export function. Its controls are
identical to the Open box. Variations on this box are used for other operations.

The box contains the following:

 “Save in” field The Save in field displays the current folder or, in some cases, the
current drive. The folder shown here is the folder where your file will be
saved. This field also contains a drop-down list that shows the complete
path to the current folder and all the accessible drives for your computer.

List of folders and files The list of folders and files contains the contents of the current folder.
Items with a folder in front of it are folders. The others are files. If
there is nothing in the folder, the list will be blank.

“File name” field You enter the name for the file in this box. Windows 95 and Windows
NT support file names of any length. Spaces are permitted.

“Files of type” list Files of Type is a drop-down list box that contains a list of the file
types that are legal for the operation. Unlike some “save as” functions
in other applications, in VersaImage this field does not determine the
type of file that will be written. That is determined by the option you
selected. For example, if you selected to Export to a Flat ASCII File,
your file will be saved as a flat ASCII file, regardless of what you
choose in this box or what extension you apply.

}  To save a file

1. Find the folder where you want to save the file:

• To open a folder in the current directory, double-click the  in the list.

Fig. 4.5. Save dialog box
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• To back up to the previous folder, click the  tool at the top of the box.

• To go to a different drive, click the  by the Save in field to display the list of available
drives available for your computer and click the drive you want.

2. Do one of the following to enter the file name:

• To save a new file, the name of the file. You do not need to enter the extension unless All
Files is selected as the list type.

• To overwrite an existing file, select the file from the list.

3. Click .

 Important: Do NOT change the extension if there is only one file type listed or VersaImage may not
recognize it. As a general rule, you should not apply an extension other than those listed unless All
Files is one of the available file types.

} To create a new folder

1. Find the folder where you want to place the new folder:

• To open a folder in the current directory, double-click the  in the list.

• To back up to the previous folder, click the  tool at the top of the box.

• To go to a different drive, click the  by the Save field to display the list of available drives
available for your computer and click the drive you want.

2. Click the  tool at the top of the box. A new folder with the name New Folder will be placed
in the list:

3. The box around the folder name works like a text box. The name New Folder will be
highlighted and your insertion point will be in the box:

• Start typing the name for your new folder and it will replace “New Folder”.

• Press Enter  when you finish.

4. Double-click the new  to select it and it will appear in the Save in box.

On-line Help

VersaImage/VersaCAR uses Windows on-line Help to give you quick reference to information you
many have forgotten so you don’t have to look it up in the manual. If you prefer to learn on line
instead of reading the manual, you will find most of the instructions in this manual adapted for use
on line. You are probably already familiar with Windows Help but, just in case you aren’t, we’ll
give you some basic instructions and point out a few of its standard features and also some of its
special features that VersaImage and VersaCAR take advantage of.

Starting Help

To invoke help, so the following:

1. Select Help from the menu bar

2. Select Help on VersaImage 32 from the Help menu.

You can also access the Help screen directly by pressing F1 .



Chapter 4 - VersaImage/VersaCAR Basics      29

When you access help, you will see a dialog box with 3 tabs:

Contents Displays the table of contents

Index Displays the index.

Find Accesses the full text search feature

Using the table of contents

The table of contents organizes your help topics much like a manual. To use the table of contents,
click the Contents tab.

1. Each  contains a group of related topics.

2. When you double-click on the  it will  and display its contents. It may contain a list of
topics or more . You can open these additional s the same way.

3. To go to a topic in the table of contents, double-click on the topic.

4. To close a , just double-click on it.

Using the index

The index is like the index in a book. It is the place to go when you want to find out what
information there is on a specific item. You search by “keyword” rather than topic name. To use the
index, click the Index tab.

When you select a keyword from an index, a list of help topics related to that keyword will be
displayed for you to choose from. To select from the index, do the following:

1. Type the first few letters of the word or phrase you are looking for in the text box at top of the
index. The index will scroll to that location.

2. Find the keyword you want from the ones listed and double-click on it.

3. If there is only one related topic, you will go directly to that topic. If there is more than one
topic, all topics associated with that keyword will be displayed for you to select from.

4. Some keywords have a large number of topics associated with them. These topics will be
subdivided into “second level” keywords so you can zero in on the topic you want more quickly.

[Rest of instructions will be added when on-line help is completed]

Exiting from the Application

To exit from the program, do the following:

1. Select File from the menu bar.

2. Select Exit from the File menu.

When you exit, any open databases will be closed automatically, so you don’t have to close them
first. However, you may have to close open dialog boxes before you can access the menu.

Hint: For a faster exit, use the  button in the application title bar.
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5 Configuring
Your System

Before you can run VersaImage, VersaCAR, or VersaView, you will need to set up some general
system parameters. You will need to let the program know what hardware peripherals you will be
using and set up your system default directory for your files. If you are using passwords for security
and have more than one user, you will also need to set up your system security.

Configuring Your Peripherals

Your hardware peripherals that interface to the program may include any or all of the following:

Peripheral VersaImage VersaCAR VersaView
Microfilm reader/printer þ þ
Microfilm camera þ þ
Microfilm scanner þ
Paper Scanner þ
Laser or inkjet printer þ þ þ
Fax modem software þ þ
E-mail software þ

Before you configure your peripherals, you should know what options are available and how to set
them up to run with a computer. Since these programs support a number of different devices, there are
a variety of options and consequently a variety of instructions. Therefore, we won’t clutter up the main
manual (which is supposed to be relatively generic) with specifics regarding all of them. The readers,
cameras, and scanners supported at the time of release
are documented in the hardware supplement manual
that accompanies your product. This information is
also available on line. Documentation for any addi-
tional devices supported will be provided at the time
you purchase your software. Laser and inkjet printers
and fax modems use the standard Windows drivers. If
a device runs under Windows, it will run with
VersaImage, VersaCAR, or VersaView.

After your devices are properly set up to work with
your computer, you can configure them to work with
VersaImage, VersaCAR, or VersaView. Configuration
is merely a matter of telling the application what
devices you are using and which options you are using
for each. Your configuration options are found on
either the File menu or the Preferences menu, which
is accessed from the File menu (fig. 5.1).

Setting up your reader/printer

Before you configure your reader/printer, you must make sure that it is set up to run with a computer.
Then you must enter the communications parameters in your VersaImage or VersaCAR application.
The documentation provided in the hardware supplement should contain the information you need to
set up your reader.

} To configure your reader/printer

1. Select File from the main menu.

5

Fig. 5.1. File drop-down menu with Preferences
menu
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2. Select Preferences from the File menu and the Preferences menu will drop down.

3. Select Readers and Cameras from the Preferences menu. A dialog box for entering reader and
camera information (fig. 5.2) will appear.

4. Note that there are two sides to the dialog box—one for your reader and one for your camera.
On the Reader/Printer side, enter the following:

• Click on the  to display the Reader/Printer drop-down list. Use $$  to scroll through the list
until you find your reader/printer controller. Then press Enter .

Note: Only the controllers in the list are supported. You must have one of the listed controllers and
an RS232 interface in order for your reader/printer to work with this system.

• Select the correct value for your equipment from each of the following boxes:

Baud Rate
Com Port
Parity
Data bits
Stop Bits

Note: When you select a reader printer controller, the Parity, Data Bits and Stop Bits are preset to
the defaults for that controller. The baud rate will default to 9600.

5. Click the  button (located near the top of the box). The test box shown in fig. 5.3 will
appear:

• The status in the Status box should read
“Ready.” If it reads “Busy/Off-line”, there is
no communication between your reader and the
system. Recheck your setup parameters.

• If the reader is Ready, use the buttons in the
box to test your reader:

Fig. 5.2. Reader/camera preferences

Fig. 5.3. Reader test box
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Searches for frame 100. Use this for single-level film.

Searches for the 10th “file” blip. Use this for two-level film.

Rewinds the film.

Prints a frame.

• When you have finished testing, press . If your reader did not respond to the tests,
check your setup and communications parameters again. If they appear to be correct, check
your reader/printer manual.

6. When your reader is set up, do one of the following:

• If you have a camera, follow the instructions below to set up your camera.

• If you do not have a camera, or if you are not ready to set up your camera yet, click  to
save your reader setup and close the box.

Hint: You can also access the dialog box for reader and camera setup without going through the
menu by moving your mouse pointer to the status bar and clicking your right mouse button.

Setting up your camera

Before you configure your camera, you must make sure that the hardware is set up to run with
VersaImage or VersaCAR. Then you must enter the communications parameters in your application.
The documentation provided in the hardware supplement should contain the information you need to
set up your camera.

} To configure your camera

1. Select File from the main menu.

2. Select Preferences from the File menu and the Preferences menu will drop down.

3. Select Readers and Cameras from the Preferences menu. The Preferences dialog box for en-
tering reader and camera information (fig. 5.2) will appear.

4. Enter the information about your camera on the Camera (right) side of the box:

• Click on the  to display the Camera drop-down list. Use $$  to scroll through the list until
you find your camera controller. Then press Enter .

Note: You must have one of the listed controllers and an RS232 interface in order for your camera to
work with VersaImage/VersaCAR.

• Select the correct value for your equipment from each of the following boxes:

Baud Rate
Com Port
Parity
Data bits
Stop Bits

5. Click the  button at the top of the box and the test box shown in fig. 5.4 will appear:

• If the status in the Status box reads “Ready”,
the camera is communicating.

• If the status is anything else, there is no com-
munication. Check your setup and communica-
tions parameters again. If they appear to be cor-
rect, check your camera manual.

Fig. 5.4. Camera test
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6. When you have finished testing, click .

7. After your camera is set up, click  to save your setup and close the box.

Setting up your scanner

VersaImage supports most ISIS-compatible scanners. The ISIS drivers are generally available from
the scanner manufacturer. If you are unable to locate an ISIS driver for your scanner, contact Image
Vision Corporation for assistance. Set up your scanner for use with VersaImage as directed in the
scanner manual. If you have communications problems, refer to your scanner manual. After you set
up your scanner, you will need to tell VersaImage which scanner you are using.

} To select your scanner

1. Select Select Scanner from the File menu.

2. Click on Select ISIS Scanner and a dialog box listing the available ISIS scanners will appear
(usually, there will only be one).

3. Highlight the name of your scanner in the list and click .

Setting up your printer and fax

You can use your laser or inkjet printer to print database information and, if you are image enabled,
scanned images. If you are image enabled, you can also send the images directly to your fax
modem. Your printer and fax modem use standard Windows drivers. If they are already installed,
you will not need to install and configure them again. However, you do need to let VersaImage
know what they are.

Note: If you do not have a fax modem, or if you do not want to use your fax modem with the
program, you can use the “fax” option to set up an alternate printer. In this case, your image would
print on your primary printer when you select Print Image and on your alternate printer when you
select Fax.

Both the printer setup and the fax setup functions use the Print Setup dialog box (fig. 5.5).

Fig. 5.5. Print Setup dialog box. Used for setting up your printer and your fax.
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} To set up your printer

1. Select File from the main menu.

2. Select Setup Printer. The Print Setup dialog will appear.

3. The Print Setup dialog box will display your current system default printer as the Default
Printer. To select another device, do the following:

• Click  from the Name drop-down list box to display the list of currently installed printers.

• Double-click on the name of the printer you want to select in the list.

Note: If your printer is not in the list, it is not installed in Windows. You will have to do that first be-
fore you can set it up in this program. Consult your Windows documentation or your printer manual.

4. Set your usual defaults for the following options. Generally, these will be:

Paper Size 8½" by 11"

Source The tray or bin where you generally load your paper for this printer

Orientation Portrait

5. To check and/or change other printer properties, click  to display the Properties
dialog for your printer. In most cases, the settings you usually use should be OK.

Important: The printer you select will become the default printer for your system. If you make changes
to your printer options, it will affect printer setup for your other applications as well. Therefore, if you
use a different default printer or need to run differently for other applications, you will need to change
your printer setup when you run those applications and restore this setup when you run VersaImage.

6. When you have completed your setup, click .

} To set up your fax modem

1. Select File from the main menu.

2. Select Setup Fax. The Print Setup dialog will appear.

3. Select your fax modem from the Name drop-down list box:

• Click  to display the list.

• Double-click on the name of your fax modem.

Note: If your fax modem is not in the list, it is not installed in Windows. You will have to do that
first before you can set it up in this program. Consult your fax documentation.

4. Set your usual defaults for the following options. Generally, these will be:

Paper Size 8½" by 11"

Orientation Portrait

5. To check and/or change other properties for your fax, click  to display the Properties
dialog. You may need to change these settings for VersaImage.

6. When you have completed your setup, click .

Note: Changes you make to your fax modem properties only affect VersaImage. They do not affect
your general fax setup or your fax setup in other applications.



36        VersaImage/VersaCAR/VersaView User’s Guide

Setting up your E-mail system

VersaCAR can be configured to interface with a number of E-mail systems. This allows you to E-
mail scanned images as attachments directly from VersaImage. To use this option, you must use one
of the supported E-mail systems.

} To set up your E-mail

1. Select Preferences from the File menu.

2. Select EMail Setup from the Preferences menu. The E-mail Setup dialog (fig. 5.6) will appear.

3. Select your E-mail system from the Current Mail System Selected list box.

• Click  to display the list.

• Double-click on the name of your E-mail system.

4. Enter your E-mail system password in the Mail System Password field.

5. Click .

Note: If your E-mail system is not listed, you cannot use it directly from VersaImage.

Setting Up System Security

The Modify System Security option permits you to establish and maintain system security by es-
tablishing security levels and entering passwords for all users. If you opted to use passwords when you
installed your software, you will have already entered your system administrator password. If you are
the only user, you will not have to do any more setup at present. However, you may want to change
your password occasionally. If you did not elect to use passwords when you ran setup, you can do so
at any time through this function. You can also disable the password option if you change your mind
and do not want to use them.

We highly recommend that you use passwords for multi-user systems and that you protect your
databases by assigning users to security levels that limit the functions they can do. We also recommend
passwords for single-user systems where other people have access to your machine. Passwords and
security levels can only be changed by users with system administrator security level clearance through
the Modify Security option. The Modify Security option is accessed from the Maintenance menu.

Note: The Maintenance menu cannot be accessed unless all databases are closed.

Fig. 5.6. E-mail Setup dialog box
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Enabling and disabling the password option

You can enable the password option at any time. You
can also disable it if you do not want to use it, even if
you have already assigned passwords.

} To enable or disable the password option

1. Close any open databases and select Maintenance
from the File menu.

2. Select Modify Security (see fig. 5.7) from the
Maintenance menu. If you have not enabled pass-
words, the dialog box shown in fig. 5.8 will be dis-
played. Otherwise, the dialog box shown in fig. 5.9
(page 38) will appear.

3. In the lower left hand corner are two option buttons:

Disable Disables passwords.

Enable Enables passwords.

4. The current option will be selected. To change it, click on the other option. The screen will
change accordingly.

5. To exit from the box, press .

Important: If you just enabled passwords for the first time, you should add your password and your
user passwords NOW (see instructions below) before you exit from this dialog box. When passwords
are enabled, only authorized users will be able to sign on to the system.

Adding users and passwords

If you have enabled passwords, no one will be able to sign on to the system unless they are
“registered” by you through the Modify Security option. To sign on, they will need to enter both their
user names and their passwords. Once signed on, they will only be able to use the functions that are
permitted by their security level. Since only the system administrator has access to the Modify
Security function, you will need to keep track of the passwords you assign to your users so that you
can modify them periodically. You can either determine the passwords yourself or have your users tell
you what password they want to use. (The latter is a better idea because they will more likely
remember them.) If you want to do that, you can always add your users now with “blank” passwords
and enter their security levels. Then you can add their actual passwords later through the Change
Password option after consulting them later.

Fig. 5.7. Selecting the Modify Security option

Fig. 5.8. Modify Security dialog box with passwords disabled
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} To add a user

1. Exit from any databases you have open. Then select Maintenance from the File menu.

2. Select Modify Security to display the Modify Security dialog (fig. 5.9). Your current user list
will appear in the User List drop-down list box.

3. Press  and text boxes for entering the user security information will appear (see fig.
5.10).

4. Enter a one-word sign-on name for the user in the User Name box (e.g., last name, initials,
name/initial combination).

5. In the Password box, enter the password.

6. In the Level of Security box, enter the number of the security level you are assigning:

5 System administrator

4 All functions except security

3 All functions except maintenance and setup functions

2 Index and search only

1 Search only

7. Click  to save the information and add the user.

Fig. 5.9. Modify Security dialog with passwords enabled

Fig. 5.10. Modify Security dialog - Add User option
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Modifying user information

The Change User option allows you to change user names, passwords, and security levels. Passwords
should be changed periodically to protect system security in case they fall into unauthorized hands.
You can also change their security level through this option if the need arises. The Delete User option
permits you to remove users that are no longer authorized to use the system.

} To change user security information

1. Exit from any databases you have open. Then select Maintenance from the File menu.

2. Select Modify Security from the Maintenance menu to display the Modify Security dialog.

3. Press the  next to the User List and click on the user you wish to change. The  and
 push buttons will appear in the dialog box.

4. Click  and the current information for the selected user will appear (fig. 5.11).

5. Enter your changes to the user name, password, or security level.

6. Click  to save the information and update the user.

} To delete a user

1. Exit from any databases you have open. Then select Maintenance from the File menu.

2. Select Modify Security from the Maintenance menu to display the Modify Security dialog.

3. Press the  next to the User List and click on the user you wish to delete.  and
 push buttons will appear in the dialog box.

4. Click  and the current information for the selected user will appear (fig. 5.11).

5. Click  to delete the user from the list.

Warning: The Delete User and Change User options look identical. Make sure you have the selected
the correct option. No confirmation message will be displayed when you delete a user. The user will
just be removed from the list. If you delete someone by mistake, simply add the information again
through the Add User option.

Fig. 5.11. Change User option
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Setting the Default System Path

The last thing you need to do to finish up
your system setup is enter your default
system path. The path you enter will be the
drive and directory (folder) where your data-
bases and other files will be written unless
you specifically select another location at the
time. By default it is set to the VersaImg
directory. If you don’t want to change it,
you do not need to do anything. However, if
you want your files stored elsewhere, you
will find it more convenient to set the default
system path to that directory.

} To change the default path

1. Select Preferences from the File menu.

2. Select Defaults from the Preferences
menu. The Defaults dialog box (fig.
5.12) will appear.

3. In the Default Path box, press . The Set System Default Path dialog box (fig. 5.13)
will open.

4. Select the drive where your folder is located from the Drives list box.

5. Select the folder you want to use from the Directories list box.

6. Click  to set your path and you will return to the Defaults dialog box. The path you set
will be displayed under Default Path.

Note: The folder you want to use must be created BEFORE you select it as your default path. You
cannot create folders “on the fly” as you can with the standard Open dialog boxes usually used in
Windows 95. If you have not already done so, create the folder through Windows Explorer.

Fig. 5.12. Defaults dialog box

Fig. 5.13. Set System Default Path dialog box
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6  About
Databases

Your database is your link to your indexed documents. How they are linked depends on whether you
are indexing microfilm documents or paper documents:

n You index your microfilm documents to your database by roll and frame numbers. The record
can optionally be linked to a scanned image of the document (or set of documents).

n You index your paper documents to scanned images. The index record is associated with the
image file name.

A database in VersaImage can contain both types of documents. VersaCAR supports microfilm
indexes only.

Database Records

The database record links your film frame or scanned image to searchable data. You can define
whatever fields you want for your record.

All databases should contain the following:

• The field or fields you want to search for the document with. You can have as many of these
as you want.

• Whatever additional fields you want to include for information purposes.

Databases that are to be indexed to roll film must contain roll and blip (frame number) fields. These
fields are used to associate the record with the specific film frame. They are filled in automatically
when you index your film. These values can also be imported if you have already indexed your film
in another CAR system. Non-film databases do not use these fields.

Databases that include images must be image enabled. This can be done either when you create your
database or from the File menu. When a database is image enabled, a field for the image file name
and path is added to the record. This field is filled in automatically when you index your images.

Placing records in your database

There are a number of different ways to place index records in your databases.

If you are indexing roll film, you have these options:

n If you are currently using VersaCAR for DOS, you can simply import your DOS databases.

n If your microfilm is already indexed to a database (CAR system), you can create a matching
VersaImage or VersaCAR database, then import pertinent data from your existing database. The
data must be in either a flat ASCII file or a comma-separated file. The records can contain a roll
number and a frame number.

n If you have a database that already contains the data you want for the record, you can import the
data from the database (same qualifications as above) and then index them to your documents at
either your reader or at the camera.

n You can create and index your database from scratch at either your reader or your camera.

6
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In all cases, if you have VersaImage and microfilm scanning capabilities, images can be associated
with each record. This enables faster and more versatile viewing or printing because you do not
have to be at the microfilm reader to access them.

If you are indexing paper documents, you have these options:

n If you have a database that already contains the data you want for the record, you can import the
data from database. Then you can scan your documents and link the images to your database.
The data must be in either a flat ASCII file or a comma-separated file.

n If you have the images stored but no data records associated with them, you can import the
images and then enter the data.

n If you have both a database and stored images but they are not linked, you can import both and
then link them.

n You can create your database from scratch and then scan and link the images.

n You can scan and index the images in one step on a folder-by-folder basis.

Most likely, you will be using more than one method to index your documents in the lifetime of
your system. You might, for example, import as much data as you can for your currently stored
documents. Then, for new documents, you might create your records as you scan or photograph
them. The options are yours to choose from. Select the ones that work best for you.

Types of Indexes

There are two basic ways to associate index records with documents:

n Each document can be associated with a record.

n Documents can be grouped into subgroups where one record is associated with a group.

The way this is done depends on whether you are indexing film or paper or both. You can have the
following types of databases:

n Standard film databases, where all records in the database are indexed to roll film. They may or
may not have scanned images.

n Standard paper document databases, where all records in the database are indexed to scanned
images.

n Hybrid databases, which contain both film and paper indexing.

n Master reference databases, which contain a table of master records with common identification
data and a reference table containing the records for the indexed documents. These indexes can
be film only, paper only, or hybrid.

Film indexes

When you index film, the type of indexing you use depends on your film type. VersaImage and
VersaCAR support the following types of indexing:

n Single-level indexing where you index every frame. This is the standard method for film with
single-level blips.

n Single-level indexing where frames are grouped into logical subgroups. This method simulates
two-level indexing for film with single-level blips by indexing only the first frame of each logical
group.

n Two-level indexing. This is the standard method for film with two-level blips.

n Three-level indexing. This is the standard method for film with three-level blips.



Chapter 6 - About Databases      45

If your documents are primarily one-page documents that are not related to each other, single-level
indexing with one record per frame is generally best. If your documents are generally multi-page
documents or if you have groups of documents that are related to one another, either two-level
indexing or, if you do not have two-level film capabilities, single-level indexing with subgroups is
best. Image Vision generally does not recommend three-level indexing. However, if your applica-
tion requires it, VersaImage and VersaCAR will handle three-level indexing schemes.

A more detailed description of each of the above options is given below. If you do not index film at
all, you may want to skip to “Paper Document Indexes” on page 46.

Single-level indexing

If you index each frame, you will fill in a database record each time the film stops on a frame:

You search the film on a frame-by-frame basis to find the document you are looking for. If you are
image enabled and scan your images into VersaImage, the individual document image will be dis-
played for each record.

Two-level indexing

To do true two-level indexing, you must have film that has two levels of blips¾a “file” blip and a
“page” blip. You must also have a reader that can support two-level indexing. In two-level
indexing, each frame with a file blip has a record in the database. This frame is generally the start of
a file or subgroup of related documents:

When you search your database, you will search for the index record for the subgroup where your
document is located. You then locate the document you want on film by “paging” through the group
of documents on your reader. If you have scanned images for the roll, thumbnail images of the
documents in the subgroup will be displayed and you will be able to zoom in on the one you want.

Note: It is also possible to index “pages” within a “file.” More will be said about how to do this in
Chapter 17.

Single-level indexing with subgroups

This method of indexing simulates two-level indexing for film with only single-level blips. When
your film is shot, your documents are grouped into logical subgroups. You then add a database
record for the first frame of each group:
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When you search your database, you search for the index record for the subgroup and page through
the documents in the group.

Three-level indexing

For three-level indexing, you must have film that has three levels of blips¾a “batch” blip, a “file”
blip, and a “page” blip. You must also have a reader that can support three-level indexing. In
standard three-level indexing, each frame with a batch blip and each frame with a file blip have
records in the database. The file blip is generally the start of a file or subgroup of related documents
and the batch blip is generally a group of related files:

When you search your database, you will search for the index record for the group (batch blip) or
subgroup (file blip) where your document is located. You can then locate the document you want on
film by paging through the documents on your reader. If you have scanned images for the roll,
thumbnail images of the documents in the subgroup will be displayed and you will be able to zoom
in on the one you want.

With three-level film, you also have the option of indexing batch blips only. In this scheme, you
would have an index record for each batch blip.

Note: It is also possible to index individual pages. More will be said about how to do this in Chapter
17.

Paper document indexes

When you index paper documents or other non-film images, you have the following options:

n Single-page TIFF images where you index each page

n Single-page TIFF images with images grouped in “folders”, which allows you to group single
TIFF pages as one document

n Multi-page TIFF images

Single-page images without folders

When you index single-page images individually, each image has a record. You search for the image
on a record-by-record basis. Each image will be displayed with its associated record.
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Single-page images with folder files

When you group the images into folder files, each group has an index record. You search for a
document by searching for the record. All pages in the group will be displayed with the record.

Multi-page TIFF files

Multi-page TIFF images store the separate pages of a document in one file. There is a record for
each file. You search the database on a record-by-record basis. All pages in the file will be dis-
played with the record.

Note: With manual intervention, you can create folders in databases with single images to accommo-
date the occasional multi-page document.

Hybrid indexes

VersaImage can fully support hybrid indexing schemes where you combine both film and non-film
indexing in the same database. They can be as simple as single-page records, each of which are
indexed to either film or paper, to a complex scheme, which places images scanned from film and
images scanned from paper in the same folder file. Before you design a hybrid indexing scheme,
you should understand how both film and paper indexing work.

Master reference indexes

The master reference index can be film, paper, or hybrid. These databases consist of a master
record table, which contains a master record for each document set and a reference table, where the
documents are indexed and linked to the master records. Master records contain information that
applies to the document set. The document index records contain information specific to the
document. There can be any number of document index records linked to a single master record. (In
database jargon, this is referred to as a one-to-many relationship.) A bank’s lending department
might, for example, create a master record for each loan and add an index record for each document
required for the loan. A hospital medical records department might create a master record for a
patient, then link all documents related to a patient’s stay (admission forms, insurance provider
information, discharge form, etc.) to the master record.

A linking field (e.g., a loan number, a patient ID, a case number) links the individual document
records in the reference table to the master record. When you search a master reference database, you
search for the master record you want. When the master record is retrieved, all documents associated
with it in the reference table are retrieved for it so you can select the ones you want to view.

Because of its two-table structure, master reference indexing lends itself nicely to hybrid indexing.
This is far and away the best scheme to use if you have sets of related documents you want to group
together that come from different sources. A big advantage of this database over standard multi-level
indexing is that your group of documents does not have to be indexed at the same time. You can
index documents from roll film one day, index scanned images from one department (e.g., loan
applications) on another, and add supporting information at a different time—all to the same master
records. Each document, regardless of source or length, can (and usually does) have an index
record. This is less “messy” than placing several documents of varying lengths in a single folder.
While individual “page” records can be added for the latter, retrieval is generally easier and cleaner
with the master reference setup.

Database Files

When you create your database, several files and folders are created. Unless you specify another
location, they are placed in your default directory. A VersaImage database has the following:
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n A .CAR file, which contains your field definitions.

n An .MDB file, which contains your data records and other processing record information.

n A folder for image files if the database is image enabled.

Because it does not support scanned images, VersaCAR will not have an image folder. It will,
however, have both a .CAR file and an .MDB file. Do not delete either of these files or the image
folder or try to change or create them other than through VersaImage or VersaCAR. If either the
.CAR file or the .MDB file is missing, you will not be able to open your database. If your image
folder or any of its contents is removed, you will not be able to retrieve all or part of your images.
If you try to change or create these files outside of VersaImage or VersaCAR, unpredictable results
may occur.

What to Do Next

What you do next depends on how you plan to create your database:

n If you are importing your databases from VersaCAR for DOS, you do not need to define your
database in advance. Your database will be defined for you automatically when you import it. Go
directly to Chapter 9.

n For all other databases, you will first need to define your database. Go to Chapter 7.



7  Defining a
Database

Unless you are importing your database from VersaCAR for DOS, your first step in indexing will be
to define your database. In order to create your database, you will first need to decide which type of
indexing you are using. If you have not yet read Chapter 6, which explains your options, you should
do so before you follow the instructions in this chapter.

Note: If you plan to create a master reference database, you will find specific instructions in Chapter
8. You should, however, read this chapter first to learn the basics of database creation before you
try to create a master reference database.

Determining What Fields You Need

Because you cannot change your data field definitions or their order after you have created your
database, you should give careful thought to how you want them defined.

What fields to include

What you include is mostly up to you. Here are some general guidelines:

n At the very least, you will need the fields you want to use to search for the record. In an invoice
file, for example, you would probably want to be able to look up by either customer name or
invoice number. You might also want to be able to screen by date.

n Databases for indexing roll film (including “hybrid” databases) must include roll and blip number
(frame number) fields. These fields are not needed for databases that are strictly “non-film.”

n Other information about the document that further identifies it or gives information about its con-
tents may be included as needed.

n For your own benefit, the combination of fields you end up with should uniquely identify the
record.

If you are going to import data from either a flat file or a comma-separated file, you will probably
want to duplicate the fields in that file. However, you do not have to use all of them, only those that
will be of value in finding and retrieving or identifying your documents. You should, however,
know the sizes of the fields you are going to import because, if the field is larger than the one you
define, you will not be able to import it.

Note: The Image Address field will be added automatically to your record if you image enable the
database. Do not add this field yourself.

Field order

The order in which you define your fields is the order in which they will appear on the screen for
searching. Therefore, you need to decide what you want to see first. In general, you should select
the most commonly searched field as the first field, the second most commonly searched field as the
second, etc. Fields that are almost never searched should be placed at the end. By arranging your
fields in such a manner, you will eliminate the need for excessive tabbing by the persons who use
the database.

7



50      VersaImage/VersaCAR/VersaView User’s Guide

The field order can be changed for indexing purposes so data entry while indexing is not an issue.
Your primary purpose is information retrieval and you should arrange your fields in a way that is
efficient for the users who will be retrieving the documents.

Entering Your Database Parameters

Your first step in creating a database will be to enter the parameters that describe the database.

} To define your database parameters

1. From the File menu, select New Database. The New Database dialog box (fig. 7.1) will appear.

2. Select the folder where you want the database to be located. Make sure it appears in the Save in
field at the top of the box.

Note: This dialog box is a standard Windows 95 Save dialog. If you do not know how to select a
folder, refer to page 27 in Chapter 4.

3. Enter the name of your database in the File name field. You do not need to enter an extension.
The .CAR extension will be added automatically.

4. Click  and the Create Master Table dialog box (fig. 7.2) will appear.

5. Enter a name for your database in the Title field that helps you identify the contents of the
database. You can use your file name or you can enter a more descriptive name if you wish.
This title will be displayed in the Windows title bar when you open the database.

6. If you are indexing film, select the type of film you will be indexing:

1 Level If you are indexing film with single-level blips.

2 Level If you are indexing film with two blip levels.

3 Level If you have film with three blip levels.

Note: This field is ignored if you are indexing paper so, if your database is strictly non-film, just
leave it at level 1.

Fig. 7.1. New Database dialog box
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Defining Your Database Fields

Once you have defined your database parameters, you are ready to define your database fields.

} To define a database field

1. Click  and the Add Field
Definition dialog box (fig. 7.3) will appear.

2. Enter the Field Name. It can be up to 30
characters long and must begin with a letter.

3. Press the  and select a field type from
the drop-down list:

AlphaNumeric All characters accepted.

Numeric Numbers only.

Number, SSN Social Security Numbers in NNN-NN-NNNN format.

Date Date field in MM/DD/YY format (or YYYY if Windows is configured for
four-digit years).

Roll Roll number. Your record must have a roll field to enable microfilm controller
functions.

Blip Blip field (frame number). Your record must have a blip field to enable the
microfilm controller functions.

4. For AlphaNumeric, Numeric, and Roll fields, you must enter a field length. Automatic field
lengths will be entered for Numeric, SSN (9), Date (8), and Blip (six characters for single-level
indexes, 13 for two-level, and 20 for three-level).

Fig. 7.2. Create Master Table dialog box

Fig. 7.3. Add Field Definition dialog box
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5. If you selected Numeric as your type, you may want to define a specific field format. You can
do either of the following:

• Press  from the Field Format drop-down list box (fig. 7.4) and select one of the four types:

#,###.00 Comma separators, two
decimal places.

$#,###.00 Monetary amount with
dollar sign.

000-00-0000 Social security format.

000-000-0000 Phone number format.

• Enter your own format definition using
Microsoft’s numeric picture conventions. For
further information, refer to Appendix C.

If you do not enter a format, standard integer
(i.e., no decimal places) with no commas will be
assumed.

6. You may optionally add data entry verification to any field. Select the type you want from the
Verificaton list box:

Dbl Key Double-key verification. When a field has this attribute, the value must be entered
twice and both entries must match before it is accepted.

Mod10 Mod 10 check-digit verification. When a field has this attribute, the number must
internally verify according to Module 10 check-digit rules. The last digit is calculated
based on the previous digits.

7. If you want a “fast search” on the field, check the Fast Search check box. A fast search pro-
vides much quicker access to your records. However, because of the table it builds, it takes up
more disk space. So, if space is at a premium, you will want to confine this attribute to only the
fields you will usually search on.

Note: To help speed up the QC function and the Export function, the Roll field should be designated
as a fast search field.

8. If you are defining a Numeric field and want the field to be zero-filled, check the Zero Fill
check box.

9. Click  and the box will close. The field you have just added will be displayed in the
Create Master Table box (fig. 7.5).

Fig. 7.4. Add Field dialog box with field type list

Fig. 7.5. Create New Database dialog box showing entered fields
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Modifying and Deleting Fields

You can always modify or delete your last entry. It is important to note, however, that you cannot
modify or delete any field but the last field. If you find you need to make changes to another field,
you will need to delete all of the entries that appear after that field, modify the field, and then add
the fields you deleted again.

} To modify a field

1. Click  and the Add Field Definition box will be redisplayed with the information
you entered in the last line.

2. Make whatever changes you want to make to your definition.

3. Click  to place your changes in the line on the screen.

} To delete a field

1. Click  and the Add Field Definition box will be redisplayed with the information
you entered in the last line.

2. Click  to delete the field.

Completing Your Database Definition

When you finish defining your fields, you will need to save your database. Be sure you have defined
all the fields you need because, once you have created a database, you will not be able to add or
delete fields.

} To save your database

1. Click .

2. If you did not include Roll and Blip fields, a message will inform you that microfilm access will
be disabled. Click on one of the following:

If you intended to create a non-film database.

If you left these fields out by mistake and wanted to add them before you save your
database.

Warning: You cannot add Roll and Blip fields after your database is created.

3. Before your database is saved, you will see a confirmation message:

Are You Sure?

Press one of the following:

To create your database.

To return to the Create Master Table dialog box and make changes or additions to your
definition.

4. After you give your confirmation to create the database, you will be asked whether or not you
want to image enable the database. Select one of the following:

If your database is going to include images.

If your database is not going to include images.

Note: You can always image enable a database later from the File menu.
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Your Next Step

After your database is created, you are ready to populate it. Since there are so many different ways
to do this, the chapter you go to next depends on what you want to do:

n If you are going to import a data file, go to Chapter 10.

n If you are going to enter your records while you index your film, go to Chapter 16.

n If you are importing images to index or plan to scan images to index, go to Chapter 11 and read
about images. This chapter will direct you to the chapters you need for your next operation.



8  Defining a Master
Reference Database

Master reference databases are a special type of database that allows you to index a number of
different document types to a single master record. A mortgage application, for example, contains a
number of different forms. You could create a master record for each application and then index
each document as a separate record linked to the master record. When you search for a document in
a master reference database, you would first look for the master record. Then you would retrieve the
document you want to see for that record.

The documents you attach to a master reference record can be from either film or paper and can be
either single- or multi-page documents. This chapter assumes that you have read Chapters 6 and 7,
are familiar with the different indexing options available, and know how to define a standard
database. If you have not read these chapters, you should do so before you try to create a master
reference database.

Determining What Fields You Need

A master reference database consists of two tables. The master table contains the master records and
the reference table contains the document index records. You need to define both the fields for your
master record table and the fields for the reference table when the database is created. You cannot
change your data field definitions or their order after you have created your database.

The master record

The master record should contain the basic identification information for the group of documents.
You should include all fields that you may want to search for the master record on. Here are some
ideas:

n Loan number, case number, or other type of identification number

n Name of person or organization associated with the document group

n Social security number or tax ID

n Date

You might also want to include other general information, such as address information, loan
amount, or other data you might want available when you consult the document records. This infor-
mation will remain displayed for all documents in the record.

Note: You may want to import the master data from either a flat ASCII or a comma-separated file. If
you do, make sure you know the sizes of the fields you are going to import from because, if the field
is larger than the one you define, you will not be able to import it.

The link field

One field in the master record must be designated as the link to the reference table where the document
records are stored. The link field will be placed in each reference table record automatically. The link
value of the associated master record will be placed in the link field of each document record.
VersaImage uses this value to find the document records linked to a given master record.

The link field value must be unique to each master record. It is recommended that this field be
numeric. Good candidates are loan numbers, case numbers, etc. If your master record does not
contain any numeric fields, you may want to create an “artificial” record number field for linking.

8
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The document index records

The document index records should contain identification data for the specific document. Although
the contents is up to you, at the very least, you should probably include the following:

n Document identification number or other unique identifier for the type of document.

n Document name or title (advisable unless the numeric identifiers are as well known as Form
1040!)

n Document date

n Roll and blip numbers (required for databases that will contain indexes to roll film)

You can safely skip the roll and blip numbers if you do not index roll film. If you index roll film at
all, it is probably best to include them, even if you don’t think you will need them.

Note: The Image Address field will be added automatically to your record if you image enable the
database. Do not add this field yourself.

Field order

The order in which you define your fields is the order in which they will appear on the screen. As
with standard databases, you will be able to rearrange them for indexing if necessary, so you should
give primary consideration to arranging them for efficient searching. Usually, you will want to place
your link field first since it is the unique master record identifier. However, if it is not a field that is
usually searched on, you may want to place another one in that position.

Your document records are selected for viewing from a table display screen. The table fields are
placed in the order in which they are defined in your database. Therefore, you should place the
fields by which the document can be most easily identified as your first fields.

Entering Your Database Parameters

Your first step in creating your database will be to enter the parameters that identify it as a master
reference database.

} To define your database parameters

1. From the File menu, select New Database. The New Database dialog box (fig. 8.1) will appear.

Fig. 8.1. New Database dialog box
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2. Select the folder where you want the database to be located. Make sure it appears in the Save in
field at the top of the box.

3. Enter the name of your database in the File name field. You do not need to enter an extension.
The .CAR extension will be added automatically.

4. Click  and the Create Master Table dialog box (fig. 8.2) will appear.

5. Enter a name for your database in the Title field that helps you identify the contents of the
database. You can use your file name or you can enter a more descriptive name if you wish.
This title will be displayed in the Windows title bar when you open the database.

6. Select Reference as the database type from the Indexing options.

Defining Your Master Record Fields

Once you have defined your database parameters, you are ready to define the fields for your master
record. Make sure that you include a link field in your definition. Do not include roll or blip number
fields. While you are defining your table, you may modify or delete the last field. Be sure, however,
to complete all necessary modifications before you define the reference table.

Note: We are assuming that you read Chapter 7 and already know how to define a database field, so
we will skip some of the details here. More detailed information can be found on page 51.

} To define a database field

1. Click  and the Add Field Definition
dialog box (fig. 8.3) will appear.

2. Enter the Field Name.

3. Press the  and select Field Type from the
drop-down list.

4. Enter the Length for Numeric and Alpha-
numeric fields. Automatic field lengths will be
entered for Numeric, SSN and Date fields.

5. Enter any of the optional fields you want to
apply to your data field:

Fig. 8.2. Create Master Table dialog box with the Reference option selected

Fig. 8.3. Add Field Definition dialog box
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• Field Format and Zero Fill can be applied to numeric fields only.

• Verification and Fast Search are can be applied to any field.

For detailed information on the above, refer to page 51 in Chapter 7.

6. Click  when you finish and the definition will be added to the table.

} To modify your last field

1. Click  and the Add Field Definition box will be redisplayed with the information
you entered in the last field.

2. Make whatever changes you want to make to your definition.

3. Click  to place your changes in the line on the screen.

} To delete your last field

1. Click  and the Add Field Definition box will be redisplayed with the information
you entered in the last line.

2. Click  to delete the field.

Defining Your Reference Table

Once you have defined your master table fields, you can define and complete your reference table.
Make sure you have defined all fields in your master table first. Unpredictable results may occur
when you add or change fields in the master table after completing your reference table.

} To define your reference table

1. Click the  button in the Create
Master Table dialog box. A dialog box (fig.
8.5) will appear so you can select your link
field.

2. The link field connects the document records in
the reference table to the master table record.
Select the field you want to use from the Link
Field list box.

Fig. 8.4. A typical set of fields for a master table

Fig. 8.5. Define Link Field dialog
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3. Click  and the Create Reference Table dialog box (fig. 8.6) will appear.

4. If you will be indexing roll film for this database, select the type of film you will be indexing:

1 Level If you are indexing film with single-level blips.

2 Level If you are indexing film with two blip levels.

3 Level If you have film with three blip levels.

Note: This field is ignored if you are indexing paper so, if your database is strictly non-film, just
leave it at level 1.

Adding Your Reference Table Fields

Your reference table fields to define your document records are added in the same way as you added
your master record fields. If you are indexing film in your database, don’t forget to add Roll and
Blip fields. As with master records, you can modify or delete the last field in the table. Make sure
that you complete all necessary modifications before you close this dialog and return to the Create
Master Table dialog.

} To define a reference table data field

1. Click  and the Add Field Definition dialog box will appear.

2. Enter the Field Name and select the Field Type.

3. Enter the Field Length for AlphaNumeric, Numeric, and Roll fields. Automatic field lengths
will be entered for Numeric, SSN, Date, and Blip fields.

4. Enter whichever of the optional fields apply.

Note: To help speed up the QC function and the Export function, the Roll field should be designated
as a fast search field.

5. Click  and the box will close. The field you have just added will be displayed in the
Create Reference Table box (fig. 8.6).

Completing Your Database Definition

When you finish defining your reference table fields, you will need to save your database. Make
sure you have defined all the fields you need for your document index record before you leave the
Create Reference Table dialog.

Fig. 8.6. Create Reference Table dialog box with document record fields entered
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} To save your database

1. Click  in the Create Reference Table dialog box to save the reference table and return to
the Create Master Table dialog box.

2. If you did not include Roll and Blip fields in your document records, a message will inform you
that microfilm access will be disabled. Click on one of the following:

If you intended to create a non-film database.

If you left these fields out by mistake and wanted to add them before you leave the
reference table dialog.

Warning: You cannot add Roll and Blip fields after your database is created.

3. Click  in the Create Master Table database to save your database.

4. Before your database is saved, you will see a confirmation message:

Are You Sure?

Click  to create your database.

5. You will be asked whether or not you want to image enable the database. Select one of the
following:

If your database is going to include images.

If your database is not going to include images.

Note: You can always image enable a database later from the File menu.

Your Next Step

After your database is created, you are ready to index. Since there are so many different ways to do
this, the chapter you go to next depends on what you want to do:

n If you are going to import your master data record from a data file, go to Chapter 10.

n If you are indexing film only and will not be scanning images, go to Chapter 16.

n If you are importing images to index or plan to scan and index your images, go to Chapter 11
and read about images. This chapter will direct you to the chapters you need for your next
operation.



9 Importing VersaCAR
for DOS Databases

If you have VersaCAR for DOS, you simply import and go. You don’t even have to define a
database first. VersaCAR for Windows takes care of everything! You can start using your database
immediately. This feature enables seamless integration with VersaCAR 32. If you have upgraded to
VersaImage and have a film scanner, you can add such features as scanned images to your existing
database after you import it.

Importing Your Data

To import your VersaCAR for DOS databases, your VersaCAR for DOS databases must be either
on the same machine or accessible from your network.

} To import a VersaCAR for DOS database

1. Select Tools from the main menu bar. Then select
Import from the Tools menu (fig. 9.1). (Actually,
it’s the only one you can select without a database
open.)

2. When the Import menu pops out, select VersaCAR
for DOS, which once again is the only thing you
can select.

3. The Open dialog box will appear on the screen. Navigate to the folder where your VersaCAR
for DOS databases are stored.

4. In the list of files displayed, you will see one called CATALOG.TXT. Select CATALOG.TXT
and click . Immediately, the Import VersaCAR for DOS dialog box (fig. 9.2) will appear:

• On the right side, you will see the available import options.

• On the left side, you will see the record fields for the first available option.

5. From the available databases displayed on the right, select the one you want to import. When
you select it, its full name will appear in the box and its fields will appear on the left.

9

Fig. 9.1. Import menu

Fig. 9.2. Import VersaCAR for DOS dialog box

Available
databases

Error handling
options
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6. Select your error handling method:

Write Errors to File Skips records with errors and writes them to a file.

Correct During Import Stops for errors during import so you can correct them.

7. Click  to start the import and import the first record. The record will be displayed in the
fields (fig. 9.3). A progress message box at the top of the screen will display the number of
records in the file.

8. A message box will appear on top of the dialog box asking you if you want to continue im-
porting. You have three options:

Imports records one at a time. Each time you click , another record will
be imported and displayed.

Imports the file without stopping.

Cancels the import.

You will probably want to import several records singly to make sure that they are coming in as
they should be. Once you are satisfied that the records are OK, you can click  to start
importing the file.

 Hint: If your records are covered by the message box and you want to read them, drag the message
box to another position on the screen.

9. If you decided to correct errors during import, the system will stop every time it encounters an
error:

• A dialog box containing the error
message and current data will appear
(fig. 9.4).

• At the bottom of the box, you will
find a text box. Enter your correction
in the box.

• Click  to continue.

Fig. 9.3. Import VersaCAR for DOS dialog box with first record displayed

Fig. 9.4. Import error correction box
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10. When the import is finished, the Import dialog box will close and you will see a completion
message:

• If there were no errors, the message will say so. Your database is imported and ready to go.

• If there were errors and you elected to have them written to a file, the message will display
the number of errors and the names of the error files. Information on handling these errors is
given below.

Error Files

If you elected to have your errors written to a file, the import program will write records with errors
to a file instead of importing them. There are two error files. Each has the same name as your
database. One has the extension .ERR and the other .ERD:

.ERR Contains the type of error.

.ERD Contains the raw data record.

You can examine the error files through the Windows Notepad application. Just choose Notepad
from the Accessories group and retrieve the file.

You will need to add these records to your database manually. The easiest way to do this is through
the Indexing From Paper option (Chapter 20). It allows you to enter the complete record including
roll and frame numbers. You can also add records through the QC function.

What to Do Next

What you do next depends on what else you want to do with your database and what product you are
using:

n If you just want use your database as is, go to Chapter 23 for information on searching your
database.

n If you want to add more records to your existing database, go to Chapter 16 for information
about indexing.

n If you have upgraded to VersaImage and want to add scanned images to your database, go to
Chapter 11.
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10 Importing Data
from External Databases

VersaImage and VersaCAR have built-in functions to import data from three types of data files:

n Flat ASCII files

n Comma-separated files

n Kofax Ascent files

This is particularly time saving if you already have your microfilm indexed to a database or if you
have your identification data already entered in a file.

For standard databases, you may import complete index records or you may use the database to
retrieve pertinent information, such as identification information, so you don’t have to enter it when
you index. Data records that are already indexed to microfilm with roll and frame numbers are
“ready to go” as soon as they are imported. Data records that are not already indexed to documents
will need to be associated with either roll film or scanned images.

For master reference databases, you can import data for your master record fields. You may also
import data for your first document index record if it is in the same database record as your master
record data. You cannot import data for additional document records. Your document records can
be added to the database and linked to the master record through the indexing function.

Before you import data from an external database file, you must first define a database for your data
as explained in Chapter 7. If you have not yet done so, return to that chapter for instructions.

Important: The file extension of your import file will be changed to .DON after the import is
finished. You will need to change it back to its original name if it is accessed by other programs. If
you want to avoid this altogether, create a copy of your import file in Windows Explorer. Either give
the file a different name or place it in a different directory.

Importing from a Comma-separated File or Kofax Ascent File

Comma-separated files and Kofax Ascent files use the same import dialog. The only difference
between the two is that Kofax files may be associated with images, which are imported at the
same time.

Selecting your files

Your first step is to open the VersaImage or VersaCAR database you want to import your file to.
Then you must select your import file.

} To open your .CAR database

1. Select Open Database from the File menu. The Open dialog box will appear.

2. Select your database from the Open dialog box.

3. Click on  and the fields you have defined for your record will appear on the screen.

10
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} To select a comma-separated file database to import

1. Select Import from the Tools menu.

2. Select Comma Separated File (fig. 10.1) from
the Import menu. The Open dialog box will
appear.

3. If your file does not have a .CSV extension, press
 to display the drop-down list and select either

Text File (for .TXT extensions) or All Files (for
any other extension).

4. Find the folder where your file is located.

5. Select your file and click on . The Comma Separated Import Setup dialog box (fig. 10.2)
will appear.

} To select a Kofax Ascent file database to import

1. Select Import from the Tools menu.

2. Select Import Kofax from the Import menu. The Open dialog box will appear.

3. The default file type is Kofax Ascent File with the extension .TXT. If your file does not have
this extension, press  to display the drop-down list and select All Files.

4. Find the folder where your file is located.

5. Select your file and click . The Kofax Import Setup dialog box will appear. It is identical
to the Comma Separated Import Setup dialog (fig. 10.2).

Importing your data

Once you have selected your import database, the import procedure is the same for both comma-
separated files and Kofax files. On the left side of the dialog box, you will see the fields in the
VersaImage or VersaCAR database record. On the right you will see the data from the first record
in your import file. A scroll bar will permit you to scroll through the information. To import your
data, you will first need to map the fields in your import file to the fields in your .CAR record and
select your import options.

Fig. 10.1. The Comma Separated File option

Fig. 10.2. Comma Separated Import Setup dialog box. The Kofax Import Setup dialog box is identical.
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} To map your fields

1. For each field you want to import, do the following:

• Click on the VersaImage or VersaCAR database field. The number of the field you clicked on
will be highlighted.

• Click on the value in your displayed record that you want to import to that database field. The
value will be displayed next to the field on the left.

2. When you finish, your screen will look something like the one shown in fig. 10.3.

Note: You do not have to import all of your fields or fill all of the fields in your database, only the
ones that you need.

} To select your import options

1. Select your error handling method:

Write Errors to File Skips records with errors and writes them to a file.

Correct During Import Stops for errors during import so you can correct them.

2. If you want leading zeros in alphanumeric fields deleted upon import, enable Delete Leading
Zeros in Alpha Fields in the Options group.

3. If you are importing Kofax files and want to have your multi-page TIFF images converted to
folder files, select Convert Multi-Image TIFF to Folder File. (This option will be grayed out
for comma-separated files.)

} To import your data

1. Click  to start importing the file. A processing message at the top of your screen (fig.
10.4) will display the number of records in the file.

Fig. 10.3. Comma Separated Import Setup dialog showing data selected for import

Fig. 10.4. Import processing message—comma-separated files
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2. A message box (fig. 10.5) will appear asking you if you want to continue importing. You have
three options:

Imports records one at a time. Each
time you click , another
record will be imported and displayed.

Imports the file without stopping.

Cancels the import.

You will probably want to import several records singly to make sure that they are coming in as
they should. Once you are satisfied that the records are OK, you can click  to start
importing the file.

Note: During import, the processing message (fig. 10.4 ) will show you how much of the file has
been processed.

3. If you decided to correct errors during import, the program will stop every time it encounters an
error:

• A dialog box (fig. 10.6) containing
the error and the current field data
will appear.

• At the bottom, you will find a text
box. Enter your correction in the
box.

• Click  to continue.

4. When the import is finished, the dialog box will close and you will see a completion message:

• If there were no errors, the message will say so. Go to the chapter for your next step:

Chapter 11 If your database will include images.

Chapter 16 If you will be indexing your database to microfilm.

Chapter 23 If your database does not require indexing.

• If there were errors and you elected to have them written to a file, the message will display
the number of errors and the names of the error files. For error handling information, go to
page 72.

Hint: If you are importing data from a number of comma-separated files with the same structure,
you may want to check out the template function. This function saves your structure as a reusable
template. See page 72 for details.

Importing from a Flat ASCII File

A flat ASCII file is a file where all records are the same length (fixed length record) and all of the
field data in each and every record is in the same column position within each record.

Selecting your files

First, you must open the .CAR database you want to import your data into. Then you must select
your import file.

Fig. 10.5. Import processing options

Fig. 10.6. Error correction for comma-separated files
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} To open your database

1. Select Open Database from the File menu. The Open dialog box will appear.

2. Select your database from the Open dialog box.

3. Click  and the fields you have defined for your record will appear on the screen.

} To select your import file

1. Select Import from the Tools menu.

2. Select Flat ASCII File (fig. 10.7). The Open dia-
log box will appear.

3. If your file does not have a .TXT extension, press
 to display the drop-down list and select All

Files.

4. Find the folder where your file is located.

5. Select your file from the list and click . The dialog box for importing flat files (fig. 10.8)
will appear.

Selecting fields to import

The left side of the screen will contain the fields in the .CAR database record. On the right side, the
first record in your import file will be displayed in a box at the top. The right side of your screen is
used for selecting your fields to import. You select fields by selecting the data that is in that field in
the displayed import file record.

There are several methods you can use to select your fields from the record:

n Use your mouse

n Enter the starting position and length

n Enter the starting and ending position

Fig. 10.7. The Flat ASCII File option

Fig. 10.8. Flat ASCII file import screen
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} To select the field with your mouse

1. Position your mouse pointer at the start of the field in the record.

2. Hold your mouse button down and drag the pointer until the field is highlighted.

3. When you release the button, the field value will be displayed below the record. Its starting and
ending position will be displayed in the From, To, and Length fields.

4. If the value displayed shows that the field length or position is not correct, make corrections by
changing the values in the From, To, and/or Length text boxes.

} To enter the starting position and field length

1. Position your insertion point in the From text box and type the starting position for the field.

2. Press Tab  to move to the Length text box and enter the field length.

• The ending position will be calculated automatically and displayed in the To text box.

• The field will be highlighted in the record and the data in the field you selected will be
displayed below the record.

3. If the value displayed shows that the field length or position is not correct, make corrections by
changing the values in the From, To, and/or Length text boxes.

} To enter the starting and ending position

1. Position your insertion point in the From text box and type the starting position for the field.

2. Press Tab  twice to move to the To text box and enter the ending position of the field:

• The length will be calculated automatically and displayed in the Length box.

• The field will be highlighted in the record and the data in the field you selected will be
displayed below the record.

3. If the value displayed shows that the field length or position is not correct, make corrections by
changing the values in the From, To, and/or Length text boxes.

Note: Once you get the hang of it, you will find that you can combine these methods for your fastest
selection. For example, you might the position the mouse pointer on the first character of the field or
select part of the field with your mouse, then type in the length.

Importing your data

To import your data, you will first need to map the data fields in your import file to the fields in
your .CAR file. Then you can import your file.

Note: You do not have to import all of your fields or fill all of the fields in your .CAR database, only
the ones that you need.

} To map a data field

1. Select the field from the import file record by using one of the methods described above.

2. Select the field in the VersaImage/VersaCAR database by clicking on it with your mouse.

3. Click  and the value in the record field will be displayed next to the database field
on the left (see fig. 10.9).
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} To import your data

1. Select your error handling method:

Write Errors to File Skips records with errors and writes them to a file.

Correct During Import Stops for errors during import so you can correct them.

2. Click . A processing message at the top of your screen (fig. 10.10) will display the
number of records in the file.

3. A message box (fig. 10.11) will appear asking you if you want to continue importing. You have
three options:

Imports records one at a time. Each
time you click , another rec-
ord will be imported and displayed.

Imports the file without stopping.

Cancels the import.

You will probably want to import several records singly to make sure that they are coming in
as they should be. Once you are satisfied that the records are OK, click  to start
importing the file.

Note: During import, the processing message will show you how much of the file has been
processed.

Fig. 10.9. Selecting flat file fields

Fig. 10.10. Import processing message - flat ASCII file

Fig. 10.11. Import processing options
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4. If you decided to correct errors during import, the program will stop every time it encounters an
error:

• A dialog box containing the error and
current field data will appear (fig.
10.12).

• At the bottom, you will find a text
box. Enter your correction in the box.

• Click  to continue.

5. When the import is finished, the dialog
box will close and you will see a
completion message:

• If there were no errors, the message will say so. Go to the chapter for your next step:

Chapter 11 If your database will include images.

Chapter 16 If you will be indexing your database to microfilm.

Chapter 23 If your database does not require indexing.

• If there were errors and you elected to have them written to a file, the message will display
the number of errors and the names of the error files. For error handling information, refer to
the instructions in the next section.

Hint: If you are importing data from a number of flat ASCII files with the same structure, you may
want to check out the template function. This function saves your structure as a reusable template.
See below for details.

Error Files

If you elected to have your errors written to a file, the import program will write records with errors
to a file instead of importing them. There are two error files. Each has the same name as your
database. One has the extension .ERR and the other .ERD:

.ERR Contains the type of error.

.ERD Contains the raw data record.

You can examine the error files through the Windows Notepad application. Just choose Notepad
from the Accessories group and retrieve the file.

You will need to add these records to your database manually. The easiest way to do this is through
the Indexing From Paper option (Chapter 20). It allows you to enter the complete record including
roll and frame numbers.

Templates

The Template options (fig. 10.13) allow you to save your import
specifications as a “template”, which you can then apply to other file
imports for databases with the same format. For comma-separated
files, it saves the database field number and the corresponding import
file field number. For flat ASCII files, it saves the starting position and
length for each field being imported.

Fig. 10.12. Error correction for ASCII files

Fig. 10.13. Template options
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Creating templates

Creating new templates requires no additional work beyond saving the import instructions you have
already created.

} To create a template

1. Set up your file import specifications as you normally would.

2. Before you import your file, click  and the Save Import Template dialog box (fig.
10.14) will open.

3. Change the folder for your template if necessary. Make sure the correct folder appears in the
Save in field.

4. Either leave the suggested default name in the File Name box or enter one of your own choice.
Do not change the extension or the file will not appear in the list of templates.

5. Click  to save the template.

Note: After you save your template, you can import your file just as you normally would. Saving
your template does not affect your current import.

Using a template

Once you have saved a template, you can use it again for other databases with the same structure:

n The files you are importing must be of the same type (i.e., you can’t use a template that was
created for a comma-separated file with a flat ASCII file).

n The fields in the .CAR database record must be identical to the fields in the template.

n The fields in the import file must have the same format as the one used for the template. For
comma-separated files, they must be in the same location as the ones defined in the template. For
ASCII files, they must have the same lengths and starting positions.

} To use a template

1. Click  to open the Open Import Template dialog box (fig. 10.15 on page 74).

2. Find the directory where your template is located.

3. Select the template from the list.

Fig. 10.14. Save Import Template dialog box
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4. Click  and the template will be applied. The first record from the file will appear in the
database record fields on the right.

5. Continue with the rest of your import, just as you normally would.

Deleting templates

If you have import templates that you no longer want, you can delete them from your files through
the Import option.

} To delete a template

1. Open any database. Then select Import from the Tools menu.

2. Select either Flat ASCII File or Comma-separated File.

3. Click  to open the Delete Import Template dialog box (fig. 10.16). All of the
templates in the default directory will be displayed.

4. The Delete Import Template dialog box works just like an Open dialog box:

• Find the folder where your template is located.

• Select the template you want to delete from the list.

Fig. 10.15. Open Import Template dialog

Fig. 10.16. Delete Import Template dialog box
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5. Click  and the confirmation message shown in fig. 10.17
will appear:

• If you want to delete the template, select .

• If you do not want to delete the template, select .

Fig. 10.17. Delete confirmation
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Part 3
Images





11  About
Images

VersaImage can scan images from either film or paper and also import images that were scanned else-
where so you can index them. You may use any of these methods to obtain images for a single data-
base. You may also include scanned or imported paper images with film indexes. Regardless of how
you plan to use images, you need to understand how VersaImage handles images and the options that
are available to you.

Image Files

VersaImage can handle both single- and multi-page TIFF files. When film is scanned, single-page
TIFF files are created for each frame. From paper, either single- or multi-page TIFFs can be
created. Either type can be imported.

To handle images, a database must be image enabled. You can do this when you create the database
or from the File menu if you decide you want to add images later. When a database is image
enabled, the Image Address field is added to the record and a folder with the same name as the
database is created for the images. The folder is placed in the same folder as your database.

You scan images in rolls (film) or batches (paper). Each roll or batch will have a separate folder in
the main image folder:

n Folders for roll images will be named ROLLnnnn, where nnnn is the roll number.

n Folders for batches will be named BCHnnnnn, where nnnnn is the batch number.

When you import images, all images in a given directory are imported as a batch. You may follow
the naming conventions above or you may create your own if you want to distinguish them from
your scanned batches.

Scanning Modes and File Names

VersaImage has different scanning modes for different types of indexes and different naming
conventions for each. In general, image files are treated in two different ways:

n In databases where each document is indexed and has a corresponding index record, scanned
image files are treated as individual entities. The image file path is placed in the Image Address
field of the index record. When you view a record, the single image is displayed with the record.

n In databases where documents are indexed in groups, the images are treated as a group or folder
of documents. Individual TIFF image files are created for each document and a folder file
containing the location of each image in the group is created for each group. The folder file path
is placed in the Image Address field. When you view a record associated with a group, all
images in the group will be displayed with the record.

Note: The term “folder” may be misleading as directories in Windows 95 are usually referred to as
folders. The “folders” created for your image groups are not physical folders or directories for
image files. They are logical groupings defined in a FOLDER FILE associated with the group. Both
image files and folder files are placed in the directory folder for the batch.

11
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Given below is a brief overview of the way images from each of the different sources are handled.
More detailed information for each is found in Chapters 12—14.

Roll film

When you scan roll film, single-page TIFF images will be created and stored to correspond to the
type of film and the way it is indexed. If you have single-level film and index every image, your
image folder for the roll will contain an image for every frame. If you have indexed single records
in groups, the images will be grouped into folders based on your document groupings. If you have
multi-level film, the images will be grouped in folders based on your file blips (and batch blips if
you have three-level film).

File-naming conventions for roll film indexes are as follows.

n Single-level film images have the format

rrrrpppp.TIF

where rrrr is the roll number and pppp is the page number within the batch.

n Two-level film images have the format

ffffpppp.TIF

where ffff is the file blip number and pppp is the page number in the file.

n Three-level film images have the format

bbbfffpp.TIF

where bbb is the batch blip, fff is the file blip, and pp is the page blip.

Folder files have the same name as the first image file in the folder and the extension .FLD.

Paper images

When you scan paper images, you choose the indexing structure for your database when you select
your scan mode. You can elect to treat each document individually and associate each document
with an index record or group images into folders. The latter method allows you to group several
documents that should be associated with a single record or group several pages of a multi-page
document together for the record. You can also create multi-page TIFFs, which is a way to handle
multi-page documents without using folders.

For paper images, the file name format is:

bbbbbppp.TIF

where bbbbb is the batch number and ppp is the page within the batch. Folder files have the same
name as the first image in the file and the extension .FLD.

Paper images allow you more flexibility than roll film images do after scanning. Although you must
select a specific scan mode when you scan your documents, you can if, necessary, mix grouping
conventions when you index. You can, for example, have a database scanned in single-record mode,
where most records are associated with single images but create folders as you index for the
occasional multi-page document.

Note: When you are scanning paper images for a hybrid database, it is usually best to select the
same convention for your paper images as the one used for your film images.
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Imported files

Images are imported into VersaImage “as is.” Both single- and multi-page TIFFs can be imported.
Imported files keep their original names. VersaImage does not change them to match its conventions
for scanned documents. If your TIFF files have logical eight-character names that follow specific
conventions described in Chapter 14, VersaImage may be able to create folder files for your images
when it imports them. You can also create folders when you index the images. More information is
given in Chapter 19. In either case, the folder files will have the name of the first file in the folder
and the extension .FLD.

Master Reference Database Images

Master reference databases combine documents and images from a number of different sources.
These documents are often wildly different from each other. Each batch of images may contain
documents of a totally different structure. One set might be full of single-page documents while
another may contain multi-page documents. Another might have been scanned from roll film in a
mode totally unsuitable for the other sets of documents in the database. Because indexing in a master
reference database does not have to be sequential, you can mix scanning modes more easily. While
you cannot choose your mode for roll film, for paper images you can simply select the most suitable
scanning mode for each batch of documents you are scanning.

The “To-be-indexed” List

VersaImage keeps track of the images that need indexing in a “to-be-indexed” list. When you scan a
batch of paper images, VersaImage creates a to-be-indexed list for the batch. An empty index
record, containing only the image address, is created in the database for each image. When you
index the batch, the Index Images function uses the to-be-indexed list to determine which images
still need indexing. The image or image folder is displayed so you can enter the rest of the data in
the record. When an image is indexed, it is removed from the list.

When you scan roll film, you can either scan the images and index them later or scan the film after
you index the images. If you scan an indexed film, each image is automatically associated with the
roll frame and the address is placed in the appropriate record. No to-be-indexed list is created
because the images are indexed automatically.

If you scan a roll before it is indexed, the images are placed in a to-be-indexed list for the roll. An
empty record is created for each image, which contains not only the image address, but also the roll
and frame number of the document. This automatically links the images to the roll and frame
number. You can then index the images without using the microfilm reader. As with paper indexes,
the images will be removed from the to-be-indexed list when they are indexed.

Imported images are handled like scanned paper images. When a batch of images is imported, they
are placed in a to-be-indexed list and an empty record containing the image address is placed in the
database. Even if the records were scanned for roll film and have roll frame naming conventions,
there is no way to automatically associate them with a roll of film. You will need to do this
manually as you index.

Image Quality and Image Correction

VersaImage has a number of options that allow you to make corrections to the image during and after
scanning. If the image cannot be corrected adequately, it can be rescanned from the search and QC
functions. You can also scan single documents that may have been skipped or accidentally deleted.
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The image correction function

VersaImage uses the ClearImage engine by Imagination Software, Inc., to make background image
corrections while scanning. These corrections can also be used to correct images globally or
individually when you view your database records. Correction options are selected through the
FixImage Settings dialog (fig. 11.1).

This dialog is available from the Image Correction option on the Tools menu. You can also
access it from the Batch Scan dialog when you are scanning paper images.

The following correction options are available:

Deskew Straightens the image.

Clean Borders Removes unwanted lines, etc., from around the edges.

Clean Noise Removes random spots from the image.

Invert Image Inverts the image colors to their opposites.

Set Margins
Invert White on Black Changes black areas to white.

Crop Image Removes excess unprinted area from around the image.

Register Image
Correct Lines Removes lines.

Remove Halftone Removes halftone shading from graphics on the image.

Morphological Filters Lightens dark text.

Remove Punch Holes Removes punch hole spots from the edges of the image.

Smooth Characters Smoothes jagged characters.

Clear image Removes the image.

Rotate Before Rotates the image 90 degrees to the right before making other corrections.

Rotate After Rotates the image 90 degrees to the right after making other corrections.

Needless to say, most of these options should not be applied on a global basis. Deskew, Clean
Borders, Clean Noise may be applied safely across the board during scanning. Remove Punch
Holes and Invert Image may also be applied safely where applicable. The other options had best
be left alone except on an individual image basis.

Warning: The options in this dialog are “sticky.” Regardless of which function you enable them from,
once they are enabled they remain enabled until they are disabled. If background image correction is
enabled, the selected options will be applied to all scans. Thus, if you forgot to remove Rotate Before
after rotating a batch that was scanned in the wrong orientation, you would find all your scanned
images rotated. Therefore, be sure to always clear and reset your options after applying special
corrections to an image or group of images.

Fig. 11.1. FixImage Settings dialog box to set up image correction
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} To enable or disable background image correction

1. Click Use Image Correction on the Scan menu:

• If the option is not checked, clicking it will enable it.

• If the option is checked, clicking it will disable it.

2. The option will remain set for ALL subsequent scanning operations until you change it.

Note: This option can also be enabled or disabled from the Batch Scan dialog box.

The image correction options can also be applied to individual images and batches from the Image
Correction menu. Both scanned and imported images can be corrected as you view your images.
This function will be discussed in Chapter 23.

Other correction options

In addition to the Image Correction feature, there are several other correction options that can be
accessed through various functions. These corrections can be applied to any image whether it was
scanned or imported. Given below is an overview of these functions and the chapters where their
instructions can be found:

n While indexing your images, you can deskew and rotate them with tools from the tool bar. This
is a good way to correct for the occasional misoriented image. You can also crop your images or
delete images that were scanned by mistake. Information is given in Chapter 19.

n While searching your database, you can scan missed or deleted images and rescan badly scanned
images. You can also crop images and apply the image correction options described above.
Information is given in Chapter 23.

n While performing image QC operations, you can scan and insert missing images, rescan images,
delete images, and rearrange them in your folders. Information is given in Chapter 30. Note that
the image correction options described above are not available in QC mode.

What to Do Next

Once you have a general idea of how image files are handled, you are ready to scan or import your
own images:

n For instructions on scanning film, go to Chapter 12.

n For instructions on scanning paper documents, go to Chapter 13.

n For instructions on importing images, go to Chapter 14.

n For instructions on operating the check scanner (VersaImage/Check only), go to Chapter 15.

n For instructions on scanning and indexing individual folders in a single operation, go to Chapter
16 for general information about indexing and then to Chapter 21.
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12 Scanning
Microfilm Images

If you have VersaImage and a microfilm scanner, you can scan the images directly into your database
from your reader and then index the images. You can also scan a roll of film you have previously
indexed and VersaImage will associate the images automatically with your database records.

Image Files

VersaImage creates TIFF image files for each document it scans. When you scan a frame that is
already indexed, the file name associated with the index record will be placed in the Image Address
field. If there is no index record for the frame in the database, VersaImage will create one and add it
to the database. The roll, frame and image address information will be placed in the record and the
image will be added to the to-be-indexed list.

There are three scan modes for microfilm:

• Single level, no folders (for film where each frame is indexed)

• Single level, one folder per index (for film where frames are indexed in logical groups)

• Multi level, one folder per file or index (for all multilevel film)

Your choice depends on the film you are indexing. For multi-level film, you must choose the multi-
level option. If you are scanning single-level film you have already indexed, you must choose the
option that matches the index you have created. If you scan single-level film that you have not yet
indexed, the only option available is “single level, no folders.” If you want to index the frames in
logical groups, you will need to group them when you index.

So that you will better understand how the image files are associated with your film, each mode is
explained more thoroughly below.

Single level, no folders

Single-level scanning with no folders is done for film with single-level blips where every frame is
indexed. This method creates a TIFF file for each image and places the file name in the Image
Address field. The file name is composed of eight digits and the extension .TIF in rrrrpppp format.
The first four digits represent the roll number and the last four, the frame number:

00250001.TIF

The frame number in the file name increments for each frame:

12

Roll Number Frame Number
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Single level, one folder per index

Single-level scanning with one folder per index record is done for film with single-level blips that has
been indexed in logical groups. One index record is created for the first record in each group. When
the roll is scanned, VersaImage creates a folder file for each index record. For each frame in the
group, it creates a TIFF file and places its path in the folder file associated with the index record.

The folder file name is placed in the Image Address field of the index record. It is composed of
eight digits in rrrrpppp format and the extension .FLD. The first four digits represent the roll
number and the last four, the frame number where the folder starts:

00250001.FLD

The image file names are also eight digits in rrrrpppp format but with the extension .TIF. The first
number is the roll and the second, the frame:

00250001.TIF

The frame numbers increment for each image and remain sequential throughout the roll. Each folder
will have the same number as its starting frame:

Two-level film

When film with two-level blips is indexed, one index record is created for each large or “file” blip.
When the roll is scanned, VersaImage creates a folder file for each index record or “file blip” frame.
For each frame, it creates a TIFF file and places its path in the folder file of its associated index
record. The folder file name is placed in the Image Address field of the index record. It is composed
of eight digits and the extension .FLD in ffffpppp format. The first four digits represent the file blip
number and the last four, the starting frame number of the folder:

00250001.FLD

The image file names are also eight digits in ffffpppp format but with the extension .TIF. The first
number is the file and the second, the frame:

00250007.TIF

Roll Starting frame
for folder

Roll Frame

File Starting
Frame for
Folder

File Frame
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Each time a file blip frame is scanned, a folder file is created:

Usually, when a new folder is created, the file number will increment and the first frame of a folder
will be page blip 1. If the film has not yet been indexed, the folder files will be created strictly on
the basis of the file blips. When you scan film that has already been indexed, the file folders are
based on the index records. Generally, this will be no different from non-indexed film. However,
when you index two-level roll film, it is possible to also index individual pages.

If a roll has already been indexed and VersaImage finds an index record associated with a page blip,
it will create a folder file for that frame also. All subsequent images until the next folder file is
created will be placed in this folder. In such cases, the starting frame for the folder will have a
frame number other than 1. If, in the drawing above, there were an index record for the page blip
associated with TIFF file 00250004.TIF, the folder file would be 00250004.FLD. The images
00250005.TIF and 00250006.TIF would also be placed in that folder.

Three-level film

When three-level film is indexed, a record is generally created for each batch blip and each file
blip. When a three-level roll is scanned, a folder file is created for each batch blip and each file
blip. The folder file name is placed in the Image Address field of the index record. It is com-
posed of eight digits and the extension .FLD in bbbfffpp format. The first three digits represent
the batch blip number, the second three, the file blip number, and the last two, the starting frame
number of the folder:

02501201.FLD

For each frame, it creates a TIFF file and places it in the folder of its associated index record. The
image file names are also eight digits in ffffpppp format but with the extension .TIF. The first
number is the file and the second, the frame:

02501201.TIF

Each time a batch blip or file blip frame is scanned, a folder file is created:

Batch File Frame

Batch File Frame
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The illustration above shows the standard three-level indexing scheme where folder files are created
for both batch and file blips. They will be created this way by default if the film has not yet been
indexed. If the film has been indexed, folders will be created for each index record.

Usually, both batch and file blips are indexed. However, with three-level film, you have the option
of indexing batch blips only. If the film has been indexed with records for batch blips only, folder
files will be created for batch blips. You also have the option of indexing page blips when you index
three-level film, just as you do with two-level. If a roll is already indexed and VersaImage finds any
page blips with index records, it will also create folder files for those frames.

Scanner Setup

Before you scan, you will need to set the contrast, brightness, and other attributes on your microfilm
scanner for the film you will be scanning. You can do this through the Setup Scanner option.

} To set up your scanner

1. Select Setup Scanner from the Scan menu (fig. 12.1). The scanner
setup box for your scanner will appear. The contents of this dialog
box vary from scanner to scanner.

2. Enter the parameters for your scanner in the box. For further infor-
mation on setting up your scanner, refer to your scanner manual.

3. When you finish, click .

Note: You can adjust these later after you start your scanning operations
if necessary.

Starting Your Scan

Before you scan a roll of film, you need to enter your roll number and tell the system which frame
you are starting on and which frame you want to end on. You don’t have to scan the entire roll at
once. The first time you scan a roll for a database, you must also select your scanning mode. After
you set it once, VersaImage will remember it.

} To set your scanning parameters

1. Load the roll you want to scan.

2. From the File menu, select Open Database.

3. Select the database you want to scan images for from the Open dialog box. The main database
search screen will appear.

Fig. 12.1. Scan menu with
Setup Scanner option
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4. If you have not already image enabled your database, select Image Enable Database from the
File menu. An Image Address field will appear on your screen.

5. If this is the first time you have scanned this roll, do the following:

• Select Preferences from the File menu. Then select Defaults. The Defaults dialog box (fig.
12.2) will appear.

• Select your scan mode from the Roll Film Scanning option group and click .

6. From the Scan menu, select Scan Roll. The New Roll dialog box (fig. 12.3) will appear.

7. Enter the number of the roll you want to scan and click . The reader status will change to
Ready in the status bar and the New Frame dialog box (fig. 12.4) will appear.

8. Enter the frame number you want to start with in the text box and click . The reader will
advance the film to that frame and the Ending Frame dialog box will appear.

9. Enter the frame number you want to end with in the text box and click .

Fig. 12.2. Defaults dialog box

Fig. 12.3. New Roll dialog

Fig. 12.4. New Frame dialog
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Operating the Scanner

After you enter the starting and ending
frame numbers, you will see the Roll Scan
dialog box (fig. 12.5). Your scan mode,
the roll you are scanning, the starting
frame, and the path and file name for the
first image to be scanned will be displayed
in the box.

Note: The program will create a sub-
directory for each roll scanned. The name
will be ROLLnnnn where nnnn is the roll
number.

} To test your image quality

1. To do a test scan, click . To print the test scan, click .

2. To make adjustments to your setup, press  to access your Setup Scanner dialog
box.

} To set your scanning options

1. To display each image as it is scanned, enable Display Images.

2. To print a QC print on your laser printer every so often to check the scan quality, enter the page
(frame) interval you want in the QC Print Every ___ Pages text box. For example, if you want
to print every 25th frame, enter 25. If you don’t want to print at all, enter a 0.

} To scan your film

1. Press . The scanner will start scan-
ning automatically:

• The frame number and number of
frames and folders scanned will incre-
ment each time a frame is scanned,
and the next file name will be dis-
played.

• If you enabled Display Images, each
image will appear on the right side of
the screen.

2. If you need to interrupt scanning oper-
ations temporarily, do the following:

• To stop, press .

• To continue, press .

3. When the entire roll is scanned, VersaImage will display a completion message. To exit before
the scan is completed, press . Then press .

Note: Some readers do not inform the program that they are at the end of a roll. If yours does not,
you will need to stop the scan manually as explained above or make sure the last frame is correctly
set to the last frame on the roll you are scanning.

Fig. 12.5. Roll Scan dialog box at the start of a scan

Fig. 12.6. Roll Scan dialog during a pause in scanning.
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What to Do Next

What you do next depends on whether or not the roll you scanned has been indexed:

n If you scanned a previously indexed roll, go to Chapter 23 for instructions on searching your
database and viewing your images.

n If the roll is not yet indexed, go to Chapter 16 for instructions on indexing.
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13 Scanning
Paper Images

If you have VersaImage and a paper scanner, you can scan the images directly into your database
from your scanner and then index the images. You can scan batches of paper as individual
documents or in document groups. If you use separator sheets (either Image Vision’s or those pro-
vided for your scanner) to separate your document groups, VersaImage can create files for them
automatically.

Image Files

VersaImage creates TIFF image files for each document it scans. Each TIFF file is given an
eight-digit file name. When you scan your images, an empty record will be created for the
document or group of documents and the image address will be placed in the Image Address field
of the record.

There are three scan modes for paper documents:

• Single-page TIFF images with folder files

• Multi-page TIFF images

• Single-page TIFF images, no folders

Single-page TIFF images with folder files is most common and generally the most efficient method
of handling image files, except in cases where documents are mostly one page and unrelated. Each
of these scan modes is explained more thoroughly below.

Single-page TIFF images with folder files

Single-page TIFF images with folder files stores each TIFF image in a separate file with a .TIF
extension. It then creates a separate folder file with a .FLD extension that ties all of the TIFF
images together into a document. The path to the folder file is placed in the Image Address field.
The first five digits of the TIFF file name contain the number of the batch being scanned. The last
three contain the page number within that batch:

00045005.TIF

Folder files also have eight-digit names. The first five digits contain the batch number. The last
three contain the starting page number within that batch of the first page in the folder:

00045005.FLD

VersaImage creates one blank database entry for each folder scanned and adds that folder to the to-
be-indexed list.

13

Batch Page

Batch 91Starting Page
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Multi-page TIFF images

The Multi-page TIFF images option stores images in a multi-page TIFF file with a .TIF extension.
All of the pages of the document are placed in the same TIFF file. The path to the TIFF file is
placed in the Image Address field. The first five digits of the TIFF file name contain number of the
batch being scanned. The last three contain the starting page number within that batch:

00045005.TIF

VersaImage creates one blank database entry for each document scanned and adds that TIFF image
to the to-be-indexed list.

Single-page TIFF images, no folders

If all or most images in a database will be indexed, single TIFF images with no folders is the best
option. Each page is stored in a TIFF file with a .TIF extension. The path to the TIFF file is placed
in the Image Address field. The first five digits of the TIFF file name contain the number of the
batch being scanned. The last three contain the page number within that batch:

00045025.TIF

VersaImage creates one blank database entry for each document scanned and adds that TIFF image
to the to-be-indexed list.

Fig. 13.1. TIFF images with folder files

Fig. 13.2. Multi-page TIFF files

Batch Starting Page

Batch Page



Chapter 13- Scanning Paper Images      95

Selecting a Folder Format

The first time you scan images for a database, you will need to select the folder format. VersaImage
will then remember the setting and use it as the default for the database. Except for master reference
databases, you are not likely to need to change it after you set it.

Note: If other workstations also scan images for the database, this option will also need to be set on
those workstations. It is not retained from workstation to workstation

} To select a folder format

1. Select Preferences from the File menu.

2. Select Imaging Options from the Preferences menu. The Imaging Options dialog box (fig.
13.4) will appear.

3. Select the folder format you want to use by clicking the option.

4. Click  to save the folder format information.

Document Preparation

Prepare the documents to be scanned by removing all staples and straightening folded corners. If
you are scanning single-page TIFF images with folder files or multi-page TIFF images, you can use
Image Vision job separator sheets (or sheets provided by the scanner manufacturer) to separate the
scanned images into documents. Place these separator sheets in your document “stack” in the places
where you want to start a new folder. The separator sheets enable VersaImage to create your folder
files automatically and allow you to scan your batch without manual intervention. If you do not want
to use separator sheets, you can scan each folder individually instead.

Fig. 13.3. Single TIFF images, no folders

Fig. 13.4. Imaging Options dialog box
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Note: The document BWS_SEP.DOC contains the Image Vision separator sheets and is located in
the directory where the VersaImage .EXE is located. You can print sheets with Microsoft Word
version 6.0 or later. The black rectangle on the sheets can be moved to accommodate your scanner.
Call Image Vision Technical Support for instructions.

Scanner Setup

Before you scan, you will need to set the contrast, brightness, and other attributes on your paper
scanner for the documents you will be scanning. You can do this through the Setup Scanner option.

} To set up your scanner

1. Select Setup Scanner from the Scan menu (fig. 13.5). The
Scanner Settings dialog box will appear. The contents of this
dialog box vary from scanner to scanner.

2. Enter the parameters for your scanner in the dialog box. For further
information on how to set up your scanner, refer to your scanner
manual or ISIS driver manual.

3. When you finish, click .

Note: You can adjust these later after you start your scanning
operations if necessary.

Setting Your Scanning Options

Your next step is to set your scanning parameters for your batch.

} To set your scanning options

1. From the File menu, select Open Database.

2. Select the database you want to scan images for from the Open
dialog box. The main database screen will appear.

3. If you have not yet image enabled your database, select Image Enable
Database from the File menu. The Image Address field will appear
on your screen.

4. Select Scan Batch from the Scan menu (fig. 13.6). The Batch Scan
dialog box (fig. 13.7) will appear. The scan mode and the number of the last batch scanned will be
displayed in the box.

Fig. 13.5. Selecting the Setup
Scanner option

Fig. 13.6. Scan menu with
Scan Batch selected

Fig. 13.7. Batch Scan dialog
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5. The first time you scan a batch for a database and whenever you want to start a new batch, you
will need to enter the batch number. To start a new batch, do the following:

• Click  and the New Batch Number dialog box will appear (fig. 13.8).

• Enter a batch number between 1 and 99999 and click .

Note: VersaImage will create a subdirectory folder for each batch scanned. The name will be
BCHnnnnn where nnnnn is the batch number.

6. Select your Auto Document Separation option:

None If you are not using separator sheets or if you are scanning
single-page images with no folders.

Use BWS Separator Sheets If you are using Image Vision separator sheets.

Use Scanner’s Sep. Sheets If your scanner manufacturer provides separator sheets and
you want to use them.

Important: You must select one of the two separator sheet options for VersaImage to create folder
files or multi-image TIFFs automatically. If you select None, you will have to split the folders
yourself even if you do insert separator sheets.

7. To display the images as they are scanned (recommended), check the Display Images option.

8. To scan both sides of every page, check the Scan Both Sides box. This option will not be
enabled unless your scanner has duplex scanning capability.

9. To have VersaImage delete the separator sheets as it creates your folders, check Delete
Separator Sheets. This option will only be enabled if you select one of the separator sheet
options.

10. To apply background image correction, do the following:

• Check the Use Image Correction option. If it is already checked, background image correc-
tion is currently enabled for your system.

• Click  to display the Fix Image Settings dialog and select your correction
options. More detailed information on these settings is given in Chapter 11.

Warning: When you enable or disable Use Image Correction from this dialog, it is enabled on the
Scan menu. This setting and whatever options you select will be in effect for all scanning that is
done from this point on until you disable it. It does not apply to this batch or this dialog only.

Operating the Scanner

After you have set your scanner options, you can start scanning. If you are scanning single-page
images or using job separator sheets, you can scan the entire batch. If you want to create folders
manually, you can scan folder by folder.

Fig. 13.8. New Batch Number dialog box
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} To scan in batch mode

1. Load as much of your batch as your scanner can handle into your scanner.

2. Click . The scanner will start scanning automatically. If you enabled Display Images, each
image will appear on the right side of the screen as it is scanned. The page number and number
of pages and folders scanned will increment each time a page is scanned, and the next file name
will be displayed.

3. To interrupt scanning operations temporarily, do the following:

• To stop, click .

• To continue, click .

4. To make adjustments to the scanner, do the following:

• Stop the scan with .

• Click  to access your Setup Scanner dialog box.

• Exit from your scanner setup dialog and return to the Batch Scan dialog.

• Click  to continue.

5. When the scanner is empty, the  button will change to  and the  button will
be disabled:

• To continue scanning the same batch, load more documents into the scanner and click
.

• To start a new batch, click  and enter the batch number.

6. To exit, click .

} To scan individual folders

1. Load your folder pages into the scanner.

2. Click . The scanner will start scanning automatically. If you enabled Display Images, each
image will appear on the right side of the screen as it is scanned. The page number and number
of pages and folders scanned will increment each time a page is scanned, and the next file name
will be displayed.

3. To interrupt scanning operations temporarily, do the following:

• To stop, click .

• To continue, click .

4. To make adjustments to the scanner, do the following:

• Stop the scan with .

• Click  to access your Setup Scanner dialog box.

• Exit from your scanner setup dialog and return to the Batch Scan dialog.

• Click  to continue.

5. When your pages are scanned, the scanner will stop and  will change to :

• To add more documents to the same folder, load the documents and click .

• To create a new folder, click . The folder number will increment and the 
button will change back to . Place the documents for the next folder into the scanner and
click  to start scanning the folder.

6. To exit, click .
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Splitting Folders

If you scanned your images with Image Vision job separator sheets
but set the Auto Document Separation option to None, you will
need to split your folders. If you do not select one of the separator
sheet options, VersaImage will create one large folder file (if you
elected to use folder files) or a multi-image TIFF file (if you elected
the multi-page TIFF option). If you find that you only have one
folder or one image in your batch, you probably left your setting at
None. You can, however, easily correct the problem through the
Split Image Folders function.

Important: The Folder Format in Imaging Options must have the
same setting when you split the folders as it did when the images
were scanned.

} To split folders

1. If your database is not already open, select Open from the File menu and open your database.

2. Select Split Image Folders from the Index menu (fig. 13.9). The Select Batch/Roll dialog box
will be displayed (fig. 13.10).

3. To select the batch you want to split, either double click on the batch number or highlight the
batch number and click . The Split Folder Status box (fig. 13.11) will appear.

Fig. 13.9. Indexing menu

Fig. 13.10. Select Batch/Roll dialog box

Fig. 13.11. Split Folder Status box
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4. Processing will proceed automatically. The label near the top of the box will indicate Folder File
Split or Multi TIFF Split. The box will remain on the screen until the process is complete. The
file currently being processed will be displayed on the screen.

Important: In order for the split process to work successfully, the documents must have been
scanned with the paper size set to a width of 8.5 inches and a length of either 11 inches (letter) or 14
inches (legal).



14 Importing
Images

With VersaImage, you can import TIFF image files from other imaging systems or scanning
systems. This is very useful when you first set up VersaImage if you already have images in your
database as it eliminates the need to scan them again. Although VersaImage has excellent scanner
support for most environments, there could also be instances after your initial setup where it
might be necessary or preferable to scan the images outside of VersaImage and import them. For
example, you might have an unsupported scanner or a scanner with automated features, such as a
high-speed film scanner, that you prefer to use. This feature also enables you to import TIFF
images archived by a fax modem and index them.

When image files are imported, VersaImage creates an empty record for each in the database and
places the images in a to-be-indexed list. You can then open the database and index them. You
will be able to enter information for the images to create new records or associate the images with
existing records in the database. More information will be given on indexing images in Chapter
19.

Image Files and File Names

When VersaImage imports TIFF files, the files keep the same names as they had previously. If the
files are single TIFF images and have an eight-character naming convention that logically organizes
the files into documents or folders, VersaImage can automatically build folder files based on that
organization. For instance, suppose your microfilm images were scanned so that at each file blip,
the first five digits of the file number were incremented and at a page blip, the last three digits were
incremented. VersaImage would create a folder file for each file blip and place references for all
files matching those first five characters in the folder file. The folder files will have the same name
as the first image file in the folder and the extension .FLD.

If you do not have a logical naming convention such as the one described above, you will still be
able to create folder files when you index your images. More information and instructions on
creating folders as you index is given in Chapter 19.

Getting Ready for Import

Before you can import images, you must get both your database and your images ready.

The database

To import images for a database, you must have must first created the database (Chapter 7). The
database must be image enabled. If you did not image enable your database, you can do it now.

} To image enable a database

1. Select Open Database from the File menu and open the database.

2. Open the File menu again and select Image Enable Database.

3. The Image Address field will appear in your record and the image tool bar will appear at the top
of your screen.

14
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The images

The images you want to import must all be located in one folder and that folder must be in the data-
base’s image folder. If they are not there, VersaImage will MOVE them there. If you do not want
your images moved, you should copy them to the image folder.

} To copy your images

1. In Windows Explorer, locate the folder where your images are located.

2. Move your mouse pointer to the folder and click your right mouse button. This will select the
folder and display the context menu.

3. Click Copy to copy the folder.

4. Locate the VersaImage folder and double-click to open it.

5. In the VersaImage folder, find the folder that has the same name as your database. This is your
image folder. Double-click on the folder to open it.

6. Move your mouse pointer to the right pane and press your right mouse button to display the
context menu.

7. Select Paste and the folder will be pasted in.

8. This folder will now be your batch folder. Rename it with an eight-character name. This will be
your batch number. You may want to follow VersaImage naming conventions for batches and
rolls:

• The first three characters for a batch are BCH. The last five should be digits and are your
batch number. For example, batch 84 would be:

BCH00084

• For images scanned from rolls, the first four characters are ROLL and the last four are your
roll number. Roll 100 would be:

ROLL0100

Alternatively, you could create your own naming conventions to distinguish imported batches
from those scanned in VersaImage (e.g., IMP00010).

Hint: If want your images moved but are copying them from an external source, you can speed up
the import if you move them into your database’s image file first. Follow the instructions above, but
instead of using Copy, select Cut.

Getting Ready to Import

Your first step is to open the VersaImage database you want to import your file to. Then you must
select your import file. If your folders are logically named in incremental groups, you can choose to
have the system build folder files for each group as described under “Image Files and File Names”
above.

} To open your database

1. Select Open Database from the File menu. The Open dialog box will appear.

2. Select your database from the Open dialog box.

3. Press  and the fields you have defined for your record will appear on the screen.
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} To select your import file

1. Select Import from the Tools menu.

2. Select Import Images (fig. 14.1) from the
Import menu.

3. The Import Images for Indexing dialog box
will appear (fig. 14.2).

4. Select the drive where your folder is located from the Drives list box.

5. Double-click on the folder where your images are located in the Directories list box. Note that
the TIFF image count box at the bottom of the screen will display the number of files with a
“.TIF” extension in the directory selected.

} To automatically build folder files

1. Check the box labeled Automatically Build Folders. The dialog box will change to allow you to
tell VersaImage how to build the folders (fig. 14.3).

2. Enter the number of characters in the file name that correspond to either the folder or the page.
VersaImage will automatically calculate the other number (there must be a total of exactly eight
characters).

Fig. 14.1. Import Images option

Fig. 14.2. Import Images for Indexing dialog

Fig. 14.3. Dialog box with Automatically Build File Folders enabled



104      VersaImage/VersaCAR/VersaView User’s Guide

} To import your images

1. Press  to start the import procedure.

2. If the images are not currently in the database image folder, VersaImage will display a message
informing you that the images will be moved to the correct VersaImage directory (fig. 14.4):

• Click one of the following:

If you want to move the images.

If you do not want to move the images.

Warning: This is a MOVE, not a copy! If you select , your files will be MOVED. If you do not
want them moved, select  and copy them to your database image folder first (see page 102).

• If you select , you will be prompted to enter an eight-character batch number (fig. 14.5).
Rename it with an eight-character name. You may follow the VersaImage naming conventions
or create a separate one of your own.

• Click  and the TIFF images will be moved into the correct VersaImage subdirectory.

3. Before VersaImage imports the images, a confirmation box (fig. 14.6) will be displayed.

4. Click . The database entries will be created and the images will be added to the to-be-
indexed list for the batch.

Fig. 14.4. Image move confirmation message

Fig. 14.5. Dialog box for entering the batch number

Fig. 14.6. Image import confirmation message



15 Operating the
Check Scanner

The VersaImage/Check system interfaces with either the Visionshape B-1000 scanner or the BUIC-
1000 scanner. These scanners can scan checks, either single or dual-sided, and read the MICR line
at the bottom of the check. VersaImage/Check scans these checks and places the information read
from the MICR line into a VersaImage database. This allows for scanning and indexing in a
completely hands-free mode. This product has been used in many applications including “Checks on
CD” and many “lockbox” applications.

Scanner Setup

Before you scan a batch of checks, you will need to set your scanning options for the checks you are
scanning and enter the batch number.

} Setting up your scanner

1. From the File menu, select Open Database.

2. Select the database you want to scan images for from the Open
dialog box. The main database screen will appear.

3. If you have not already done so, select Image Enable Database
from the File menu.

4. From the Scan menu, select Scan Checks (fig. 15.1). The Check
Scan dialog box (fig. 15.2) will appear. The batch number, path,
and file name for the last image scanned for the database will be
displayed.

Note: VersaImage will create a subdirectory for each batch scanned. The name will be BCHnnnnn
where nnnnn is the batch number.

5. To start a new batch, click . The New Batch dialog box will appear (fig. 15.3). Enter
a batch number between 1 and 99999 and click .

15

Fig. 15.1. Check Scan menu

Fig. 15.2. Check Scan dialog box



106      VersaImage/VersaCAR/VersaView User’s Guide

6. Click  to display the Setup Check Scanner dialog box (fig. 15.4).

7. Select your scanner settings:

Intensity The lightness or darkness of the image.

DPI Dots per inch. The higher the number, the higher the resolution.

Image Size Check size.

Note: Intensity and DPI once set will not usually need to be changed. Image Size may need to be
changed for each batch. Consult your scanner manual for more information.

8. Select your scanning options:

Front Only Single-image TIFF

Front and Back as Two Pages Multi-image TIFF

Front and Back on One Page Single-image TIFF

Indexing Setup

If you have not scanned checks previously for a given database, you will need to configure your
database for indexing. On each check, there are up to six MICR fields along the bottom of the
check. Any one of these six fields can be placed into any field of your VersaImage database as the
checks are scanned.

A definition of the MICR fields is listed in the following table:

Fig. 15.3. New Batch dialog

Fig. 15.4. Setup Check Scanner dialog
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Field Sequence Field Name Description

MICR 1 Serial Number For many business checks, the check number is in this field
instead of the check number (MICR 5) field.

MICR 2 Return Number Used only for items returned through the Federal Reserve.
MICR 3 ABA Number The unique number of the bank is in this field.
MICR 4 Account Number The customer’s account number is in this field.
MICR 5 Check Number For some business checks and all personal checks, the check

number is in this field.
MICR 6 Amount The amount of the check will appear in the last field. The

number is placed onto the check by a bank’s proof department.
If the check has not been through the proof department, there
will be no amount.

} To configure automatic indexing

1. Click . The Configure Index dialog box will appear (fig. 15.5).

2. Click the  button to the left of the MICR field you want to configure. A list of the fields that
have been defined for your VersaImage/Check database will be listed.

3. Select the field where the data will be placed.

Note: You may place two different MICR fields into the same VersaImage field if you want. In fact,
this is common for the check number.

4. Click  to return to the Check Scan dialog box.

Scanning your checks

} To scan your checks

1. Place the checks in the hopper.

2. Click . The scanner will start scanning automatically. To interrupt scanning, remove the
checks from the hopper on the scanner.

3. When the scanner is empty, an hourglass will appear on the screen while the program indexes
your checks. This can take a few minutes.

4. When it is finished, the  button will change to a  button. To continue scanning,
load more checks into the scanner and click .

5. To exit, click .

Fig. 15.5. Configure Index dialog box
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16  Indexing
Basics

Indexing is the process of associating your document (either film or paper) with a database record.
There are a number of ways you can index:

Film

n Index at the reader

n Index at the camera as you shoot

n Associate imported records with your film, either at the reader or at the camera

n Index images captured from your film

n Scan and index individual folders in one step

Paper

n Index scanned or imported images

n Associate your images with imported data records

n Index the page documents and associate the images later

n Scan and index individual folders in one step

What Happens When You Index

When you index, the system associates the index record with the document. How it does this
depends on whether you are indexing film or images.

Film

When you index a roll of film, VersaCAR automatically inserts the roll and frame numbers into
your database record. The roll number will be the number you enter when you start your indexing.
The frame number starts with the frame you specify and increments for each frame:

n For single-level indexing, the blip or frame number is a whole number and represents the
frame’s sequential location in the roll.

n For two-level indexing, the blip or frame number is given in 0.0 format. The number before the
period is the group or file number. The number after the period is the frame or blip within the
group. For example, the first record or “file blip” would be 1.0. The small blips (page blips)
that follow would be 1.1, 1.2, 1.3 … 1.10, 1.11, etc. The next file blip would be 2.0, followed
by 2.1, 2.2, etc.

n For three-level film, the blip or frame number is given in 0.0.0 format. The first number is the
batch number, the second number is the group or file number, and the third, the page number. In
the first batch of a roll, 1.2.5 would be the fifth page of the second group in the batch.

Images

When you scan or import your images, VersaImage creates an empty record for each image or
folder and places the file location of the image or folder file in the Image Address field in the
record:

16
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n For single-page or multi-image TIFF files, the file name and path for the image will be placed in
the record.

n For image folder files, the file name and path of the folder file will be placed in the record.

If the images were scanned from roll film through VersaImage, the roll and frame number will be
placed in the record as well. When you index, VersaImage displays the empty record and its
associated image or image folder so you can enter the record information.

Entering Index Records

There are two ways to enter index records. One is from scratch and the other is in Lookup/Append
mode. Lookup/Append mode is used when you want to associate imported records or previously
entered records with your film or images.

Entering records from scratch

When you enter records from scratch, you enter data in all the fields in the record. If a value for a
field is not available when you index, you may enter it later in the search screen. The following keys
and buttons are used while entering records:

Tab  or Enter Moves to the next field.

 or F8 “Files” the record and moves into the next.

The method of entering the data in the record varies somewhat depending on the type of indexing
you are doing (reader, camera, or image). For this reason, you should read the instructions carefully
in Chapters 17—22 for the indexing method you are using.

Lookup/Append mode

When you index in Lookup/Append mode, you enter a value in the first field only. The system then
looks for all matching records in your database and displays the first one it finds. The total number
of matching records is displayed in a “hit bar” at the bottom of your screen:

If there is more than one record, you can use the buttons in the hit bar to page through the records.
When you find the record you want, you click  to file the record.

Since there is some variation in the procedure you use with different types of indexing (reader,
camera, or image), be sure to read the instructions for using Lookup/Append mode for the indexing
method you are using.

Indexing Setup Options

The Indexing Setup dialog gives you a number of setup options that can make your indexing easier
and faster if you are entering data from scratch. This dialog allows you to do the following:

n Rearrange your data fields for more convenient entry or to meet specific index entry require-
ments (such as putting a specific field first for Lookup/Append mode).

n Automatically increment numeric values (e.g., invoice numbers).

First Record

Previous Record Next Record

Last Record
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n Automatically enter the current date in a date field.

n Set up “verification tables” containing commonly entered values for a field (such as company
names or addresses). To place a value from the table in the field, you key in a code or
abbreviation.

The indexing setup options can be set in advance and maintained for each database. This dialog also
will show up the first time you index a database if you haven’t set these options for the database yet.

Selecting index options

The Indexing Setup dialog (fig. 16.1) lists all the fields you can enter while indexing and the entry
options available for each:

Auto Inc Automatically increments the number in the field. Available for numeric
fields only.

Auto Date Enters the date automatically. Available for date fields only.

Table Verify Allows you to set up a verification table for the field. Available for all
fields.

} To set your indexing preferences

1. Select Preferences from the File menu.

2. Select Indexing Setup from the Preferences menu. The Indexing Setup dialog (fig. 16.1) will
appear.

3. If you want to enter your index values in a different order, drag the fields into the position you
want.

4. Select entry options for whatever fields you want to apply them to:

• Only the options with enabled check boxes are valid for a field.

• In cases where one or more than one option is enabled, you can only select one.

} To remove all setup options

1. Click .

2. Your original order will be restored and all options you have set will be removed.

Fig. 16.1. Indexing Setup dialog
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Maintaining the verification tables

If you choose to have a verification table for a field, you will need to set up your list of values and
the codes you want to use to retrieve them. You can add and remove entries in these tables
whenever you need to. For example, if you keep a table of company names, you can add to it
whenever you get a new client.

Hint: For speedy data entry, tie address fields and other static company information to the same
code as you use for the name of the company.

} To access the Update Verification Table dialog

1. Enable the field for Table Verify (see above) if you have not already done so. A  button
will appear.

2. Press the  button by the field. The Update Verification Table dialog will appear (fig. 16.2).

} To add a value

1. Click the  button to display the Add Verify Record dialog box (fig. 16.2).

2. Enter the code in the Key field.

3. Enter the full entry in the Description field.

4. Click .

} To remove a value

1. Highlight the entry you want to remove.

2. Click .

} To use a table

1. When you move your cursor to a field with a verification table, the table will appear on the screen.

Fig. 16.2. Update Verification Table dialog with Add Verify Record  dialog box
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2. Type the key code in the field.

3. Press Tab  or Enter
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17  Indexing Your
Film at the Reader

You can index your microfilm from scratch at your reader. You can also index it by associating the
frames with imported database records that do not have roll or frame numbers. If your imported
records already contain roll and frame numbers, the film will be associated with the records auto-
matically. You don’t need to do anything.

Getting Ready to Index

Regardless of whether you are indexing a roll of film from scratch or
indexing the film to an imported database, you must set up your
basic index parameters.

} To start an index

1. Load your film.

2. From the File menu, select Open Database.

3. Select the database you want to index from the Open dialog box.
The database search screen will appear.

4. From the Index menu, select Index at Reader (fig. 17.1). The
New Roll dialog box (fig. 17.2) will appear.

5. Enter the number of the roll you are indexing in the text box and
click :

• If you are indexing one- or two-level film, the New Frame dialog box (fig. 17.3) will appear.

• If you are indexing three-level film, a message will appear asking you if you want to index
batch blips only. Select the type of index you want:

To enter records for batch blips only

To enter records for both batch and file blips

After you make your selection, the New Frame dialog (fig. 17.3) will appear.

6. In the New Frame dialog box, enter the number of the frame you want to start with:

17

Fig. 17.1. Index menu

Fig. 17.2. New Roll dialog box

Fig. 17.3. New Frame dialog
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• For single-level indexing, enter a whole number.

• For two-level indexing, enter the number of the file blip you are starting with, followed by .0.

• For three-level indexing, enter the number of the batch blip followed by the file blip and .0
for the page blip (e.g., 3.1.0).

Note: If your reader/printer is set up to recognize page 1 as the file blip, enter .1 instead of .0 after
the file number.

7. Click  and the reader will advance to that frame number:

• If you have not yet defined your indexing setup parameters,
the Indexing Setup dialog will be displayed (see Chapter
16). Change the defaults if you want. Then click  and
the Lookup/Append dialog box ( fig. 17.4) will appear.

• If you have already defined your indexing setup parameters,
the Lookup/Append dialog box (fig. 17.4) will appear
immediately.

8. Select your option from the Lookup/Append message box:

• If you are indexing your film from scratch, click .

• If you are indexing film to an imported database, click .

Note: After you have indexed a database once, the last roll and frame you indexed will always be
displayed for you in the New Roll and New Frame dialogs so that you can continue from where you
left off by merely clicking .

The Reader Index Screen

After you enter your setup parameters, the index screen for entering your records will appear (fig.
17.5). It looks much like the main database search screen and contains all the fields you defined for
your records except the Roll field and Blip field. These will be entered by the system automatically
as you index. The fields will appear in the order you specified when you set up your database,
unless you changed them in the Index Setup dialog. The status bar at the bottom of the screen
contains information about the reader and displays the current roll and frame (blip) number.

You do not have to index the entire roll at one sitting. You may quit whenever you want. To quit, click
 and you will exit from the index screen. The system will “remember” the roll number and the

frame number where you left off so that you can continue from that point if you are not finished.

Indexing from Scratch at the Reader

For each frame you index, you will enter your index record in the fields on the screen. When you
click  or press F8  to file the record and move to the next frame, the data for the last record
will remain in the fields so that you won’t have to reenter duplicate information, such as dates or
company names if they happen to be the same. You can just change the information that is different.

Note: If you press Enter  after you enter your last field, you will see the message “OK to File”. Click
 or press Enter  to file the record.

Single-level film

For single-level film, you can index your frames in two ways:

Fig. 17.4. Lookup/Append dialog
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n You can index each frame.

n You can index the frames in logical subgroups by entering an index record for only the first
frame in the group. This simulates two-level indexing.

} To enter a record for each frame

1. Fill in the fields in the record.

2. Click . The reader will advance to the next frame and the number in the Blip field in the
status bar at the bottom of the screen will increment.

} To index your frames in groups

For each logical subgroup, do the following:

1. For the first frame of the subgroup, fill in the fields in the index record.

2. Click  or press F8  to move to the next frame.

3. Continue clicking  or pressing F8  to advance through the frames until you reach the first
record in the next subgroup. As long as you do not change any data on the screen, no index
records will be created.

Two-level film

When you index two-level film, you generally create index records for each frame with a file blip.
Occasionally, however, you may wish to index all the page blips within a file. Whenever you want
to index an individual frame or set of frames, you can switch to page-level mode. For instructions,
see “Page-level indexing with multi-level film” below.

} To index two-level film

1. Fill in the fields in the record.

2. Click  or press F8  and the reader will advance to the next file blip.

Fig. 17.5. Screen for indexing at the reader

Current Roll Current Frame

Reader Status

Record
Fields
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Three-level film

In three-level indexing, you usually index the frames with batch blips and file blips. You also have
the option of indexing batch blips only. You must select this option when you start your index (see
page 117). While you are indexing, you can switch to page mode if you want to index individual
frames (see “Page-level indexing with multi-level film” below).

} To index frames with batch blips

1. Enter the fields for the batch record.

2. Click  or press Enter :

• If you are indexing both batch and file blips, the film will advance to the first file blip.

• If you are indexing batch blips only, the film will advance to the next batch blip.

} To index frames with file blips

1. Enter the fields for the file record.

2. Click  or press Enter :

• If there are more file blips in the batch, the film will stop at the next file blip.

• If there are no more file blips, the film will advance to the next batch blip.

Page-level indexing with multi-level film

When you want to index a page-level frame while indexing two- or three-level film, you can switch
to page-level mode.

} To change to page-level indexing

1. Press F7 . The rightmost box on the status bar at the bottom of the screen will switch to Page.

2. Enter the record for the frame and click  to move to the next frame.

} To return to file-level indexing

1. Press F7 . The rightmost box on the status bar at the bottom of the screen will switch to File.

2. Proceed again with two-level or three-level indexing.

Indexing to Imported Records

If your index records are already in the database but do not have roll numbers, you can associate your
film frames with them. You choose this option by selecting Lookup/Append mode when you start
indexing. In Lookup/Append mode, you enter a “key” value in the first field. The system then looks
for matching records for your key. The number of records it finds will be displayed in the hit bar at the
bottom of the screen:

The first record found will be displayed on the screen. You can use the buttons on the hit bar to
page through the other records if necessary (see Chapter 16 for a more detailed description of the hit
bar). When you select and file the record, the roll and frame number will be placed in that record.
The screen will then clear so you can enter the key field for the next record.

Hint: Before you index records in Lookup/Append mode, reorder the fields on the Index Setup screen
(see Chapter 16) so you have a “key” field that will most likely be a unique identifier for the record.
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Single-level film

For single-level film, you can index your frames in two ways:

n You can each frame.

n You can index the frames in logical subgroups by associating an index record with only the first
frame in the group.

} To enter a record for each frame in Lookup/Append mode

1. Fill in the first field in the record.

2. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed.

3. If there is more than one matching record and the first record is not the correct one, click the 
button in the hit bar. Continue clicking  until you find the right record.

4. Click  to file the record. The reader will advance to the next frame.

} To index your frames in groups in Lookup/Append mode

1. For the first frame in the group, fill in the first field of the record.

2. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

3. If there is more than one matching record and the first record is not the correct one, click the 
button in the hit bar. Continue clicking  until you find the right record.

4. Click  or press Enter  to file the record. The reader will advance to the next frame and the
screen will clear.

5. Continue clicking  or pressing Enter  to advance through the frames until you reach the first
record in the next subgroup. Do not enter anything in the screen.

Two-level film

Generally, you will be associating your records with a file blip. Occasionally, however, you may
want to associate records with page blips. Whenever you want to index an individual frame or set of
frames, you can switch to page-level mode (see page 122).

} To index two-level film in Lookup/Append mode

1. Fill in the first field in the record.

2. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

3. If there is more than one matching record and the first record is not the correct one, click the 
button in the hit bar. Continue clicking  until you find the right record.

4. Click  or press Enter  and the reader will advance to the next file blip.

Three-level film

Usually, you will be associating records with batch blips and file blips. You also have the option of
indexing batch blips only. You must select this option when you set up your index (see page 117).
While you are indexing, you can switch to page mode if you want to index individual frames.

} To index frames with batch blips

1. Enter the first field for the batch record.
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2. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

3. If there is more than one matching record and the first record is not the correct one, click the 
button in the hit bar. Continue clicking  until you find the right record.

4. Click  or press Enter :

• If you are indexing both batch and file blips, the film will advance to the first file blip.

• If you are indexing batch blips only, the film will advance to the next batch blip.

} To index frames with a file blip

1. Enter the first field in the record.

2. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

3. If there is more than one record and the first record is not the correct one, click the  button in
the hit bar. Continue clicking  until you find the right record.

4. Click  or press Enter :

• If there are more file blips in the batch, the system will stop at the next file blip.

• If there are no more file blips, the film will advance to the next batch blip.

Page-level indexing in Lookup/Append mode

If you are indexing multi-level film, you can switch to page-level indexing in Lookup/Append mode.

} To change to page-level indexing

1. Press F7 . The rightmost box on the status bar at the bottom of the screen will switch to Page.

2. Enter the first field for the record

3. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

4. If there is more than one record and the first record is not the correct one, click the  button.
Continue clicking  until you find the right record.

5. Click  or press Enter  to move to the next frame.

} To return to file-level indexing

1. Press F7 . The rightmost box on the status bar at the bottom of the screen will switch to File.

2. Proceed with two- or three-level indexing as described above.

What To Do Next

n If you want to search and view your database, go to Chapter 23.

n If you have VersaImage and want to scan images for your database, go to Chapter 11 to learn
about images and Chapter 12 for instructions on scanning your film.



18  Indexing at
the Camera

If your camera is interfaced to your computer, you can do your indexing as you shoot your film.
You control the camera from your keyboard as you index. For single-level film, you can also
associate the frames with records that are already in the database.

Note: If you are using a Minolta DAR2800 or DR1600 (or their equivalents), refer to the hardware
supplement for a complete discussion of indexing on those cameras.

When you index multi-level film at the camera, your field order is very important:

n With two-level film, a file blip will be added whenever the first field changes.

n With three-level film, a batch blip is added whenever the first field changes and a file blip
whenever the second field changes.

If your fields are not in this order, be sure to rearrange them through the Indexing Setup option
(see Chapter 16) before you index.

Getting Ready to Index

Before you index, you need to get your camera ready to shoot. Then you
need to enter the starting parameters for your index.

} To start an index

1. From the File menu, select Open Database.

2. Select the database you want to index from the Open dialog box. The
main database screen will appear.

3. From the Index menu, select Index at Camera (fig. 18.1). The New
Roll dialog box (fig. 18.2) will appear.

4. Enter the number of the roll you are indexing in the text box (see fig. 18.2) and click .

• If you are indexing one-or two-level film, the New Frame dialog box (fig. 18.1) will appear.

• If you are indexing three-level film, a message will appear asking you if you want to index
batch blips only. Select the type of indexing you want:

18

Fig. 18.1. Index menu

Fig. 18.2. New Roll dialog box
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To enter records for batch blips only.

To enter records for both batch and file blips.

After you make your selection, the New Frame dialog box (fig. 18.3) will appear.

5. In the New Frame dialog box, enter the number of the frame you want to start with:

• For single-level indexing, enter a whole number.

• For two-level indexing, enter the number of the large blip you are starting with, followed by .0.

• For three-level indexing, enter the number of the batch blip, followed by a period and the
number of the file blip, followed by .0 (1.21.0).

6. Click :

• If you have not yet defined your indexing setup parameters,
the Indexing Setup dialog will be displayed (see Chapter
16). Change the defaults if you want. Then click  and
the Lookup/Append dialog box (fig. 18.4) will appear.

• If you have already defined your indexing setup parameters,
the Lookup/Append dialog box (fig. 18.4) will appear
immediately.

7. Select your option from the Lookup/Append message box:

• If you are indexing your film from scratch, click .

• If you are indexing film for an imported database, click .

Note: After you have used this option once for a database, the last roll and frame you indexed will
always appear in the New Roll and New Frame dialogs so you can continue from where you left off by
merely clicking .

The Camera Index Screen

After you enter your setup parameters, the screen for indexing at the camera will appear. This
screen (fig. 18.5) contains all the record fields you defined for your database records except for the
Roll field and Blip (frame) field. These fields will be entered automatically by the system as you
shoot your film. The fields on your screen will appear in the order you specified in your database
screen, unless you changed them in the Index Setup dialog.

At the top of the screen, the Block, Batch, and Item fields display the following:

Block For one and two-level film, the roll number

For three-level film, the batch blip

Batch For two and three-level film, the file blip number

For one-level film, ignored

Fig. 18.3. New Frame dialog

Fig. 18.4. Lookup/Append dialog
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Item Page-level blip number

In the status bar at the bottom of the screen, the number of the roll you are indexing and the current
frame will be displayed. The screen also contains two additional buttons in the tool bar—the 
button and the  button:

Inserts extra space between the frames.

Advances the film 50 spaces. You can use this button to add leader and trailer to
the beginning and end of your film.

You can use these buttons whenever you need them to advance your film without making an exposure.

You do not have to index the entire roll at one sitting. You may quit whenever you want. To quit, click
 and you will exit from the index screen. The system will “remember” the roll number and the

frame number where you left off so that you can continue from that point if you are not finished.

Indexing from Scratch at the Camera

For each frame you index, you will enter your index record in the fields on the screen. When you
click  or press F8  to move to the next frame, the data for the last record will remain in the
fields so that you won’t have to reenter duplicate information, such as dates or company names if
they happen to be the same. You can just change the information that is different.

Note: If you press Enter  after you enter your last field, you will see the message “OK to File”. Click
 or press Enter  to file the record and the film will advance.

Fig. 18.5. Index screen for indexing at the camera

Control
Buttons

Camera Status

Roll Number
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Fields
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Single-level indexing—one record per frame

For standard single-level indexing, you create one record per frame. When you index at the camera,
a blip will be added to the frame when the film is shot.

} To index each frame as you shoot

1. Position the document on the camera.

2. Enter the record information on the screen.

3. Click  or press F8 . The frame will be shot and the film will advance. The number of the
next frame will appear in the status bar at the bottom of the screen.

Single-level indexing—one record per subgroup

When you index single-level film in subgroups at the camera, you create one record for the first
frame in the subgroup. You then shoot the other frames without creating a new record. A blip will
be added to each frame when the film is shot, regardless of whether or not you entered a record.

} To shoot the first document of the subgroup

1. Position the first document for the group on the camera.

2. Enter the index information. Click  to shoot the frame and advance the film.

} To shoot the rest of the documents in the group

1. Position the document on the camera.

2. Click  or press Enter  to shoot the frame without changing the data in the screen.

Two-level indexing

When you do two-level indexing at the camera, the first field in the record is the “key” for the
group. When the value in this field changes, the system will assume that it is the beginning of a new
group and add a large blip to the frame. If you have not arranged your fields correctly, be sure you
do so before you index.

With two-level film, you can also enter index records for any of the frames within the group. For
example, if you have multi-page documents within a group, you could create an index record for the
first page of each. Or, if you have a large number of documents in the file, you could insert index
records at strategic points to make it easier to position yourself in the file when you are searching
for records.

} To shoot the first document in a subgroup

1. Position the first document for the group on the camera.

2. Enter the index information for the record. The value in the first field must be DIFFERENT from
the previous group for the system to recognize it as a new group.

3. Click  to shoot the frame and advance the film.

} To shoot each of the remaining documents in the group

1. Position the document on the camera.

2. Decide whether you want to create a record for the frame:

• If you want to create an index record for the frame, modify the record as needed. DO NOT
CHANGE THE VALUE IN THE FIRST FIELD!
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• If you do not want to create an index record for the frame, do not change anything. Leave the
record fields alone.

3. Click  to shoot the frame and advance the film.

Three-level indexing—batch and file blips

When you do three-level indexing at the camera, the first field in the screen is the key for the batch
blip and the second is the key for the file blip. When the first field changes, a batch blip will be
added to the film. When the second field changes, a file blip will be added. A record will be added
to your database for each batch and each file blip. If you have not arranged your fields correctly, be
sure you do so before you index.

You can also do page-level indexing with three-level film. Under some circumstances, you may
want to index each page in a file, or you may want to place strategic index records periodically in a
large group of pages.

} To shoot the first document in the batch (batch blip)

1. Position the first document for the batch on the camera.

2. Enter the index information for the record. The value in the FIRST FIELD must be DIFFERENT
from the previous group for the system to recognize it as a new batch.

3. Click  to shoot the frame and advance the film.

} To shoot the first document for a file (file blip)

1. Position the document for the subgroup on the camera.

2. Enter the index information for the record. The value in the SECOND FIELD must be
DIFFERENT to be recognized as a file blip. Do NOT change the value in the FIRST FIELD.

3. Click  to shoot the frame and advance the film.

} To shoot the remaining documents in a subgroup

1. Position the document on the camera.

2. Decide whether you want to create a record for the frame:

• If you want to create an index record for the frame, modify the record as needed. DO NOT
CHANGE THE VALUE IN EITHER THE FIRST OR THE SECOND FIELD!

• If you do not want to create an index record for the frame, do not change anything. Leave the
record fields alone.

3. Click  to shoot the frame and advance the film.

Three-level indexing—batch blips only

If you chose to index batch blips only when you started your index, a record will be added to your
database whenever you shoot a frame with a batch blip. The first field in the screen is the key for the
batch blip and the second is the key for the file blip. When the first field changes, a batch blip will be
added to the film. When the second field changes, a file blip will be added. You will need to change
this value to shoot a frame with a file blip even though you are not creating a record. If you have not
arranged your fields correctly, be sure you do so before you index.

} To shoot the first document in the batch

1. Position the first document for the group on the camera.
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2. Enter the index information for the record. The value in the first field must be DIFFERENT from
the previous group for the system to recognize it as a new batch.

3. Click  to shoot the frame and advance the film.

} To shoot the first document for a file group

1. Position the document for the subgroup on the camera.

2. Change the value in the SECOND FIELD. This value must be different for the frame to be
recognized as a file blip. However, no index record will be created.

3. Click  to shoot the frame and advance the film.

} To shoot the remaining documents in a subgroup

1. Position the document on the camera.

2. Decide whether you want to create a record for the frame:

• If you want to create an index record for the frame, modify the record as needed. DO NOT
CHANGE THE VALUES IN EITHER THE FIRST OR THE SECOND FIELD!

• If you do not want to create an index record for the frame, do not change anything. Leave the
record fields alone.

3. Click  to shoot the frame and advance the film.

Indexing to Imported Records

If you have imported your records without roll and frame numbers and are indexing single-level
film, you can associate them with your film as you shoot. This is done in Lookup/Append mode.
Lookup/Append mode does not work for multi-level film at the camera as all record fields in
Lookup/Append mode are cleared after the frame is shot. When you use Lookup/Append mode,
you enter a value in the first field. The program then searches for all matching records for the value.
The first record found will be displayed on the screen and the number of matching records will be
displayed in the hit bar at the bottom of the screen:

You can use the buttons in the hit bar to page through the records (see Chapter 16 for more
information). When you associate a record with a frame, the program places the roll and frame
number in the record. After the record is filed, the screen will clear so you can enter the key value
for the next frame.

Hint: Before you index records in Lookup/Append mode, reorder the fields on the Index Setup
screen (see Chapter 16) so that the first field will most likely be a unique identifier for the record.

Single-level indexing—one record per frame

For standard single-level indexing, you will associate one record with each frame. When you index
at the camera, a blip will be added to the frame when the film is shot.

} To index each frame as you shoot

1. Position the document on the camera.

2. Enter the data for the first field.
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3. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

4. If there is more than one record and the first record is not the correct one, press the  button.
Continue pressing  until you find the right record.

5. When you find the right record, click . The frame will be shot and the film will advance.

Single-level indexing—one record per subgroup

When you index single-level film in subgroups at the camera, you associate a record with the first
frame in the subgroup. You then shoot the other frames without associating them with a record. A
blip will be added to each frame when the film is shot, regardless of whether or not the frame is
associated with a record.

} To shoot the first document of the group

1. Position the first document for the group on the camera.

2. Enter the value for the first field.

3. Press Tab  or Enter . The number of matching records will appear at the bottom of the screen.
The first matching record will be displayed on the screen.

4. If there is more than one matching record and the first record is not the correct one, press the 
button. Continue pressing  until you find the right record.

5. When you have found the right record, click  to shoot the frame and advance the film.

} To shoot the rest of the documents in the group

1. Position the document on the camera.

2. Click  to shoot the frame. DO NOT ENTER ANYTHING in the screen.

What To Do Next

n If you want to search and view your database, go to Chapter 23.

n If you have VersaImage and want to scan images for your database, go to Chapter 11 to learn
about images and Chapter 12 for instructions on scanning your film.
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19 Indexing
Images

VersaImage has a very powerful and versatile image indexing module. Images may be scanned from
microfilm or paper or imported from another system through the Image Import function. When
images are scanned or imported, the VersaImage creates an “empty” record for each image or folder
and places the image or folder in a to-be-indexed list. When an image is indexed, it is deleted from
the list.

Through the image indexing module, you can enter index records from scratch or associate images
with records that have already been entered. Functions are available to deskew, crop, and rotate
images and to page through images without indexing them. “Advanced” functions allow you to build
file folders as you index and read bar-coded data into your database.

Note: VersaImage also has a Index Folders and Scan function that allows you to scan and index
individual folders in one step. Instructions are given in Chapter 21.

Starting the Image Indexing Function

Before you can index your images, you must select the database to
be indexed and the batch of images you want to index. Images
scanned from paper will be in folders beginning with BCH. Images
scanned from film will be in folders starting with ROLL.

} To start indexing images

1. Select Open Database from the File menu.

2. Select the database you want to index from the Open dialog box.
The main database screen will appear.

3. Select Index Images from the Index menu (fig. 19.1). The Setup
Image Indexing dialog box (fig. 19.2) will appear. All batches
associated with the database that contain non-indexed records will
be listed in the box.

4. Select the roll or batch you want to index and click :

19

Fig. 19.1. Index menu

Fig. 19.2. Setup Image Indexing dialog.
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• If you have not set your Indexing Setup parameters yet
for this database, the Indexing Setup dialog box will be
displayed. Change the default settings if necessary and
click . The Lookup/Append message will appear
(fig. 19.3).

• If you have already set your Indexing Setup parameters,
the Lookup/Append message will appear (fig. 19.3)
immediately.

5. Select your Lookup/Append mode option:

• If you are entering your records from scratch, click .

• If the records for your images are already in the database, click .

6. The screen for indexing your images (fig. 19.4) will appear.

Using the Image Indexing Screen

The image indexing screen will contain all of the fields you defined for your records except for the
Roll, Frame, and Image Address fields. The first page of the first record to be indexed will appear
on the screen. A special tool bar at the top of the screen contains the record and page number infor-
mation and buttons that perform special indexing functions. You will be using these buttons to
perform some of the functions described in this chapter.

Setting up the data locations

When you index your first record for an indexing session, you tell VersaImage where the
information you need to view for each field is located. For subsequent records, VersaImage will
zoom into these areas automatically.

Fig. 19.3. Lookup/Append message box

Fig. 19.4. Index Images indexing screen
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} To set up your data locations

1. Index each field in the first record as follows:

• Move the cursor to the database field.

• Position your mouse pointer on the image in the place where the information you are indexing
appears on the document.

• Hold your left mouse button down and draw a box around the area that contains the information.
Then release the button and VersaImage will zoom in on the area so you can read the
information (fig. 19.5).

• Enter the data in the field and press Tab  or Enter  to move to the next field. The image will
return to normal display size so you can find the area for the next field.

2. When you finish all the fields in the record, click  or press F8  and the system will display
the next record to be indexed.

Note: If you press Enter  from the last field in the record, you will see a message that says “OK to
File?” To go on to the next record, click  or press Enter  again.

} To index the other records for the batch

1. When a record is displayed, the cursor will be on the first field and the system will zoom in the
data for the first field.

2. Enter your data into the screen fields. As you move from field to field, the program will
“remember” the area you zoomed in on before and will automatically zoom in on it again.

3. When you finish with the record, click  or press F8  to display the next one.

You do not need to index all the images in a batch at one sitting. You may quit whenever you want.
To quit, click  and you will exit from the index screen. The next time you select the batch for

Fig. 19.5. Image indexing screen with zoomed image
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indexing, the system will start with the next non-indexed record. However, it will not remember
your data locations. You will need to redefine them each time you index.

Zooming in and out

In addition to zooming in and out on the data for a field, you can zoom in and out from the standard
full-page display to a full screen display. For folder files and multi-page TIFF files, you can also
display “thumbnails” of all the images in the group.

} To switch between full page and full screen

1. To change from full page to full screen, do either of the following:

• Click your left mouse button.

• Click  on the tool bar.

2. To change from full screen to full page, do either of the following:

• Click your left mouse button.

• Click  on the tool bar.

} To switch between thumbnails and full page

1. To display thumbnails, press your right mouse button and you will zoom out (see fig. 19.6).

2. To display a thumbnail as a full page, move the mouse pointer to the image you want to see and
click your left mouse button.

Paging functions

While you are indexing images, you can view images without indexing them, skip images, view
previous records you have indexed during this indexing session, and copy index information from the
previous record.

Fig. 19.6. Image indexing screen with thumbnails. Thumbnails are displayed for folder files and multi-page TIFFs
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} To skip images while you are indexing

1. To skip an image, click  on the tool bar without entering any data in the record you want to
skip. The image will be left in the to-be-indexed list.

2. When you come to an image you want to index, enter the data for that image. Click  or
press F8  to “file” the record and move to the next image.

} To view images without indexing

1. Click  on the tool bar to display the next image in the list. Do not enter any data in the
record.

2. To back up, click  on the tool bar. Do not enter any data in the record.

 Note: You can go forward and backward through as many images as you want without indexing
them as long as you do not enter data. If you enter any data for an image, it will be indexed.

} To look at records you’ve indexed previously

1. Click  on the tool bar to back up to the previous image. The data you entered for the record
will be displayed along with the image. You can back up through as many records as you want.

2. To return to the image you left, click  on the tool bar to move forward until you reach the
image.

} To copy data from the previous record

1. Press F9 .

2. The data in the previous record will be copied and you will automatically move on to the next
record.

Entering Records from Scratch

When you index from scratch, you enter data for each field in the record. If data is not available for
a particular field, you can skip it and enter it later. When you file the record and display the next
image, the data for the previous record will remain in the fields so that you won’t have to reenter
duplicate information, such as dates or company names if they happen to be the same. You can just
change the information that is different.

Note: Before you start indexing your images, make sure you have read the information above on
using the screen. The instructions below assume that you are familiar with this information.

Indexing single pages

When you index single pages, you create a database record for each image. Each image in the batch
will be displayed on the screen for you to view.

} To index single pages

1. Index each field in the first record as follows:

• Move the cursor to the database field.

• Select the area of the image that contains the data you need for the record and release the
mouse button to zoom in.

• Enter the data in the field and press Tab  or Enter  to move to the next field. The image will
return to normal display size so you can select the area for the next field.
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2. When you finish all the fields in the record, click  or press F8  and the system will display
the next image to be indexed.

3. For the rest of the records, do the following:

• When the image is displayed, the program will zoom in on the data for the first field.

• Enter your data in the screen fields. As you move from field to field, the program will
automatically zoom in on the area that contains the information.

• When you finish with the record, click  or press F8  to file the record and display the
next image.

4. When you finish indexing, click .

Reminder: Don’t forget that you can skip images you don’t want to index by pressing .

Indexing folders and multi-page TIFFs

When you index folders and multi-page TIFFs, the page counter on the tool bar will display the
number of images in the set. The program assumes that the information you need for your index
record is on the first page. For that reason, it displays that image as a full page with the blank
record. If the information is on another page, you can zoom out and select the page you want from
the thumbnails.

} To index folders and multi-page TIFFs

1. Index each field for the first record as follows:

• Move the cursor to the screen field.

• If the image that contains the information for the field is not the one displayed, click your
right mouse button to zoom out to thumbnail view, move the pointer to the correct image, and
click your left mouse button.

• Select the area of the image where the data for the field is located and release the mouse
button to zoom in.

• Enter the data in the field and press Tab  or Enter  to move to the next field. The image will
return to normal display size so you can select the area for the next field.

2. When you finish all the fields in the record, click  or press F8  to file the record. The
system will display the first image for the next record.

3. For the rest of the records, do the following:

• When the record is displayed, the program will zoom in on the first image and display the data
for the first field. If this is not the right page, click your right mouse button to zoom out and
move your mouse pointer to the correct thumbnail. Click your left mouse button and the
program will zoom in on your data.

• Enter your data in the screen fields. As you move from field to field, VersaImage will zoom
in on the area you selected for the field on the current page. If your data is on a different
page, zoom out to thumbnail view and select the correct one. VersaImage remembers the area
of the page, not the position of the document in the set.

• When you finish with the record, click  or press F8  to file the record.

4. When you finish indexing, click .

Reminder: Don’t forget that you can skip images you don’t want to index by pressing .
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Associating Images with Existing Records

To associate images with existing records, you use Lookup/Append mode. When you index in
Lookup/Append mode, you enter a value in the first field only. The system then looks for all
matching records and displays them for you to select from. The number of hits found for the value
you entered in the first field will be displayed at the bottom of the screen:

The first record in the group will be displayed in the screen fields. You can use the buttons in the hit
bar to page through the records (see Chapter 16). When you select and file record, the image
address is placed in the record and the “empty” record that was created for the image when it was
imported or scanned is removed. The screen will be cleared after the record is filed so you can enter
the key field for your next image.

Indexing single pages in Lookup/Append mode

When you index single pages in Lookup/Append mode, you match each image to a record. Each
image in the batch will be displayed on the screen for you to view.

} To index single pages in lookup append mode

1. Move the cursor to the first field in the record and do the following:

• Select the area on the image where the information for the first field is located and release the
mouse button to zoom in on it.

• Enter the value in the first field and press Tab  or Enter  to display the first matching record.

• If there is more than one matching record, page through the records with the  on the hit bar
to find the one you want.

2. Click  or press Enter  to associate the record with the image and the system will display the
next image to be indexed.

3. For the rest of the records, do the following:

• When the record is displayed, the program will zoom in on the data for the first field.

• Enter the data in the field and press Tab  or Enter .

• If there is more than one matching record, use  on the hit bar to page to the record you
want to associate the image with.

• Click  or press Enter  to associate the record with the image and display the next image.

4. When you have finished indexing, click .

Indexing folders and multi-page TIFFs in Lookup/Append mode

When you index folders and multi-page TIFFs in Lookup/Append mode, all images in the group
are associated with the same record. VersaImage assumes that the information you need for your
first field is on the first page and displays the first image as a full page with the blank record. If the
field is on another page instead, you can zoom out and switch to the correct page.

} To index folders and multi-page TIFFs in Lookup/Append mode

1. Index the first record as follows:

• If the image that contains data for the first field is not the one displayed, click your right
mouse button to zoom out to the thumbnails, move your mouse pointer to the correct image,
and click your left button.

• Move the cursor to the first field in the record.
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• Select the area where the information you need for your first field is located and release the
mouse button to zoom in.

• Enter the data in the field and press Tab  or Enter  to display the first matching record.

• If there is more than one matching record, page through the records with  on the hit bar to
find the one you want.

2. Click  or press Enter  to associate the record with the images and the system will display
the first image in the next set.

3. For the rest of the records, do the following:

• When the record is displayed, the program will zoom in on the area you selected for the first
field.

• If this is not the correct image, click your right mouse button to zoom out to the thumbnails,
select the correct page, and click your left mouse button to zoom in again.

• Enter the data in the field and press Tab  or Enter  to display the first record for the value you
entered.

• If there is more than one matching record, use  on the hit bar to page to the record you
want to associate the image with.

• Click  or press Enter  to associate the record with the folder.

4. When you have finished indexing, click .

Fixing Images

While you are indexing, you can make some minor “fixes” to your images. These include cropping,
rotating and deskewing. More extensive corrections can be applied from the search screen (see
Chapter 23)

Cropping images

Cropping removes extraneous area from around an image. This is particularly useful when indexing
images scanned from microfilm, where a large amount of background “noise” may be captured with
an image. The crop option that you want to use during indexing an indexing session must be selected
before you start indexing. This option stays in effect for your entire indexing session. Fig. 19.7
illustrates the available options.

} To select your cropping option

1. Select Preferences from the File menu.

Original Image Standard Crop Crop and Center Crop and Expand

   
Fig. 19.7. Crop options
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2. Select Imaging Options from the Preferences menu. The Imaging Options dialog box will
appear (fig. 19.8).

3. Select the crop option that best suits your needs (see fig. 19.7).

4. To enable cropping during searches as well as during indexing, check the Enable for Search
option.

5. When you are finished, click  and the window will close.

} To crop an image

1. Press Ctrl  and hold your left mouse button
down.

2. Draw a box around the area you want to crop
(fig. 19.9). The area inside the box will remain
after the crop and the area outside the box will
be removed.

3. Release the mouse button to crop the area.

Note:  If you make a mistake, press the  button
and start over.

Deskewing and rotating images

The deskewing and rotating functions allow you to
correct misoriented images. The Rotate option
rotates images that were scanned in the wrong
orientation (e.g., upside down) in 90-degree incre-
ments. The Deskew option straightens a crooked
image. It can correct up to 20 degrees of image
skew.

} To rotate an image

1. Do either of the following:

• Click  on the tool bar.

• Press F11 .

2. The image will rotate 90° to the right.

3. Continue clicking  or pressing F11  until the image is in the correct orientation. Each time
you click, the image will rotate 90°.

Fig. 19.8. Imaging Options dialog

Fig. 19.9. Cropping an image
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} To deskew an image

1. Do either of the following:

• Click  on the tool bar.

• Press F10 .

2. The image will be deskewed.

Building Folder Files As You Index

VersaImage allows you to build folder files from images that are scanned as either single-page or
multi-page TIFF files. This is particularly useful in the following cases:

n In batches where most documents are single page but the occasional document spans more than one
page (e.g., the occasional multi-page invoice in a set of invoices that are primarily single-page).

n For batches of imported images that should be grouped in folders but did not have a naming
convention that allowed VersaImage to build them automatically.

n To group images scanned from roll film in single-page mode into folders.

n For batches of images that were scanned in single-page mode by mistake.

n For batches where you want to group multi-page TIFF images into folders.

} To create or add to a file folder

1. Press F12  to append the current image to the previous image:

• If the previous image was not in a folder, a new folder file will be created and both images
will be added to the folder.

• If the previous image has already been added to a folder, the current image will be added to
the same folder.

2. After you press F12 , the next image in the to-be-indexed list will appear. Do one of the
following:

• Press F12  to add the image to the folder.

• Enter data for the record to either start a new folder or index the image as a single image.

Note: If you make a mistake, you can remove the image from the folder and place it in the to-be-
indexed list again through the QC Image function (see Chapter 30).

Reading Bar Codes

If you have documents with bar-coded data, a special feature of VersaImage allows you to create
your index records automatically by setting up bar code zones. OCR recognition is also available.
The system reads these zones and places the values in the fields you specify. Once you have defined
zones for a database, they will remain in effect until you remove them.

When you set up bar code zones, you can specify the way you want to handle an associated field if
the bar code is not recognized:

Allow Manual Entry Stops and lets you enter the data manually.

Place ~ into Database Places a ~ in the field. You can later return any records with a ~ in a field
to the to-be-indexed list through the Rebuild Index List function. You can
also search specifically for a ~ in your database records and fill the field
in.
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Copy Previous Record Copies the data for the field from the previous record.

Note: Because VersaImage will stop processing whenever the value read is invalid for the field, we
recommend that your bar code fields be alphanumeric so an error will not occur when a ~ is placed
in the field.

Because bar code processing is automatic, it can only be used on documents with bar codes in
predictable locations. Do not use it for databases with folders or multi-page TIFFs unless all the bar
code data is located on the first page. The bar code function will only read the first page.

Setting up zones

You can set up single bar-code zones, multi bar code zones or OCR zones:

n Single bar code zones contain one bar code each. They are used when each bar code on the page
is to be indexed to a different field in the record.

n Multi bar code zones contain multiple bar code for the same field. VersaImage will create a
record for each bar code and link the displayed image to each.

n OCR zones contain text to be “scanned” for information.

When you set up a zone with multiple bar codes, you can optionally include a bar code count zone
that contains the number of bar codes in your zone. If you include a count zone and VersaImage
can’t find or read all the bar codes, it also creates records for the missing codes and places a ~ in
the record. If there is no count zone, it will only create records for the codes it can read.

} To set up single bar code zones

1. Click  on the tool bar. The button will change to  and the cursor will change to .

2. Draw a box around the area where your bar code is located. The OCR/BarCode Zone Setting
dialog (fig. 19.10) will appear.

3. Select the field you want the value of this bar code placed in from the Field to Enter drop-down
list.

4. Select Single Bar Code as the Zone Type from the drop-down list.

5. Select the type of bar code from the other drop-down list. The default is All Bar Codes.

6. Select the action you wish to take If BarCode Not Recognized.

7. Click .

Note: If you have more than one bar code zone, you must use the same If BarCode Not Recognized
option for all zones.

Fig. 19.10. OCR/BarCode Zone Setting dialog
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} To set up a bar code count zone

1. Click  on the tool bar. The button will change to  and the cursor will change to .

2. Draw a box around the bar code that contains the number of bar codes for your multi-code zone.
The OCR/BarCode Zone Setting dialog (fig. 19.10) will appear.

3. Select Bar Code Count as the Zone Type from the drop-down list. All other fields in the box
will be ignored.

4. Click .

} To set up a multi bar code zone

1. Click  on the tool bar. The button will change to  and the cursor will change to .

2. Draw a box around the area that contains the bar codes. The OCR/BarCode Zone Setting dialog
(fig. 19.10) will appear.

3. Select the field where you want the value for the bar codes in the zone placed from the Field to
Enter drop-down list.

4. Select Multi Bar Code as the Zone Type from the drop-down list.

5. Select the type of code from the other drop-down list. The default is All Bar Codes.

6. Select the action you wish to take If BarCode Not Recognized.

7. Click .

} To set up OCR zones

1. Click  on the tool bar. The button will change to  and the cursor will change to .

2. Draw a box around the area that contains the information to be read. The OCR/BarCode Zone
Setting dialog (fig. 19.10) will appear.

3. Select the field where you want the value to be placed from the Field to Enter drop-down list.

4. Select OCR as the Zone Type from the drop-down list. The code type field will be ignored.

5. Select the action you wish to take If BarCodeNot Recognized.

6. Click .

Modifying zones

You can change your bar code definitions, remove the bar code zones from your document, change
the size of a zone, or move the zone to a different position.

Note: You cannot remove individual bar code zones.

} To modify bar code zone definitions

1. Click  on the tool bar. The button will change to  and the cursor will change to .

2. Double-click on the zone you want to edit.

3. Change whatever fields you need to change.

4. Click .

} To remove the bar code zones

1. Click  on the tool bar. The button will change to  and the cursor will change to .

2. Double-click on any zone.

3. Click the  button.
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} To move a bar code zone

1. Place your mouse pointer on the zone.

2. When the cursor changes to , drag the zone to the new location.

3. After you move the zone, the OCR/Bar Code Zone Setting dialog will open in case you need to
change the definition. Click  to close the box.

} To resize a bar code zone

1. Place your mouse pointer on one of the four corners of the zone.

2. When the cursor changes to a diagonal arrow, drag the corner in or out to resize the box.

3. After you resize the zone, the OCR/Bar Code Zone Setting dialog will open in case you need to
change the definition. Click  to close the box.

Processing

Processing, once started, is automatic. It will not stop until it completes the batch unless an error
occurs or you have set it to stop for manual entry when a bar code is not recognized.

} To process a batch with bar code zones

1. After you have defined your zones, click the  button at the bottom of the screen. The Start
Processing message box will appear.

2. Click  to start processing.

Note: If you select Index Images on a database that already has bar code zones set up, the Start
Processing message will be displayed immediately. If you want to make changes to your zones before
processing, select .

Rebuilding the To-Be-Indexed List

There are times when you will need to reindex a batch of images that were not indexed correctly. If
you index with bar codes, for example, can have VersaImage place ~ in the record whenever it
doesn’t recognize the bar code and then have VersaImage return all records with ~ in them to the
list. Blank records and records with missing fast search data can also be restored.

} To restore the image index list

1. Select Rebuild Image Index List from the index menu. A dialog box (fig. 19.11) for entering
your restoration criteria will appear.

Fig. 19.11. Dialog box for rebuilding the to-be-indexed list
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2. Select the batch or roll you want to restore.

3. Select the criteria for selecting the images to restore from the Selection  Criteria options:

Select Records with no Fast Search Fields Includes images for records that do not contain
data in any of the fast search fields.

Select all Blank Records Includes images for all blank records.

Select all Blank Records with SQ Number Includes images for all blank records with no
SQ number. This option is used for Canon
RFS1000 scanners with SQ feeders. If you cap-
ture the SQ number, you can use this option.

Select all Records with ~ Includes images for all records that contain a ~
in any field.

4. Click .

5. If you selected Select all Blank Records with SQ Number, a
dialog box will appear so you can select the field that contains
the SQ number (fig. 19.12):

• Click  to display the drop-down list containing the fields
in your record.

• Select the field that contains the SQ number.

• Click .

What To Do Next

For instructions on searching and viewing your database, go to Chapter 23.

Fig. 19.12. Selecting the SQ field



20  Indexing
from Paper

Although it is not usually necessary, you can enter index records from paper without associating them
with film or images. This can be of use in special circumstances, such as entering information in the
master record of a master reference database or in environments where index entry and scanning are
done in different places. Because you can also enter roll and frame numbers with this function, you
may also find it convenient for entering records for roll film that were written to an error file during
import or for maintaining a film index database when your reader is not computer-controlled.

Getting Ready to Index

} To start an index

1. From the File menu, select Open Database.

2. Select the database you want to index from the Open dialog box.
The database search screen will appear.

3. Select Index from Paper from the Index menu (fig. 20.1):

• If you have already defined your indexing setup parameters for
this database, the Lookup/Append dialog box (fig. 20.2) will
appear.

• If you have not yet defined your indexing setup parameters,
the Indexing Setup dialog will be displayed (see Chapter 16).
Change the defaults if you want. Then click  and the
Lookup/Append message box (fig. 20.2) will appear.

4. Select your Lookup/Append option:

To enter your records from scratch. This is the usual
mode for paper indexing.

  To manually add roll and frame numbers to existing
records.

Note: Although Lookup/Append mode is technically available, it is not usually useful for paper
indexing as there is no real reason to access previously entered records unless you need to manually
add roll and frame numbers. In general, changing information in existing records is much simpler
through the search screen and roll and frame number corrections should be done through the QC
function.

The Index Screen

After you enter your setup parameters, the screen for entering your records will appear. It looks
much like the main database screen and contains all the fields you defined for your records except
Image Address. Unlike other index screens, roll and frame fields are included if they have been
defined for the record. The fields will appear in the order you specified in your database screen,
unless you changed them in the Index Setup dialog.

20

Fig. 20.1. Index menu

Fig. 20.2. Lookup/Append dialog
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Entering Records from Paper

When you index records separately from film or images, you are simply creating new records that
will later be associated with film or images. If you are entering records that will later be indexed to
a roll of film, do not fill in the roll and frame numbers. Roll and frame numbers should only be
entered when you are adding missing records to a database that has already been indexed to a roll of
film or creating a database for manual use in that will not be indexed to film through the computer.
If you are already familiar with other indexing methods, you will find that indexing from paper is no
different from entering records while you are indexing film or images, except that you have no
visual clues that you are entering a new record.

} To enter your records from scratch

1. Fill in the fields in the record.

2. Click  or press F8  to file the record.

After you file the record, the data in the record will remain in the fields so that you won’t have to
enter duplicate information, such as dates or company names if they happen to be the same. You can
just change the information that is different.

Using Lookup/Append Mode with Paper Indexing

If your index records are already in the database and you need to enter roll or frame numbers
manually, you can use Lookup/Append mode. In Lookup/Append mode, you enter a “key” value
in the first field. The system then looks for matching records for your key. The number of records it
finds will be displayed in the hit bar at the bottom of the screen:

Fig. 20.3. Indexing screen for paper indexing
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The first record found will be displayed on the screen. You can use the buttons on the hit bar to
page through the records if necessary to find the one you want (see Chapter 16 for a more detailed
description of the hit bar).

Since your only reason to use Lookup/Append mode would be to add roll or frame numbers manu-
ally, your procedure in Lookup/Append mode will be somewhat different than for other modes of
indexing you might be familiar with.

} To enter records in Lookup/Append mode

1. Enter a value in the first field.

2. Press Tab  or Enter . The number of matching records will be displayed in the hit bar at the
bottom of the screen and the first record found will be displayed on the screen.

3. Use the buttons in the hit bar to page to the record you want if necessary.

4. Ignore the displayed message and either click your mouse on the field you want to enter data in
or use Shift  + Tab  to back up to the field.

5. Enter your values.

6. Click  or press F8  to file the record. The data you entered will remain on the screen but
the rest of the record will be cleared.

Hint: If you are using Lookup/Append to add roll and frame numbers, make sure you set your
indexing order up so the frame number is last. That way, if your frames are on the same roll, you
only need to Shift   + Tab  once to reach the frame field. The roll number from the previous record
will remain in the field so you won’t need to back up to enter it each time.

What To Do Next

n For instructions on searching your database, go to Chapter 23.

n To associate images with the records you have entered, go to Chapter 11 to learn about placing
images in your database. Then index the images to this database in Lookup/Append mode as
instructed in Chapter 19.

n To associate the records you have entered with microfilm, go to Chapter 17 and index the film to
these records in Lookup/Append mode.
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21 Scanning and Indexing
Folders in One Step

The Index Folder and Scan function bypasses the batch scanning process. It allows you to place a
complete file folder into the feeder of your paper scanner, scan the first page, index the folder, then
automatically scan the rest of the folder. You can use this feature to either index new folders or add
folders of documents to existing records. You can also use it for scanners without feeders (film
scanners). However, you will need to use the Scan Single function ( F5  key) to add the remaining
pages to your folder.

Note: This method is a more efficient way than using Scan Single from the search screen to add
pages to an existing folder if you have a large number of pages to add.

This function is commonly used in hybrid systems to scan a microfiche jacket into an image folder,
then add additional pages from paper to the image folder. It can also be used in reverse to scan
paper into a file folder and then add microfilm or microfiche images to this folder. The latter
method keeps new images at the top of the folder and older images towards the end of the folder.

Before you use this option, you should know how to scan images (Chapter 11) and index them
(Chapter 19). The instructions in the chapter assume you know how to do both. All indexing
functions that are available when you index images except F9  (copy previous record) and F12

(append existing image to folder) will work in Index and Scan mode. You can use the “zoom”
feature to zoom in on the areas in the scanned image where the data for your fields are located.
VersaImage will remember your data locations for subsequent scans until you exit Index and Scan
with Clear.

Index and Scan operates in Lookup/Append mode. However, unlike standard Lookup/Append
mode, it will allow you to place images in already existing folders. Standard Lookup/Append mode
looks only for records without images while Index and Scan looks for all matching records. You
can still enter new records in this mode if there are no hits found in the database. If you are
appending images to existing records or want to do so if the record already exists, be sure to arrange
your fields for indexing so that your “key” field appears first. If you are planning to enter new
records only, make sure your first (key) field is unique (e.g., an invoice number or a case number as
opposed to a company name) so VersaImage won’t find any “hits.”

Scanning a Folder with a Paper Scanner

For Index and Scan to work automatically with a paper scanner, you must select Single page TIFF
images, Folder File as your scanning mode. Otherwise, it will assume you are using single images
and will not scan the folder.

} To scan paper images in Index and Scan mode

1. Click Imaging Options on the Preferences menu and make sure that Single page TIFF images,
Folder Files is selected.

2. Select Setup Scanner from the Scan menu and make whatever changes you need to the settings.
If you know it is already set up correctly, you can skip this step.

3. Place the file folder to be scanned into your paper scanner.

4. Do one of the following to scan the first page:

• Press the F2  key.

21
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• Select Index Folder and Scan from the Scan menu.

5. Use your mouse to select the area or the image where the data for the first field is located.
VersaImage will zoom in on the area.

6. Enter the data in the first field and press Tab  or Enter :

• If there are any matching records, the number of hits will be displayed in the hit bar and the
first matching record will appear on the screen. If there is more than one matching record,
page through them with  to find the one you want.

• If there are no matching records, you will see a message telling you to press Tab  to continue.
Press Tab  to leave the first field and enter the remaining fields for the record. You may use
the Zoom features to zoom in on the image data.

7. Click  or press F8  to file the record. VersaImage will display the Batch Scan dialog box
(fig. 21.1) and scan the rest of the pages in the scanner automatically.

8. When it finishes, click  in the batch scan dialog and you will return to the search screen.
The folder will be displayed for you to examine:

• To scan another folder, press F2  or select Index Folder and Scan from the Scan menu.

• To exit, click  to clear the record.

Note: If the batch scan dialog does not appear, you did not select Single page TIFF images, Folder
Files as your scanning mode. You can still add additional pages manually with the F5  key.

Scanning a Folder with a Film Scanner

When you scan film images in Index and Scan mode, you will need to use the Scan Single ( F5 )
option to tell VersaImage which images to include in the folder.

} To scan film in Index and Scan mode

1. Select Setup Scanner from the Scan menu and make whatever changes you need to the settings.
If you know it is already set up correctly, you can skip this step.

2. Position your film on the first frame for the folder.

3. Do one of the following to scan the first page:

• Press F2  key.

Fig. 21.1. Batch Scan screen during an Index and Scan operation
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• Select Index Folder and Scan from the Scan menu.

4. Use your mouse to select the area or the image where the data for the first field is located.
VersaImage will zoom in on the area.

5. Enter the data in the first field and press Tab  or Enter :

• If there are any matching records, the number of hits will be displayed in the hit bar and the
first matching record will appear on the screen. If there is more than one matching record,
page through them with  to find the one you want.

• If there are no matching records, you will see a message telling you to press Tab  to continue.
Press Tab  and enter the remaining fields for the record. You may use the Zoom feature to
zoom in on the data in the image.

6. Click  or press F8  to file the record. You will return to the search screen and the scanned
image will be displayed.

7. For each subsequent frame you want to add to the folder, do following:

• Press F5  or select Scan Single from the Scan menu.

• The scanned image will appear on the screen and the reader will move to the next frame.

8. When you finish the folder, do either of the following:

• To scan another folder, press F2  or select Index Folder and Scan from the Scan menu.

• To exit, click  to clear the record.



White Text



22 Indexing a Master
Reference Database

Master reference databases can contain both scanned images and indexed roll film indexed to the same
master records. Unlike standard databases where most document groups are indexed sequentially, the
master reference database allows you to index from several different sources to one master record.
You might for example scan a batch of documents and index them at one sitting, creating master
records for each as well as the individual document records, then import a set of images that were
scanned by another department and link them to the same master records. Later you might index the
documents on a roll of film to the same database and link them to the existing master records.

You don’t have to add your master records at the same time you index your database records if this
is not a convenient may to operate. If your master record data is already in a database, you could
import the master records and then index your documents later. Or you might enter the records
independently through the Indexing from Paper option (ideal if master record entry is completely
separate from document indexing).

Since the basic “how tos” of indexing film and images are the same as for indexing in a standard
database, you should first know how to create index records for film and/or scanned images for a
standard database as discussed in Chapters 17—19 before you build a master reference index.

The Master Reference Index Screen

The master reference index screen (fig. 22.1) displays the fields in both the master record (from the
master table) and the document record (from the reference table). The master record fields are
located above the blue line and the document record fields are located below. Like other database
filled in automatically as you index. The screen will differ slightly depending on whether you are
indexing at the reader, at the camera or from images. For indexing at the reader, it will appear

22

Fig. 22.1. The Master Reference Index screen. Fields above the blue line are master record fields. Fields below the blue line are
document record fields
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exactly as shown in fig. 22.1. For indexing at the camera, it will contain the tool bar for indexing at
the camera with  and  buttons. If you are indexing images, it will display them on the
right side of the screen and the tool bar buttons for image indexing will appear.

You can rearrange your fields for more convenient indexing through the Indexing Setup options
(see Chapter 16) and apply table verify, auto increment and auto date features if you want.
However, there are some caveats:

n The link field should be the first field on the screen. If it is not first in your database definition,
be sure to place it there before you index. This field must always be entered. It must be present
in the master record in order to index the document record. It is also the field that will be used to
retrieve master records as you index if you are adding documents.

n Do not reorder fields between the two records. You may place the master record fields in any
order among themselves and the document record fields likewise. But you cannot insert a
document record field in the middle of the master record fields or vice versa.

Think of the fields as two separate database records and don’t intermix them. Other than that, you
may do whatever is convenient for indexing.

Hint: If you are incorporating document type names as well as ID numbers, create a verification
table for the names so you don’t have to enter them over and over. If your ID numbers are long, you
create a verification table for them also and link them to the same two- or three-letter code you use
for the names. For example, you could use the code “LA” for both the loan application document ID
and the document name.

Indexing Roll Film at the Reader

Your procedure for indexing roll film for a master reference database depends on the type of film
and also how the documents on the film relate to the master reference structure. In this section, we
give you some standard scenarios. Based on these, you can make recommendation for how you want
the film shot if you plan to use this type of database. Single-level film is usually pretty straight-
forward. However, existing multi-level film may have been shot with scenarios that do not relate
well to master reference indexing, in which case you will have to get creative. In worst case
scenarios, you may want to index completely in page-level mode.

} To start indexing roll film for a master reference database

1. Load your film.

2. From the File menu, select Open Database.

3. Select the database you want to index from the Open dialog box. The database search screen will
appear.

4. From the Index menu, select Index at Reader. The New Roll dialog box will appear.

5. Enter the number of the roll you are indexing in the text box and click :

• If you are indexing one- or two-level film, the New Frame dialog box will appear.

• If you are indexing three-level film, a message will appear asking you if you want to index
batch blips only. Select the type of index you want:

To enter records for batch blips only

To enter records for both batch and file blips

After you make your selection, the New Frame dialog will appear.

6. In the New Frame dialog box, enter the number of the frame you want to start with:
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• For single-level indexing, enter a whole number.

• For two-level indexing, enter the number of the file blip you are starting with, followed by .0.

• For three-level indexing, enter the number of the large (batch) blip followed by the file blip
and .0 for the page blip (e.g., 3.1.0).

Note: If your reader/printer is set up to recognize page 1 as the file blip, enter .1 instead of .0 after
the file number.

7. Click  and the reader will advance to that frame number. If you have not yet set your
indexing options for this database, the Indexing Setup dialog (see Chapter 16) will appear.
Change the defaults if you want and click .

Note: After you have indexed a database once, the last roll and frame you indexed will always be
displayed for you in the New Roll and New Frame dialogs so that you can continue from where you
left off by merely clicking .

Indexing single-level film

Documents that are on single-level film can be either single-page (where you index each page),
multi-page (where you index the first page of each document) or both.

} To index single-level film in a master reference database

1. Enter the link field and press Tab  or Enter .

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

2. Enter the data for the index record in the document record field.

3. Click  or press F8 . The reader will advance to the next frame:

• If this frame is a page of the document you just indexed, click  or press F8  to move to
the next frame without changing any data. Continue clicking  or pressing F8  to advance
the reader until you reach the first page of the next document.

• If this frame belongs to the same master record but is a different document, return to step 2
and enter the data for the document.

• If this frame belongs to a different master record, return to step 1 and enter the link field for
the record.

Two-level film

Usually, when you index a master reference database, you will want to create a record for each
document. With two-level film you will usually have one of two basic setups:

n Each file blip will generally signal a new document. Occasionally, however, a page blip may
contain a frame that should be indexed as a document. In this case, you will do most of your
indexing in file mode but may occasionally switch to page mode.

n Each file blip signals a different master record. Each page blip is a document page for the master
record. Documents can be one-page or multi-page. In this case you will do your indexing in page
mode unless there is only one document per master record.

If your film is mixed, you will have to switch back and forth between the two modes.
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} To index two-level film where each file blip is a document

1. Enter the link field and press Tab  or Enter .

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

2. Enter the data for the index record in the document record field.

3. Click  or press F8 . The reader will advance to the next file blip:

• If this document belongs to the same master record but is a different document, return to step
2 and enter the data for the document.

• If this frame belongs to a different master record, return to step 1 and enter the link field for
the new record.

} To index two-level film where each file blip is a new document for a different master record

1. Enter the link field and press Tab  or Enter :

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

2. Enter the data for the index record for the current frame in the document record field.

3. Click  or press F8  and the reader will advance to the next file blip.

} To index two-level film in page-level mode

1. Press F7  to switch to page mode.

2. Enter the link field and press Tab  or Enter :

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

3. Enter the data for the index record for the current frame in the document record field.

4. Click  or press F8  and the reader will advance to the next frame:

• If it is the start of a new document and you want to index the record, go to step 3 and enter
the data for the record in the document record fields

• If it is a part of the previous document and you do not want to index the record, press Enter  to
go to the next frame.

• If it belongs to a different master record, return to step 2 and enter the link field for the
master record.

Three-level film

Ideally, when three-level film is used with master reference databases, the batch blip will signal the
start of a different master record and a file blip will signal the start of a document. While you are
indexing, you can switch to page mode if you want to index individual frames.

} To index frames with batch blips

1. Enter the link field and press Tab  or Enter :

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.
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2. Enter the data for the document in the current frame in the document record field.

3. Click  or press Enter  and the film will advance to the first file blip.

} To index frames with file blips

1. Enter the data for the document associated with the file blip in the document record field. Do not
change the master record.

2. Click  or press Enter :

• If there are more file blips in the batch, the film will stop at the next file blip.

• If there are no more file blips, the film will advance to the next batch blip.

Indexing a Master Reference Database at the Camera

When you index a master reference database as you shoot, VersaImage makes certain assumptions:

n For single-level film, it assumes that you want to add a new document record every time you
change any values in the document record fields and a new master record whenever the link
value changes.

n For two-level film, it assumes that you want a file blip whenever you change the link value in the
master record. A new master record is also created. If you have multiple documents associated
with the same master record on the same film, you will have to use page-level indexing.

n For three-level film, it assumes that you want a batch blip whenever you change the link value in
the master record and a file blip every time the first field in the document record changes. A new
master is created when the batch blip changes and a new document record is created when the
file blip changes.

} To start an index

1. From the File menu, select Open Database.

2. Select the database you want to index from the Open dialog box. The main database screen will
appear.

3. From the Index menu, select Index at Camera. The New Roll dialog box will appear.

4. Enter the number of the roll you are indexing in the text box and click .

• If you are indexing one- or two-level film, the New Frame dialog box will appear.

• If you are indexing three-level film, a message will appear asking you if you want to index
batch blips only. Select  and the New Frame dialog will appear.

5. In the New Frame dialog box, enter the number of the frame you want to start with:

• For single-level indexing, enter a whole number.

• For two-level indexing, enter the number of the large blip you are starting with, followed by .0.

• For three-level indexing, enter the number of the batch blip, followed by a period and the
number of the frame blip, followed by .0 (1.21.0).

6. Click . If you have not yet set your indexing options for this database, the Indexing Setup
dialog (see Chapter 16) will appear. Change the defaults if you want and click .

Note: After you have indexed a database once, the last roll and frame you indexed will always be
displayed for you in the New Roll and New Frame dialogs so that you can continue from where you
left off by merely clicking .



158      VersaImage/VersaCAR/VersaView User’s Guide

Single-level film

For single-level indexing, a blip will be added to the frame when the film is shot. You determine
with each frame whether the frame belongs to a new master record or a new document.

} To index each frame as you shoot

1. Position the first document on the camera.

2. Enter the link field and press Tab  or Enter .

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

3. Enter the data for the index record in the document record field.

4. Click  or press F8 . The frame will be shot and the film will advance. Position the next
document on the camera:

• If the next document is a page of the document you just indexed, click  or press Enter

without changing any data to shoot the next frame.

• If the next document belongs to the same master record but is a different document, return to
step 3 and enter the data for the document.

• If the next document belongs to a new master record, return to step 2 and enter the link field
for the new record.

Two-level indexing

When you do two-level indexing at the camera, the link field in the master record is the “key” for
the file blip. When the value in this field changes, the system will assume that it is the beginning of
a new group and add a large blip to the frame.

With two-level film, you can also enter index records for any of the page blips. Therefore, if there
is more than one document associated with the master record, you can create an index record for the
first page of each.

} To shoot the first frame for a master record

1. Position the document on the camera.

2. Enter the link field and press Tab  or Enter . The link field must be different from the last one to
create a new master record and a file blip:

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

3. Enter the index information for the document in the document record fields.

4. Click  to shoot the frame and advance the film.

} To shoot each of the remaining documents for the master record

1. Position the document on the camera.

2. Decide whether you want to create a record for the frame:

• If the page is part of the same document, do not change anything. Leave the record fields
alone.

• If the page is part of a different document, change the information in the document record.

3. Click  to shoot the frame and advance the film.
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Three-level indexing

When you do three-level indexing at the camera, the program assumes that the link field the key for
the batch blip and the first field in the document record is the key for the file blip. When the link
field changes, a batch blip will be added to the film. When the first field in the document record
changes, a file blip will be added. A record will be added to your database for each batch and each
file blip. The batch blip signals a new master record and the file blip signals a new document
record. You can also do page-level indexing with three-level film, but unless you have sub-
documents that need their own index records, you will probably not need to do so.

} To shoot the first document in the batch (batch blip)

1. Position the first document for the master record on the camera.

2. Enter the link field and press Tab  or Enter . The link field must be different from the last one to
create a new master record and a batch blip:

• If there is already a master record for this link field, it will be displayed.

• If no record is displayed, enter the data for the new record in the master record fields.

3. Enter the index information for the document in the document record fields.

4. Click  to shoot the frame and advance the film.

} To shoot the first document page for a file (file blip)

1. Position the document for the subgroup on the camera.

2. Enter the index information for the record. The value in the first field of the document record
must be different to be recognized as a file blip. Do not change the value in the link field.

3. Click  to shoot the frame and advance the film.

} To shoot the remaining pages for a document

1. Position the document on the camera.

2. Decide whether the page needs its own record:

• If you do not want to create an index record for the frame (the usual case), do not change any-
thing. Leave the record fields alone.

• If you want to create an index record for the frame (the exception), modify the record as
needed. DO NOT CHANGE THE FIRST VALUE IN THE DOCUMENT RECORD OR THE
LINK FIELD!

3. Click  to shoot the frame and advance the film.

Indexing Images in a Master Reference Database

Before you can index your images, you must select the database to be indexed and the batch of
images you want to index. Images scanned from paper will be in folders beginning with BCH.
Images scanned from film will be in folders starting with ROLL.

} To start indexing images

1. Select Open Database from the File menu.

2. Select the database you want to index from the Open dialog box. The main database screen will
appear.
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3. Select Index Images from the Index menu. The Setup Image Indexing dialog box will appear.
All batches with non-indexed records for the database will be listed in the box.

4. Select the roll or batch you want to index and click .

5. If you have not yet set your indexing options for this database, the Indexing Setup dialog (see
Chapter 16) will appear. Change the defaults if you want and click .

Zooming in on data locations with master reference databases

You can use the zoom feature (see Chapter 19) to zoom in on data in your images while indexing a
master reference database. However, if your documents are of different types or you are not always
entering master record data, you may find it a little awkward. Here are some tips:

n You can always add new data locations for fields you have not previously indexed and
VersaImage will remember them. Therefore, if your first several documents are indexed to
existing master records and then you encounter one without a master record, you can define the
data locations for master record fields at that time.

n You can always change a location. If the defined data location is in a different place on a
document, you can redefine it.

} To redefine a “zoom” zone

1. Click your right mouse button on the document to zoom out to full screen.

2. Draw a box around the current location for the data. VersaImage will now remember this as the
location until you change it again.

If you are indexing different types of documents and your data is readable without it, it may be
easier not to use the zoom feature, especially if you have to change the zones a lot.

Indexing single-page images

When you index single pages, you can decide whether to associate each image with a new master
record or a new document.

} To index the first document in the batch

1. Zoom in on the area of the image where the link field for the document is located. Then enter the
link field and press Tab  or Enter :

• If there is no matching record, enter both the master record information and the document
record information as described in step 2.

• If a matching record is displayed for the link field, the master record is already in the
database. Enter data in the document index record fields only as described in step 2.

2. Enter your record fields. If you want to zoom into data locations do the following:

• Move the cursor to the database field.

• Select the area of the image that contains the data you need for the record and release the
mouse button to zoom in.

• Enter the data in the field and press Tab  or Enter  to move to the next field. The image will
return to normal display size so you can select the area for the next field.

3. Click  or press F8 . The next image will be displayed and the program will zoom in on the
data for the link field.
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} To append an image to the previous document

1. Press F12  to add the page to the previous record. This will either create a folder for the index
record or add the page to the existing folder.

2. The next image in the batch will appear.

} To add a new document to the same master record

1. Do not change the master record.

2. Enter the data for the fields in the document record. If you defined data locations on your image,
VersaImage will zoom in on the data as you move from field to field.

3. Click  or press F8 . The next image will be displayed and the program will zoom in on the
data for the link field.

} To add a new document to a different master record

1. Enter the link field and press Tab  or Enter .

• If the master record is already in the database, it will be displayed.

• If the record is not displayed, enter the master record fields for the record. If you defined
your data locations, the system will zoom in on the data for each field in the document.

Note: If you have not defined master record data locations yet and you want to do so, you may do so
now.

2. Enter the data for the fields in the document record. If you set up data location zoom zones, the
program will zoom in on the data for each field.

3. Click  or press F8 . The next image will be displayed and the program will zoom in on the
data for the link field.

Indexing folders and multi-page TIFFs

When you index folders or multi-page TIFFs with a master reference database, the general assump-
tion is that each folder represents a document. The program assumes that the information you need
for your record is in the first image. For that reason, it displays the first image as a full page with
the blank record. If you need to look at another page instead, you can zoom out and select it from
the thumbnails.

} To index the first folder or file in the batch

1. Enter the link field and press Tab  or Enter :

• If there is no matching record, enter both the master record information and the document
record information as described in step 2.

• If a matching record is displayed for the link field, the master record is already in the
database. Enter data in the document index record fields only as described in step 2.

2. Enter your record fields. If you want to zoom in on your data locations, do the following:

• Move the cursor to the screen field.

• If the image that contains the information for the field is not the one displayed, zoom out to
thumbnail view and select the correct image from the thumbnails.

• Select the area of the image where the data for the field is located and release the mouse
button to zoom in.
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• Enter the data in the field and press Tab  or Enter  to move to the next field. The image will
return to normal display size so you can select the area for the next field.

3. Click  or press F8 . The next image will be displayed and the program will zoom in on the
data for the link field.

} To add a folder or file to the same master record

1. Do not change the master record.

2. Enter the data for the fields in the document record. If you defined data locations for the
document, VersaImage will zoom in on the location of the data for the active field in the current
image. If the current image does not contain the data, zoom out, select the correct image, and
zoom in again.

3. Click  or press F8 . The next image will be displayed and the program will zoom in on the
data for the link field.

} To add a folder or file to a different master record

1. Enter the link field and press Tab  or Enter .

• If the master record is already in the database, it will be displayed.

• If the record is not displayed, enter the master record fields for the record. As you move the
cursor to each one, the system will zoom in on the data for the field in the current image. If
the document displayed does not contain the data, zoom out and select the correct one.

Note: If you have not defined master record data locations yet and you want to do so, you may do so
now as you enter the master record.

2. Enter the data for the fields in the document record. If you have defined data locations,
VersaImage will zoom in on the data for the active field in the current image. If the document
displayed does not contain the data, zoom out and select the correct one.

3. Click  or press F8 . The next image will be displayed and the program will zoom in on the
data for the link field.
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23 Searching
Your Database

Once your documents are indexed, you can retrieve and view any document you want easily. If the
record is on microfilm, you simply find the record in your database and the reader will find the
corresponding frame. If there is a scanned image associated with a record, the system will display
your image on the right side of the screen. If you have scanned images for your film, you can view
your documents without having to go to microfilm. In addition to viewing your documents, you may
print, fax, E-mail and, in some cases, export them to another file.

Regardless of whether you have indexed film or scanned images or both, your first step in viewing
your documents is to find the record associated with the document in your database. This chapter
tells you how to search for and find your records. The remaining chapters in this section give you
instructions for viewing your documents and distributing copies of them.

The Screens

When you search for your records, you will use two different screens—the search screen and the
table display screen. Because you need to be acquainted with both of them before you start your
search, we will give you an overview of them now.

The search screen

The search screen (fig. 23.1) is the main database screen. It is the first screen that is displayed when
you open a database. If you have set up a database or indexed records, you are already somewhat
familiar with this screen. The search screen contains fields for all of the data in your database record.
Under the menu is a tool bar. The buttons in the tool bar vary, depending on what is displayed on the
screen. These functions will be explained in the instructions in this chapter and the chapters that
follow. A drop-down list on the tool bar contains your text search options. If your database is image
enabled, a tool bar with drawing tools will also appear. These tools allow you to add visual annotations
to your image. More will be said about these tools in Chapter 26.

23

Fig. 23.1. Database search screen
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The search screen is used to define your search and to display individual records. Users with
security clearance to do so can also edit fields in the records.

To move from field to field on the search screen, use the following keys:

Tab Moves to the next field.

Shift  + Tab Backs up to the previous field.

You can also go directly to a field by clicking on it with your mouse. However, this is not generally
convenient if you are using the keyboard to enter values.

Note: Unlike the indexing screen, you cannot use Enter  to move from field to field. Enter  activates
your search.

The table display screen

The table display screen (fig. 23.2) displays your records in table format. It is displayed after you
initiate a search if there is more than one matching record. You can also display it anytime from the
search screen while you are viewing records.

The following buttons on your tool bar are used to switch between the two screens:

Switches to the table screen display from the search screen.

Switches to the search screen display from the table screen.

Note: If you want to see this screen now, click the  button from the search screen. Then click
 when you are asked if you wish to see the entire database.

If your list covers more than one page, you can do the following to move through it:

Fig. 23.2. Table-display mode
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• Press PgDn  to display the next page.

• Press PgUp  to display the previous page.

• Use the scroll box or arrows on the vertical scroll bar.

Most database records will not fit horizontally on one screen. You will be able to see the start of the
record but not the end of it. To scroll through a record horizontally, use the horizontal scroll bar.

The size of the table cells is arbitrary and not all of the data in a given cell may show. You can
adjust the width of the cells if you want by dragging the vertical bars in the table heading with your
mouse:

Setting Up a Search

You may search the database on virtually any field in your record. How you define your search
depends on whether or not a field is an alphanumeric, numeric or date field.

Alphanumeric fields

For alphanumeric fields, you have three options, all of which are displayed in the drop-down list in
your tool bar:

Exact Searches for records with the exact value you enter in the field.

Starts with Searches for records with values in the field that start with the text you enter.

Contains Searches for records that contain the value you enter in your search field.

These options are also available from the Search menu. This allows you to use the keyboard instead
of your mouse if you prefer not to take your hands off your keys while you are searching.

Note: The alphanumeric search also works for Roll and Blip fields. However, keep in mind that
searching for “text contains” can yield unpredictable results. For example, if you select “text
contains” and enter a 2 to find roll 2, you will get all rolls that have 2 in their number.

} To start an alphanumeric search with your mouse

1. Select the type of search you want from the drop-down list.

2. Either click your mouse in the field you want to search or use Tab  to move to the field.

3. Enter your search value.

4. Click  and the system will search the database for records that match your search value.

5. The number of “hits” will be displayed in the “hit” bar at the bottom of your screen:

• If there is only one hit, the record will be displayed on the search screen (see fig. 23.3).

• If there is more than one hit, the table display screen will be displayed so you can select the
record you want to view.

Drag this bar to adjust the
size of the cell



168      VersaImage/VersaCAR/VersaView User’s Guide

} To start an alphanumeric search with your keyboard

1. Press Alt  and then S  to select Search from the menu. The Search
menu (fig. 23.4) will appear.

2. Do one of the following to select your search type:

• Type the underlined letter.

• Use the ##  and $$  keys to move the highlight to the search type and
press Enter .

3. Use Tab  to move to the field you want to search on and enter your
search value.

4. Press Enter  to start your search.

Numeric and date fields

Numeric and date fields do not allow “text” searches. They will match on exact values only.
However, you may notice that, for each of these field types, there are two text boxes instead of one.
This permits you to enter a range—a range of dates or a range of numeric values—as search
parameters. Numeric field search values must contain numeric characters only. Date field search
values must be valid dates entered and must be entered in month/day/year order. Either of the
following formats are valid:

n MM/DD/YY format

12/25/95

Enter the month, day, and year numerically, separated by slashes. You do not need to enter
leading zeros for single-digit months or days. 10/21/95, 9/8/95, and 11/2/93 are all valid entries.

Fig. 23.3. Search screen with a record displayed

Fig. 23.4. Search menu

Number of Hits
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n Month Day Year format

Jan 25 1994

Enter at least the first three characters of the month, followed by the date and then the year. Do
not use periods or commas. Either a two-digit or four-digit year is acceptable—Sep 2 1993 and
Sep 2 93 are both legal. If no year is entered, the current year is assumed.

Note: If you want to use four-digit years you must configure your system in Regional Settings on the
Windows Control Panel for four-digit years.

} To set up a numeric or date search

1. Use Tab  to move your cursor to the field you want to search on or click on it with your mouse.

2. Enter your search values:

• To search for an exact value, enter the value you want to search for in the first text box.

• To search for a range of values, enter the starting value for your range in the first box. Then
press Tab  to move to the second box and enter the ending value for your range. Make sure
that your ending value is greater than your starting value.

3. Click  or press Enter  to start your search.

4. The number of hits will be displayed in the bottom of the screen:

• If there is only one record, it will be displayed in the fields on the screen.

• If there is more than one hit, the table display screen will be displayed so you can select the
record you want to view.

Searching on more than one field

You can use more than one field to narrow the set of records down if you want. For example, you
might search for all invoices for a company that fall within a specific date range by entering both the
company name and the date range. There are two things to keep in mind, however:

n All values you search for must be present in the record, so do not use fields that are mutually
exclusive.

n The type of alphanumeric search you choose is in effect for all alphanumeric fields. You cannot
search for “exact text” in one field and “text contains” in another. For searching in multiple
fields, it is best to use “text contains” unless you are using roll or frame numbers as part of your
search.

} To search on multiple fields

1. If you are searching any alphanumeric fields, select your type of search from the drop-down list
box.

2. Enter the values for your search in each field you want to search on. Use Tab  to move from
field to field.

3. Click  or press Enter .

4. The number of hits will be displayed in the bottom of the screen:

• If there is only one record, it will be displayed in the fields on the screen.

• If there is more than one hit, the table display screen will be displayed so you can select the
record you want to view.
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Displaying your entire database

If you prefer, you can display all of your database records sequentially instead of a selected subset.

} To display your entire database

1. Click on  without entering any search para-
meters.

2. A message (fig. 23.5) will appear asking you if you
want to select the entire database.

3. Click . The table display screen will appear.

Note: This will work only on databases with less than 32,000 items.

Looking at the Records

You can look at your records in either single-record mode and table-display mode. If there is only
one record on your hit list, you will be placed in single-record mode automatically. If there is more
than one, you will be placed in table-display mode. Regardless of mode, the number of hits will be
displayed in the “hit bar” at the bottom of the screen:

If you have indexed in Lookup/Append Mode, you will already be familiar with the hit bar.

Using table-display mode

The main purpose of table-display mode is to allow you to quickly locate the record you want to
look at or start with. You can then switch to single-record mode and return to the search screen to
view it. If your record is not visible in the table, you can find it either by scrolling or by using the
Find function. The Find function allows you to search for an exact text match for any field in the
record.

} To select a record with your mouse

1. Move your mouse pointer to the record you want to view.

2. Double-click on the record to view the search screen.

} To select a record with your keyboard

1. Use the arrow keys to move the highlight to the record you want:
$$  or "" Moves down to the next record.
##  or !! Moves up to the previous record.

Home Moves to the first record.

End Moves to the last record.

PgDn Moves to the next “page” of records.

PgUp  Moves to the previous “page” of records.

2. When the record you want to see is highlighted, press Enter  to view the search screen.

Fig. 23.5. Selecting the entire database

Displays previous
record

Displays next record

Displays last record in
the hit list

Displays first record in
the hit list
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} To scroll through the records with your mouse

1. Move the highlight by doing one of the following:

• To move the highlight down to the next record, click  at the end of the vertical scroll bar or
 on the hit bar.

• To move the highlight up to the previous record, click  at the top of the vertical scroll bar
or  on the hit bar.

• To scroll continuously, move your mouse pointer to either  or  on the vertical scroll bar.
Hold your mouse button down and the records will scroll in the direction of the arrow.

• To scroll to the last record in the list, click  in the hit bar.

• To scroll to the first record in the list, click  in the hit bar.

2. When the highlight is on the record you want, do either of the following to display the search
screen:

• Double-click your mouse on the record.

• Click  on the tool bar.

} To use the Find function

1. Do one of the following to display the Hitlist Search dialog:

• Select Find First from the Search menu.

• Press Ctrl  + F .

2. Enter the text you want to search for. The text can be in any field but it must be an exact match
for the data in the field.

3. Click  and the program will find the first instance of that record.

4. To look for the next instance, select Find Next from the Search menu.

5. When you find the record you want, do one of the following to display the search screen:

• Double-click your mouse on the record.

• Click  on the tool bar.

• Press Enter .

Single-record mode

In single-record mode, each record is displayed on the search screen in turn. You can display your
records with either the mouse or the keyboard. If an image is associated with the record, it will
appear on the right.

} To display single records sequentially with your mouse

1. When the table display appears for your search, click  on the tool bar to switch to single-
record mode and display the first record. (If you do not want to start with the first record, select
the record you want to start with first.)

2. Use the buttons on the hit list to browse through the individual records:

Displays the next record.

Displays the previous record.

 Displays the last record.

 Displays the first record.
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} To display single records sequentially with the keyboard

1. When the table display appears for your search, press Enter  to display the first record in single-
record mode. (If you do not want to start with the first record, select the record you want to start
with first.)

2. Use the following keyboard keys to browse through the individual records:

"" Displays the next record.

!! Displays the previous record.

End Displays the last record in the hit list.

Home Displays the first record in the hit list.

Changing sort sequence

By default your hit list will be sorted on the field you searched on in ascending order. If you select
the entire database, the records will be sorted in the order in which they were entered into the
database. If you want, you can retrieve your “hits” sorted in a sequence different from the default
sort sequence. This can be particularly useful when viewing the table display. For instance, when
you retrieve invoices for a particular company, you might want to view them in descending date
sequence so you could find the most recent invoice first. By changing the primary sort field to
“invoice date” you could view them in your table in this order.

} To change the sort sequence

1. Select Preferences from the File menu.

2. Select Sort Sequence from the Preferences menu. The dialog box shown in fig. 23.6 will
appear.

3. Select the field you want as your primary sort sequence.

4. Select the sort order:

Ascending Sorts from lowest to highest.

Desending Sorts from highest to lowest.

5. To sort all hits within the Primary Sort field in a specific order, select a Secondary Sort field
and sort order.

6. To sort any identical fields for your Secondary Sort field in a specific order, select a Tertiary
Sort field and sort order.

7. When you are done, click .

Note: Since the sorting is done as the hit list is extracted from the database, you must select your
sort order before you initiate your search. If you have already searched, you will have to perform
the search again to have your currently displayed hit list re-sorted into the new sequence.

Fig. 23.6. Display Sort Sequence dialog
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Ending a search

After you have finished viewing the records for a search, you will need to “clear” the current search
before you can start another.

} To clear a search with your mouse

Click  at the bottom of the screen.

} To clear a search with the keyboard

Press Esc .

Searching a Master Reference Database

When you search a master reference database, you first look for the master record. Then you select
the documents you want to view.

Searching for the master record

In most cases, you will be searching for a specific record, such as a specific loan application, or a
specific group of records (e.g., all accounts tied to a given social security number). You can also
search the database on fields in the document record. This search will return all master records
containing documents that meet the criteria you specify. You might, for example, want to search for
master records containing verification of employment forms for a given date.

} To search for the master record on master record criteria

1. Enter the value you want to search for in the master record.

2. Click .

3. If there is more than one hit, select the one you want to see from the table display screen.

4. Your selected master record and a table display of the documents associated with the record (fig.
23.7) will appear.

Fig. 23.7. Search screen for a master reference database with the master record and the table of associated
documents
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5. If there is more than one matching master record, you can use the buttons in the hit bar to page
through them in single record mode.

} To search for master records on document criteria

1. Enter the document criteria you want to search for in the document record.

2. Click  to find all master records containing documents with the criteria you specified.

3. To display the first master record in the list, click . If you want to start with another record,
select the one you want to from the table.

4. The record and a table display of the documents associated with the record (fig. 23.7) will
appear. Note that it will list all documents associated with the record, not just the one you were
looking for.

Displaying document records

To look at an individual document record, you must select it from the document table in the master
record.

} To display a document for the record

1. Double-click on the document you want to see in the table.

2. The information for the document will be displayed on your screen (fig. 23.8). If an image is
associated with the document record, it will be displayed on the screen also.

3. To select another document for the master record, click . You will return to master record
view and the table of documents so you can select another.

Note: You cannot use the hit bar to browse through your documents sequentially.

Fig. 23.8. Document selected and displayed for a master record
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Browsing through master records

You can browse through your master records in single-record mode or you can return to table-
display mode. When you browse in single-record mode, you must be in master record view. It does
not work if you have a document displayed.

} To view another master record in single-record mode

1. Click  to return to the master record view.

2. Use the hit bar to page through the master records until you find the one you want.

} To select another master record in table-display mode

1. Click the  in the tool bar from any screen (either document or master record view).

2. Select the master record from the table.

Ending the search

When you end a search for a master reference database, you must first return to the master record
view. Then you can exit.

} To end your search

1. Click  to clear the currently displayed document.

2. Click  again to clear the master record.

Printing Your Hit List

If you want a hard copy, you can print your hit list on your laser or inkjet printer. You can print the
hit list in either table format or single-record format. In table format, there is one record per line
(fig. 23.9). In single-record format, each record is listed with one field per line (fig. 23.10).

Fig. 23.9. Printed hit list - table format

Fig. 23.10. Printed hit list - record format
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When you print your hit list, you can print all fields in the record or you can select the fields you
want to print. You may also select the print order for your fields. If your database is image enabled,
you may elect to print data records, images, or both.

Note: If you are printing hits for a master reference database and choose to print document fields,
all documents associated with the master record will be listed. This is a good way to get a “report”
of associated documents for a group of master records.

} To print your hit list

1. Click  on the tool bar (the one with the blue printer) or select Print Hitlist from the File
menu.

2. If your database is image enabled, you will see the following messages:

• Print data records?

If you want to print the data records for your hit list.

If you do not want to print data records for your hit list.

• Print images?

If you want to print the images for your hit list.

If you do not want to print images for your hit list.

3. Unless you are printing images only, the Print Hitlist Setup dialog (fig. 23.11) will appear.

4. Select the fields you want to print by enabling and disabling the check boxes to the right of the
fields. By default, all fields are enabled.

5. To change the order of the fields, drag the fields into the order you want. To restore the original
order, click .

6. Select the Report Style:

• To print a table-style format (fig. 23.9), choose to print one line Per Record.

• To print a single-record format (fig. 23.10), choose to print one line Per Field.

7. Select your page orientation:

• Landscape is generally best for table-style format (unless you have very few fields).

• Portrait is generally best for single-record format.

8. Click  to print your report.

Fig. 23.11. Print Hitlist Setup dialog
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Editing your Records

If you have security clearance to do so, you can edit the fields in your records from the search
screen. This is particularly useful if you need to change the occasional field in a record to correct an
address, spelling, date, etc. Note that Roll and Frame fields can only be changed through QC Film
Indices and Image Addresses cannot be changed at all. For global changes, frame adjustments,
etc., you should use the QC Film Indices option (see Chapter 29) instead. For correcting image
indexing problems, you should use the Image QC option.

} To edit records from the search screen

1. Display the record you want to edit in single-record mode.

2. Press  to enable editing.

3. Use Tab  to move to the field or fields you want to edit and make your changes.

4. When you finish, click  or press Enter  the changes will be made.

What To Do Next

Now that you know how to use your database search screen, you can view and print your images:

n For instructions on viewing and printing microfilm documents, go to Chapter 24.

n For instructions on viewing and printing images, go to Chapter 25

n For instructions on making and filling requests from request-enabled workstations, go to Chapter
27.

n If you want to view multiple databases at once and do not know how to use this feature in
Windows programs, go to Chapter 28.
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24 Viewing and Printing
Microfilm Documents

After you find a record in your database, you can retrieve the corresponding document on your
microfilm reader. Depending on your system’s capabilities and available equipment, you can scan,
print, and/or fax your documents right from your search screen (some options are not available from
VersaCAR).

Note: If you have scanned images associated with your file, the system will display them right on
screen so that you do not have to go to microfilm. Instructions for viewing images are given in
Chapter 25.

The Microfilm Controller

Through VersaImage and VersaCAR, you can retrieve the microfilm frames for the records in your
database on your microfilm reader. To do this, you use the program’s microfilm controller. (This
function is not available in VersaView.)

Activating the controller

} To activate the microfilm controller

1. Do either of the following:

• Press  on the tool bar.

• Click on Display Controller on the Search
menu.

2. The controller will appear on your screen (fig
24.1). A prompt in the controller “window”
will tell you which roll to load for your current
database record. If you have not already done
so, load the film onto your reader.

Note: If you perform a search in VersaImage and there is no Image Address, but there are Roll
and Frame numbers, the controller will automatically be activated.

} To remove the microfilm controller

1. Do one of the following:

• Press  on the tool bar.

• Click on Display Controller in the Search menu.

• Click the  button in the upper right hand corner of the controller window.

2. The controller will disappear from the screen.

24

Fig 24.1. Microfilm Controller
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Operating the controller

The controller looks much like a calculator. Once you activate it, you operate it by “pushing” the
“keys” with your mouse or by pushing the corresponding keys on your keyboard. There are
keyboard equivalents for most controller keys:

Controller Keyboard
0-9 0-9

Enter

Esc

 /

+

 -

P

S

R

The keyboard keys are active for the controller when the controller is the “active window” (i.e., its
title bar is highlighted). To use the arrow keys for your search screen, press Alt  + F6  to make the
search screen the active window. After you press an arrow key to go to the next record, the controller
will become the active window again.

Hint: Another way to use the controller function keys with your keyboard is to tab to the function key
on the controller with the Tab  key and press Enter .

Moving and sizing the controller

You can move the controller around if you want, just like any dialog box. This may be necessary if
it gets in the way of your record. You can also make the box smaller.

} To reduce the size of the controller

1. Position the mouse pointer on one of the corners of the box.

2. Hold your first (left) mouse button down and move the pointer toward the center to make the
frame smaller.

3. Release the button and the controller will turn into a “credit-card-size” box.

} To restore the controller to normal size

1. Drag the frame outward until it is quite large.

2. Release the button and the controller will reappear in its original size.

Using the Controller to Retrieve Documents

The method you use to retrieve documents with the controller depends on how your database is
indexed.

Single-level indexes with one record per frame

If your database has single-level indexing, you will notice that the frame (blip) number for the
record will appear in the window of the controller as you “page” through your database records.
You can use the controller “keys” to retrieve a record from film.
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} To search with your mouse

1. Search through your database records by clicking on the buttons in the hit bar until you find the
record you want. Each time you click, the record frame number will appear in the controller
window.

2. Click  on the controller. “Searching . . .” will be displayed in the window and the reader
will move to the frame. When it finds the frame, the frame number will reappear in the
controller window. It will also be displayed in the status bar at the bottom of the screen.

} To search with the keyboard

1. Use the ""  key to “page” to the next record.

2. The frame number will appear in the controller window. If this is not the record you want, press
Alt  + F6  to leave the controller window. Then press ""  to move to the next record.

3. When you find the record you want, press Enter . “Searching . . .” will be displayed in the
window and the reader will move to the frame. When it finds the frame, the frame number will
reappear in the controller window. It will also be displayed in the status bar at the bottom of the
screen.

Multi-level indexes

If you have a two- or three-level index or a single-level index with logical subgroups, you search for
the indexed record. Then you page through the associated frames in your group with the controller.

} To search with your mouse

1. Search through your index records by clicking  in the hit bar until you find the record for the
subgroup.

2. Click  on the controller to position the reader on that frame.

3. Use the  key on the controller to advance the film to the next frame. As you advance, the
frame number will be displayed.

4. Continue using  to advance and  to back up until you find the record you want.

Fig 24.2. Search screen with microfilm controller displayed
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} To search with the keyboard

1. Use the ""  key to “page” to the next record.

2. The frame number will appear in the controller window. If this is not the record you want, press
Alt  + F6  to leave the controller window. Then press ""  to move to the next record.

3. When you find the record you want, press Enter .

4. After the film is positioned on the frame for the record, use +  and  -  on the keyboard to search
for the frame:

+ Moves forward one frame.

 - Moves backward.

Requesting a specific frame

You can look at a frame other than the one associated with your record if you wish.

} To request a specific frame with the mouse

1. Click  on the controller to clear the controller display.

2. Use the controller keys to enter the frame number.

3. Click  on the controller.

} To request a specific frame with the keyboard

1. Press Esc  to clear the controller.

2. Use either the numeric keypad or the number keys on the keyboard to enter the frame number.
The number will appear in the controller window.

3. Press Enter .

Scanning Documents

If you have a microfilm scanner, you can use the controller “keys” to scan a frame you have
retrieved. You can scan a single frame or a sequence of frames. The scanned images will be saved
in your database.

Note: If your database is not image-enabled, you will need to enable it before you can scan.

} To scan a single frame with your mouse

1. Locate the record you want in the database and retrieve its frame on microfilm.

2. Click  to scan the image. The scanned image will be displayed on your screen on the right.

} To scan a single frame with the keyboard

1. Locate the record you want in the database and retrieve its frame on microfilm.

2. Click S . The scanned image will be displayed on your screen on the right.

} To scan a sequence of frames with your mouse

1. Click  to clear the window.

2. Use the controller “keys” to enter the starting frame number.
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3. Click . Then enter the ending frame number.

4. Click  to scan the frames.

} To scan a sequence of frames with the keyboard

1. Press Esc  to clear the controller.

2. Use the numeric keypad or number keys to enter your starting frame number. The number will
appear in the controller window.

3. Enter a forward slash (/). Then enter the ending frame number.

4. Press S  to scan.

Printing Documents

If you can print from your reader, you can use the controller “keys” to print a frame you have
retrieved. If you have VersaImage and have a microfilm scanner, you have the following additional
output options:

n Scanning the document and printing it on your laser or inkjet printer.

n Scanning the document and faxing it through your fax software.

n Scanning the document and E-mailing it through your E-mail software.

Regardless of the output option, you can print either a single frame or a sequence of frames.

When you scan, you can apply background image correction to your document. If you choose to do
so, check to make sure your correction options are set appropriately before you scan. You can
access the Correction Options from Image Correction on the Tools menu. For more information
on image correction, refer to Chapter 11.

Caution: Enabling or disabling image correction when you print from the controller does not use or
affect your current setting on the Scan menu. It is only in effect for this function. However, it uses
whatever correction options are in effect at the time. These changes will remain in effect after you
exit this function.

Note: The Scan and Print, Scan and Fax, and Scan and E-Mail functions do NOT save the
images onto your hard drive. To do this, use the Scan function on the controller.

} To print a single frame

1. Locate the record you want in the database and retrieve
its frame on microfilm.

2. Click  or press P  to print the document. The
How to Print dialog box (fig 24.3) will appear so
you can select your print option.

3. Select your print option.

4. If you want to apply background image correction, en-
able Use Image Correction.

5. Click  or press Enter .
Fig 24.3. How to Print dialog box
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} To print a sequence of frames with your mouse

1. Click  on the controller to clear the controller window.

2. Use the controller “keys” to enter the starting frame number.

3. Click . Then enter the ending frame number.

4. Click  to print the frames. The How to Print dialog box (fig 24.3) will appear so you can
select your print option.

5. Select your print option.

6. If you want to apply background image correction, enable Use Image Correction.

7. Click  to print your documents.

} To print a sequence of frames with the keyboard keys

1. Press Esc  to clear the window.

2. Use the numeric keypad to enter the starting frame number. The number will appear in the
controller window.

3. Enter a forward slash (/). Then enter your ending frame number.

4. Press P . The How to Print dialog box (fig 24.3) will be displayed so you can select your print
options.

5. Select your print option.

6. If you want to apply background image correction, enable Use Image Correction.

7. Click  to print your documents.

Other Controller Operations

In addition to retrieving frames, you can use the controller keyboard to reset your position and
rewind the film. These functions allow you to operate the reader almost completely from your
search screen.

Rewinding

After you finish with a roll, you can use the controller to rewind it directly from your computer
screen.

} To rewind your film

1. To start rewinding your film, press  on the controller or R  on the keyboard.

2. To stop the rewind, click  on the controller.

Caution:  does not work with all readers.

Resetting the microfilm frame position

If you notice that the number of the frame on your microfilm does not agree with the number
displayed on the screen, you can reset on the controller so that it will be “in sync” with your data
records:
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} To reset the frame position

1. Enter the correct number for the frame in the controller window.

2. Click  and the frame number will be reset.
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25 Viewing and
Printing Images

When you search an image-enabled database, the scanned images will be displayed with your
records. You can zoom in on them, print them on your laser printer, send them to your fax machine,
or E-mail them. The distribution folder option permits you to collect documents from a number of
different records in different databases prior to printing.

Zooming in on Images

The zoom feature allows you to get a close-up view of any portion of your document.

Records with single images

If a record has a single image associated with it, the image will be displayed as a full page next to
the record (fig. 25.1).

} To zoom in on the image

1. Hold your left mouse button down and draw a “box” around the area you want to zoom in on.

2. Release the mouse button to zoom in on the area.

3. When you zoom into an image, horizontal and vertical scroll bars will appear by the image (fig.
25.2). You will be able to move up and down and left and right to see other parts of the zoomed
image.

4. To zoom in further, draw a box around the place you want to zoom in on.

5. To restore the image to normal size, press your right mouse button.

25

Fig. 25.1. Database record with single scanned image on right
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Records with multiple images

Documents for images in folder files and multi-page TIFF files appear in “thumbnails” next to the
record (fig. 25.3).

} To view multi-page documents

1. To view an individual image, move the pointer to the image and click your left mouse button.

2. To zoom in further:

• Hold your left mouse button down and draw a box around the area you want to zoom in on.

• Release the mouse button to zoom in on the area.

Fig. 25.2. Database record with zoomed image. Note the scroll bars.

Fig. 25.3. Database “folder” record with thumbnails of scanned images
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3. When you zoom into an image, horizontal and vertical scroll bars will appear by the image. You
will be able to move up and down and left and right to see other parts of the zoomed image.

4. To zoom in further, draw a box around the place you want to zoom in on.

5. To restore the image to normal size, click the right mouse button. To return it to thumbnail size,
click the right mouse button again.

Other Viewing Adjustments

In addition to zooming in, there are some other viewing adjustments you can make.

Full screen mode

For a better view of your document, you can switch your display to full screen mode.

} To activate full screen mode

Do either of the following:

• Click anywhere on your document with the left mouse button.

• Click the  button on the tool bar.

} To return to window mode

Do either of the following:

• Click anywhere on your document with either mouse button.

• Click the  button on the tool bar.

Rotating and deskewing your image

If an image was scanned in the wrong orientation, you can rotate or deskew it for easier reading.
These functions do not change the image orientation permanently, only so you can view it. To
change the image permanently, use Image QC.

} To rotate an image

1. Do either of the following:

• Click  on the tool bar.

• Press F11 .

2. The image will rotate 90° to the right.

3. Continue clicking  or pressing F11  until the image is in the correct orientation. Each time
you click, the image will rotate 90°.

} To deskew an image

1. Do either of the following:

• Click  on the tool bar.

• Press F10 .

2. The image will be deskewed.

Scanning Images

If you have the security clearance to do so, you can add images to folders or records with your
scanner. You can also rescan badly scanned images. When you rescan an image, it replaces the
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image you have selected. When you scan an image, it adds the image to the record. If there is a
folder file associated with the record, it adds the document to the end of file. A special Scan and
Insert function allows you to scan a page and insert it into a specific place in the file. The single-
page scanning options allow you to add images scanned from paper to folders of images that were
scanned from film and add images to folders or records at a later date.

} To rescan an image

1. Make sure the page you want to replace is displayed on the screen.

2. Place the page you want to scan in the scanner.

3. Either select Rescan from the Scan menu or press F6 . The page will be scanned and replace the
currently displayed page in your database.

} To scan and add an image

1. Place the page you want to scan in the scanner.

2. Either select Scan Single from the Scan menu or press F5  to scan the page:

• If there was no previous image associated with the record, VersaImage places the file name in
the Image Address field.

• If there was a single image previously associated with the record, VersaImage creates a folder
file and places both images in the folder file.

• If the record has a folder file associated with it, VersaImage adds the new image to the end of
the folder.

} To scan and insert an image

1. Place the page you want to scan in the scanner.

2. Zoom out to thumbnail view.

3. Move your mouse pointer to the image that is in the location where you want to place the
inserted image.

4. Click your right mouse button on the page number label to select the image. The label will be
highlighted to show the image is selected.

5. Either select Scan and Insert from the Scan menu or press F3  to scan the page.

6. The page will be scanned and inserted in front of the selected page.

Correcting Images

You can apply image corrections from your search screen through the Image Correction menu.
These functions use the same correction options that are available for background scanning (see
Chapter 11). If you use background correction as a general rule, you will not have to apply these
options individually. However, there may be images or folders or even batches that require a special
correction procedure. The Image Correction functions allow you to select and apply options that
you would not normally use for background correction (such as lightening text in an image that is so
dark it is not readable) or rotating an entire batch that was scanned upside down.

Warning: If you change the correction options, they will remain in effect for all subsequent scanning
operation, including background correction, until you change them. If you set special options for a
correction and also use background correction, do not forget to reset these options after you finish
correcting your images!
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} To correct an individual image

1. Select the image you want to correct. It should be displayed on the right side of your screen in
full-page mode.

2. Select your correction options as follows:

• Select Image Correction from the Tools menu.

• Select Correction Options from the Image Correction menu. The FixImage Settings dialog
box will appear.

• Select the correction options you want to apply to the image from the box and click .

3. Select Image Correction from the Tools menu. Then select Correct Image.

} To correct all images in a folder

1. Make sure you have the correct folder displayed.

2. Select your correction options as follows:

• Select Image Correction from the Tools menu.

• Select Correction Options from the Image Correction menu. The FixImage Settings dialog
box will appear.

• Select the correction options you want to apply to the image from the box and click .

3. Select Image Correction from the Tools menu. Then select Correct All Images in Folder.

} To correct an entire batch

1. Select your correction options as follows:

• Select Image Correction from the Tools menu.

• Select Correction Options from the Image Correction menu. The FixImage Settings dialog
box will appear.

• Select the correction options you want to apply to the image from the box and click .

2. Select Image Correction from the Tools menu.

3. Select Correct Batch from the Image Correction menu. The Select Batch dialog box (fig.
25.4) will appear.

4. Select the batch you want to correct and click .

Fig. 25.4. Selecting a batch for image correction
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Printing and Faxing

You may have noticed that, when you did your first search on your image-enabled database, three
additional buttons appeared in your tool bar:

Prints the image on your laser or inkjet printer.

Initiates a fax transaction.

Initiates an E-mail transaction.

With these buttons, you can distribute copies of your images directly from the search screen. If your
images are kept in folders or multi-page TIFFs, you can print either single pages or the entire set of
documents. You can also print thumbnails.

Note: To fax and E-mail, you must first set up your fax and E-mail software so VersaImage can
recognize it. Fax setup is found on the File menu. E-mail setup is found on the Preferences menu.
Instructions are given in Chapter 4.

} To print, fax, or E-mail from a single-page record

1. Display the record with the image.

2. Press the button that performs the action you want:

• If you selected the print button, the image will be printed on your printer.

• If you selected the fax button, you will be placed in your fax software so you can complete the
transaction.

• If you selected the E-mail button, you will be placed in your E-mail software so you can
complete the transaction.

} To print, fax, or E-mail a single page from a folder or multi-page TIFF

1. Display the record for the folder on the screen.

2. Click the page you want to print with the left mouse button to display it full size.

3. Press the button that performs the action you want:

• If you selected the print button, the image will be printed on your printer.

• If you selected the fax button, you will be placed in your fax software so you can complete the
transaction.

• If you selected the E-mail button, you will be placed in your E-mail software so you can
complete the transaction.

} To print, fax, or E-mail all pages in a folder or multi-page TIFF

1. Display the record for the folder on the screen.

2. With the thumbnails displayed, press the button that performs the action you want.

3. A message will appear asking you if you want to print thumbnails. Click one of the following:

To print the pages as thumbnails

To print the pages full size
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4. After you respond to the message, the pages will be printed:

• If you selected the print button, the images will be printed on your printer.

• If you selected the fax button, you will be placed in your fax software so you can complete the
transaction.

• If you selected the E-mail button, you will be placed in your E-mail software so you can
complete the transaction.

Distribution Folders

The distribution folder is located at the right side of your screen for all databases that have images.
You can place documents in this folder for printing or faxing. By default, there is one folder called
Folder 1. You may rename this folder and add additional folders. The distribution folders allow you
to search your database and collect documents prior to distribution. They are not attached to a speci-
fic database, so you can pull documents from any number of databases for distribution as a unit.

Using a distribution folder

You can add pages to your distribution folder for any record and delete pages from a folder. A
distribution folder can be viewed or cleared from any image-enabled database, regardless of whether
it contains documents for that database.

} To add pages to the distribution folder

1. Find the record that contains the document you want.

2. If the document is in a folder or is a page in a multi-page TIFF file, select the document:

• To select one page, either click your left mouse button on the page or click your right mouse
button on the page number.

• To select several random pages, hold Ctrl  down and click your right mouse button on the
page number label of the pages you want to select.

• To select consecutive pages, click your right mouse button on the page number label below
the first document you want to select. Then hold Shift  down and click your right mouse
button on the page number label of the last page.

3. Place your mouse pointer on the distribution folder and click your
right mouse button to display the folder menu (fig. 25.5).

4. Click on Add Page to Folder. The selected page (or pages) will be
added and the current contents of the folder displayed.

5. Click  at the bottom of the screen to close the folder.

} To view a folder

1. Place your mouse pointer on the distribution folder.

2. Do one of the following to open the folder:

• Double-click on the folder.

• Click your right mouse button to display the folder menu and select View Folder.

3. The contents of the folder will be displayed in the image area on the right of the screen.

4. To close the folder, click  at the bottom of the screen.

Note: If you are in the middle of a search when you requested a distribution folder, you will be
exited from that search when the distribution folder is displayed.

Fig. 25.5. Folder menu
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} To delete a page from a distribution folder

1. Move your mouse pointer to the distribution folder and click your right mouse button to open the
folder.

2. Select the page you want to delete:

• To select one page, either click your left mouse button on the page or click your right mouse
button on the page number label.

• To select several random pages, hold Ctrl  down and click your right mouse button on the
page number label of each page you want to select.

• To select consecutive pages, click your right mouse button on the first page number label.
Then hold Shift  down and click your right mouse button on the page number label of the last
page.

3. Press Del  on the keyboard.

} To clear the contents of a distribution folder

1. Place your mouse pointer on the distribution folder you want to clear.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Clear (Folder).

Maintaining distribution folders

You may create, delete, and rename your distribution folders as needed. If, for example, you needed
to pull documents for several different recipients, you could name a folder for each. Then you could
search your databases and deposit the needed documents in the appropriate folders. After you no
longer needed the folders, you could delete them or rename them for another recipient.

} To add a new distribution folder

1. Place your mouse pointer on any existing distribution folder.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Add (Folder). The New Folder Name dialog (fig. 25.6) will appear.

4. Type a name for your folder in the box and click . The new folder will appear on the right.

} To rename a distribution folder

1. Place your mouse pointer on the distribution folder you want to rename.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Rename (Folder). The New Folder Name dialog (fig. 25.6) will appear.

4. Type the new name for your folder in the box and click . The name will appear on the
folder on the right.

Fig. 25.6. New Folder Name dialog
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} To delete a folder

1. Place your mouse pointer on the distribution folder you want to delete.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Delete (Folder).

Distributing the contents of a distribution folder

You can output the contents of a distribution folder to a printer, fax modem, or E-mail attachment.
You can also export the documents to a multi-image TIFF file.

} To print the contents of a distribution folder

1. Place your mouse pointer on the distribution folder you want to print.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Print the Folder. The contents of the folder will be sent to your printer.

} To fax the contents of a distribution folder

1. Place your mouse pointer on the distribution folder you want to fax.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Fax the Folder. You will be placed in your fax application so you can complete the
transaction.

} To E-mail the contents of a distribution folder

1. Place your mouse pointer on the distribution folder you want to fax.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on E-mail the Folder. You will be placed in your E-mail application so you can complete
the transaction.

} To export the contents of a distribution folder as a multi-image TIFF

1. Place your mouse pointer on the distribution folder you want to export.

2. Click your right mouse button to display the folder menu (fig. 25.5).

3. Click on Export the Folder. The Save Folder as Multi TIFF dialog box (fig. 25.7) will appear.

4. Navigate to the directory where you want to save your folder.

5. Type the name you want to save the image under in the box and click .

Fig. 25.7. Save Folder as Multi TIFF dialog
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26 Annotating
Images

You can annotate your images with the drawing tools on the annotation tool bar. The drawing tools
allow you to add highlights, masks, shapes, lines, and text to a document. You can also use the note
feature to add and store text notes for your images. Fig. 26.1 shows an example of some of these
features. These annotations overlay the document and can be added and removed without affecting
the image file itself. Therefore, they can be very useful for tracking problems and pending issues.

Adding Graphic Elements

Graphic annotation elements consist of highlights, ellipses, polygons, masks and free-hand lines.
These elements can be used to flag parts of a document you want people to look at and to mask
portions of a document during printing that you do not want people to see (such as confidential or
security-sensitive elements). You may also use them to highlight text annotations (see page 199).

Note: If you select a drawing tool by mistake, click on the  tool on the drawing tool bar to
return the mouse pointer to the default arrow.

Drawing highlights

You can “highlight” portions of the document with the highlighter tool. Highlights have a
transparent yellow fill that allows your text to show through on the display. They also print as
transparent yellow highlights on a color inkjet printer. On most laser printers the highlight will print
a transparent gray highlight. It will not, however, print as transparent on either PostScript printers
or most fax machines. It will appear instead as an opaque layer over the printed copy. Therefore, if
you want to highlight a document that will be printed on either of these devices, be sure not to place
the highlight directly over the text. Put a bar along the side instead.

26

Fig. 26.1. Document with graphic and text annotations added
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} To place a highlight on your document

1. Select the  tool.

2. Drag your mouse to the image. The pointer will change to a highlighter.

3. Position the “point end” of the highlighter at the point where you want to start drawing your
highlight.

4. Press your left mouse button and hold it down.

5. Start dragging your mouse to select the area you want to highlight. A “rubber band” outline will
appear.

6. When all the area you want to highlight is covered, release the mouse button. A yellow highlight
will appear on the image.

Drawing polygons and ellipses

You also draw ellipses or free-form polygons on your documents. Like highlights, these shapes
appear as “transparent solids” that allow your text to show through on the display and also on color
inkjet output. However, because the colors are so dark, they will print as black on black and white
printers, obscuring any text that is underneath. They will also cover the text on any PostScript
printer or fax machine.

} To add an ellipse

1. Select the  tool.

2. Drag your mouse to the image. The pointer will change to an ellipse.

3. Position the + in the pointer at the point where you want to start drawing your ellipse.

4. Press your left mouse button and hold it down.

5. Start dragging your mouse to draw your ellipse. A rectangular “rubber band” outline will
appear.

6. When the outline is the size you want your ellipse to be, release the mouse button. A blue ellipse
will appear on the image.

} To add a polygon

1. Select the  tool.

2. Drag your mouse to the image. The pointer will change to a polygon.

3. Position the + in the pointer at the point where you want to start drawing your polygon and click
your mouse.

4. Move the mouse pointer to the point where you want your first side to end and click. A red line
will appear on your image.

5. Move the pointer to the place where the next side should end and click again. The next line will
appear. Do this to draw all sides except the last one.

6. Double-click your mouse to draw the last side and complete the polygon. A red polygon of the
shape you defined will appear on the image.
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Masks

A mask can be added to any area of an image to mask out parts of the image you don’t want people
to see. Masks are opaque in the display as well as when they are printed. They will be opaque on
any print device.

} To create a mask

1. Select either the  drawing tool or the  tool from the tool bar.

2. Drag your mouse to the image. The pointer will change to a rectangle.

3. Position the + in the pointer at the point where you want to start drawing your mask.

4. Press your left mouse button and hold it down.

5. Start dragging your mouse to draw your mask. A rectangular “rubber band” outline will appear.

6. When the outline is the size you want your mask to be, release the mouse button. A red
rectangular mask will appear on the image.

Free-hand line drawing

You can draw free-hand lines on your image. You can draw arrows to or point out a particular item,
underline an item, or circle an item on the image. Because you can create shapes that are not filled
in, it is a good way to draw attention to items on documents you plan on faxing. The free-hand
drawing tool is a little difficult to manage at first. You will need to practice using your mouse as a
drawing tool in order to develop your skill. (Fortunately, there is an “eraser!” See page 201).

} To draw a free-hand line

1. Select the  tool.

2. Drag your mouse to the image. The pointer will change to a pencil.

3. Position the “point end” of the pencil at the point where you want to start drawing your line.

4. Press your left mouse button and hold it down.

5. Start dragging your mouse to draw your line. The line will appear on the screen as you draw it.

6. When your line is finished, release the mouse button.

Note: If you are drawing an object with multiple lines, you will need to reselect the  tool for
each line you draw.

Adding Text Annotations

You can add text annotations either through the drawing text tool or the note tool. The drawing tool
is good for adding “one-time only” text. The note tool stores the annotation and lets you add stored
annotations as well as new ones. You can also edit stored notes and reapply them. You cannot edit
the annotations you add with the drawing tool.

Hint: If you want to highlight your text annotation, draw a highlight or shape first. Then place your
text on top of it. Both the highlight and the annotation will then print on any output device, including
faxes.
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} To add text with the drawing tool

1. Select the  tool.

2. Drag your mouse to the image. The pointer will change to an insertion bar.

3. Position the + in the pointer at the point where you want to enter your text and click your
mouse.

4. Start typing your text. The text will appear on the screen as you type.

5. When you finish typing your text, either click your mouse again or press Enter . The text will be
changed to that of the currently selected annotation font.

} To add a new message with the note tool

1. Select the  tool from the tool bar. The Annotate Image dialog (fig. 26.2) will appear. All
saved messages for your system will be displayed.

2. To enter a new message, press . The Add Annotation dialog (fig. 26.3) will appear.

3. Enter your annotation text in the box.

4. Click . The box will close and your message will appear in the Annotate Image list.

5. To place the annotation in your text, do one of the following:

• Double-click on the message in the list.

• Highlight the message and click .

6. The annotation will appear in the upper left corner of the image. To position it where you want
it, do the following:

• Place your mouse pointer on the text. The mouse pointer will change to a .

• Drag the message to the place where you want to put it and release the mouse button.

Fig. 26.2. Annotate Image dialog box

Fig. 26.3. Add Annotation dialog
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Moving, Sizing, and Erasing Annotations

You can move your text or graphic annotations anywhere on your image or delete them from the
image. You can also resize your graphic annotations. You cannot resize text annotations.

} To erase an annotation object

1. Select the  tool.

2. Drag your mouse to the image. The pointer will change to an eraser.

3. Position the + in the pointer on the object you want to remove.

4. Click your mouse and the object will be removed from your image.

} To move an annotation object

1. If a drawing tool is selected, select the  instead.

2. Place your mouse pointer on the object. The mouse pointer will change to a .

3. Press your left mouse button and drag the object to the place where you want to put it.

4. When the object is where you want it, release the mouse button.

} To resize an annotation object

1. If a drawing tool is selected, select the  instead.

2. Place your mouse pointer on one of the object’s corners. The mouse pointer will change to a
diagonal arrow and a rubber band outline will appear around the object.

3. Press your left mouse button and drag your mouse to change the size of the outline.

4. When the outline is the size you want the object to be, release the mouse button. The object will
be resized to the size of the outline.

Using and Maintaining Stored Annotations

The note tool stores your annotations automatically. Therefore, it is useful for maintaining
annotations you frequently use. Once you create an annotation with the note tool, it is available for
use until you delete it.

} To insert an existing annotation

1. Select the  tool from the tool bar. The Annotate Image dialog (fig. 26.2) will appear. All
saved messages for your system will be displayed.

2. Select the annotation you want to insert and do one of the following:

• Double-click on the message in the list.

• Highlight the message and click .

3. The message will appear in the upper left corner of the image. To position it where you want it,
do the following:

• Place your mouse pointer on the text. The mouse pointer will change to a .

• Drag the message to the place where you want to put it and release the mouse button.
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} To edit an annotation

1. Select the  tool from the tool bar. The Annotate Image dialog (fig. 26.2) will appear. All
saved messages for your system will be displayed.

2. Highlight the message you want to edit and click . The current text of the message will
appear in the Add Annotation dialog box (fig. 26.3).

3. Make your changes to the annotation text.

4. Click . The box will close and your message will appear in the Annotate Image list.

Note: There is no link between the messages in the list and the documents you may have added them
to. If the text of the message is already inserted in the image you want to add the updated text to,
you will need to remove the old message and add the new one.

} To delete a stored annotation

1. Select the  tool from the tool bar. The Annotate Image dialog (fig. 26.2) will appear. All
saved messages for your system will be displayed.

2. Highlight the message you want to delete.

3. Click  and the message will be removed from the list.

4. To add the message to an image, follow the instructions above.

Changing the Annotation Text Font

You can also use the note function to change the annotation text font. The font you select will be in
effect for all text annotations until you change it. It will also affect text that you apply with the

 tool.

} To change the annotation text font

1. Select the  tool from the tool bar. The Annotate Image dialog (fig. 26.2) will appear. All
saved messages for your system will be displayed.

2. Click . The Font dialog (fig. 26.4) will appear.

Fig. 26.4. Font dialog box
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3. All fonts available on your system will be displayed in the box. To select your font, do the
following:

• Select the font name from the Font drop-down list.

• Select the style (bold, italic, etc.) from the Font Style list. Only valid styles for the font you
selected will appear.

• Enter the font size in the Size field. Common font sizes are listed for you to select from. If the
size you want is not in the list, enter it in the text box at the top.

4. Click  and the Font dialog box will close. All annotations you apply to your image from
now on will appear in the selected font. This includes notes applied with the text tool as well as
with the note tool.

5. Click  again to close the Annotate Image dialog.
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27 Requesting
Document Prints

If your system operates on a network, the program’s request functions permit user workstations
without microfilm readers to request documents from stations that have access to your microfilm
“library” and a microfilm reader. Stations that can process the requests are enabled as request
fulfilling workstations. Other stations on the network would be enabled as requesting workstations.
Requests made by requesting workstations are placed in a queue to be processed by request fulfilling
workstations. Requests can also be imported by request fulfilling workstations from workstations
that do not have VersaImage or VersaCAR.

The requests can be one of three types:

Return to Requestor The document is retrieved, printed, and returned to the requestor.

Mail To The document is retrieved, printed, and mailed. The request includes the
address and accompanying notes. An insert for the envelope containing
the recipient address and the notes is printed directly from the included
information.

Fax To The document is retrieved, printed, and faxed. The request includes the
fax number and fax notes. An accompanying fax cover sheet is printed
from this information.

Setting up Your Workstation

To use the request feature, the workstations on your network must be set up either as requesting
stations or request fulfilling stations.

} To set up your workstation

1. Select Preferences from the File menu. Then
select Workstation Setup (fig. 27.1).

2. When you make a selection, the Workstation
Setup dialog box (fig. 27.2) will appear.
Select one of the following as your
workstation type from the group of options:

Requesting Workstation

Request Fulfilling Workstation

27

Fig. 27.1. Selecting Workstation Setup

Fig. 27.2. WorkStation Setup dialog
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3. Next, you must set up a queue file. Press  and a dialog box for setting up your
queue file will appear. The Setup Queue File dialog box (fig. 27.3) looks and works like the
Open dialog box:

• Navigate to the directory where you want to place the queue file.

• Either enter a new queue file name or select one of the existing ones.

• Click . You will return to the WorkStation Setup dialog box.

4. Click  to complete your setup.

Note: Generally, for most setups, all workstations should be set up to use the same queue file on a
network server.

Making a Print Request

You can make a print, fax, or mail request from a requesting workstation.

} To open the print request dialog

1. Locate the record for the document you want in your database (see Chapter 23).

2. There are two ways to initiate your request:

• Click  on the tool bar. This button will appear whenever you do a search if you are a
requesting workstation.

• Select Make Request from the Request menu.

3. The Print Request dialog box (fig. 27.4) will appear.

Fig. 27.3. Setup Queue File dialog box

Fig. 27.4. Print Request dialog box
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} To request a copy of a document

1. Enter your name in the Requestor Name box.

2. Select Return to Requestor from the Return Via drop-down list.

3. Enter any notes you may want to make for the request fulfilling station in the Notes field of the
Print Request dialog box.

4. Click  and your request will be placed in the queue.

} To mail a document to a recipient

1. Enter your name in the Requestor Name box.

2. Select Mail to from the Return Via drop-down list. The dialog box shown in fig. 27.5 will appear.

3. Enter the following:

Name Name of recipient

Address 1, 2, 3 Mailing address

Notes Mailing notes to include with the document

4. Click  and you will return to the Print Request box. The recipient’s name will appear in
the box.

5. Enter any notes you may want to make for the request fulfilling station in the Notes field of the
Print Request dialog box.

6. Click  and your request will be placed in the queue.

} To fax a document to a recipient

1. Enter your name in the Requestor Name box.

2. Select Fax to from the Return Via drop-down list. The dialog box shown in fig. 27.6 will appear.

Fig. 27.5. Mailing Address dialog box

Fig. 27.6. Fax Information dialog box



208      VersaImage/VersaCAR/VersaView User’s Guide

3. Enter the following:

Fax Number Number of recipient’s fax line

Attention Recipient’s name

Fax Notes Notes to be included on fax cover sheet

4. Click  and you will return to the Print Request dialog box.

5. Enter any notes you may want to make for the request fulfilling station in the Notes field of the
Print Request dialog box.

6. Click  and your request will be placed in the queue.

Requesting a Group of Documents

If you have several documents in a database which are to be delivered to the same recipient, you can
request them all at once.

} To request a group of documents

1. Change to table display mode.

2. Select the documents you want to request by clicking on the box in the Hit column with your
mouse (fig. 27.7). To request the entire hit list, click Hit.

3. Either press  on the tool bar or select Make Request from the Request menu.

4. A message displaying the numbers of the items you requested will be displayed (fig. 27.8). To
process the requests, click .

Fig. 27.7. Hit list with several items selected for request processing

Shaded
items are
selected for
request
processing



Chapter 27 - Requesting Document Prints      209

5. The Print Request dialog box (fig. 27.4) will appear so that you can complete your requests.
The information that you enter for the request will be applied to each of the documents in the
group.

Processing Requests

Requests are processed through the request processing option.

} To initiate request processing

1. Select Process Requests from the Request menu. The Request Processing Sequence dialog box
(fig. 27.9) will open.

2. Select the sequence in which you want the request queue displayed and click .

3. When you select Process Requests, the request queue will be opened and the request processing
screen (fig. 27.10) will appear.

• The first record in the queue will be displayed on the screen.

• At the top of the screen is request information—the name of the requestor, the delivery
information (fax number, address, notes, etc.).

• Below this information is the database record.

When you initiate request processing, all of the request processing functions on the Request menu
will be enabled.

To process requests, you will need to do the following:

1. Print your request list and pick list.

2. Pull the rolls of film you need.

Fig. 27.8. Request group confirmation

Fig. 27.9. Request Processing Sequence dialog
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3. Find the frames to be printed, either manually on a reader or with your computer if your reader
is interfaced to it.

4. Make your copies and mail, fax, or return them to the requestor as requested.

5. Mark the completed requests done in the queue.

Printing the request list and the pick list

Your first step in processing requests should be to print your request list and your roll pick list.

The request list

The request list is not really a list at all. The Request List option prints one request sheet for each
request. The type of sheet printed depends on the request:

Mail To Prints an envelope insert containing the address, mailing notes, and the
roll and frame number of the document. The address will be displayed in
the window of a #10 window envelope.

Fax To Prints a fax cover sheet containing the fax number, recipient name, fax
notes, and the roll and frame number of the document requested.

Return to Requestor Prints a sheet with the requestor name, roll, and frame number, which can
be attached to the document and sent through interoffice mail.

These request sheets serve two purposes. You can use them to determine what documents to copy
and you can use them for the delivery of the document to the recipient.

Fig. 27.10. Request processing screen
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} To print your request list

1. Open the Request menu.

2. Select Reports from the Request menu (fig. 27.11).

3. Select Print Request List from the Reports menu
and the current requests in the queue will be sent to
your printer.

The roll pick list

If you do high volume request processing, you will find the roll pick list an indispensable aid. The
roll pick list simply lists the roll numbers of all requests in the queue so that you can pull all of your
rolls at once, then take them to the reader and process the requests in one sitting.

} To print your roll pick list

1. Open the Request menu.

2. Select Reports from the Request menu.

3. Select Print Roll Pick List from the Reports menu and the pick list will be sent to your printer.

Processing your documents

You do not need to have a reader that is interfaced to your computer to find your documents.
However, if you do have such a setup, you will be able to use VersaImage or VersaCAR to find
your frames automatically. If you do not, you can use the request sheets to find your documents.

} To process your requests from your computer

1. Click  to activate the controller (see Chapter 17 for more information on controller
operation).

2. The system will display each record in the order it was placed in the queue. You do not have to
process the requests in order. To page back and forth through the requests, use the following
buttons:

Displays the next record in the queue.

Displays the previous record in the queue.

3. For each request in the queue, do the following:

• Make sure that you have the correct roll for the request loaded.

• Press the  button on the controller panel. The reader will find and display the frame.

• Make your document copy.

• Mark the request “done” by clicking the Yes option in the Done box.

• Use  and  to find your next request.

4. When you finish processing requests, click End  or select Exit Request Processing from the
Request menu:

• All records you processed and marked Done will be deleted from the queue.

• Those that you have not marked Done will remain in the queue to be processed during your
next session.

} To process your requests manually

1. Use the request sheets to find your documents on your reader and make your copies.

Fig. 27.11. Reports menu
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2. When you finish making your copies, mark each request you completed done on your computer
as follows:

• Using the request sheet, find the request in the queue. Use  to page forward and 
to page backward.

• Click the Yes option in the Done box.

3. When you finish, click  or select Exit Request Processing from the Request menu:

• All records you marked Done will be deleted from the queue.

• Those not marked Done will remain in the queue.

Importing Requests

If you have an external program that can generate requests in a flat ASCII file, you can import them
into VersaImage or VersaCAR. This allows workstations that do not run VersaImage or VersaCAR to
make requests to a request fulfilling workstation that does. To do so, you will need to create a template
that maps the fields used in your import file to those used in a standard request in VersaImage or
VersaCAR.

Creating templates

To create a template, you must first open the request file you want to process. Then you must map
the fields in the request file to the VersaImage/VersaCAR request fields.

} To open your request file

1. Select Import Requests from the Request menu
(fig. 27.12).

2. Select Create Import Template from the Import
Requests menu. The Open dialog box will
appear.

3. Select the file containing the requests from the
Open dialog box and click . The dialog box
for creating your template (fig. 27.13) will appear. The fields required for the request are displayed
on the left side of the screen. The first record in your file will be displayed on the right:

Fig. 27.12. Import Requests menu

Fig. 27.13. Creating a template for importing requests
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• Fields 1 through 10 on the left map to the same fields on the request screen.

• The fields labeled Data1, Data2, etc. can be used for identifying data for the document (e.g.,
name, address, etc.). They will be displayed in the record information area of the screen.

} To map a field

1. Select the field by clicking on the field number on the left.

2. Define the field location in the record by doing one of the following:

• Selecting the field from the record by highlighting it with your mouse.

• Entering the starting location for the field in the From box and the field length in the Length
box.

• Entering the starting location for the field in the From box and the ending location in the To
box.

3. Click  and the data will be placed next to the field on the left.

Note: This screen works identical to the flat ASCII import screen described in Chapter 10. If you
would like more detailed instructions on selecting mapping your import fields on this screen, refer to
page 69 in that chapter.

} To create your template

1. Map fields 1 through 10 to the corresponding data in your record as instructed above.

2. Map your identifying data for the document to the remaining data fields.

3. When you are finished, click .

Importing the requests

You can import requests either manually or automatically in the background. If you turn on
background processing, requests will be imported and added to the queue as they are made. If you
import manually, you select the file you want to import. The imported requests will be placed in
your queue.

Note: If you have not created a template or if the system can’t find a template when you initiate your
report, you will be prompted to create a template first.

} To import requests manually

1. Select Import Requests from the Request menu.

2. Select Manually Import Requests. The Open box will appear.

3. Select the request file from the Open dialog box and click . Import processing will start.
During processing, you will see a progress message on the screen.

4. When it is finished, you will see a completion message. Click  to close the message box.

} To import requests in the background

1. Select Import Requests from the Request menu.

2. Select Start Background Import. Requests will be processed in the background and the menu
selection will change to Stop Background Import

3. To stop background processing, open the Import Requests menu and select Stop Background
Import.
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28 Working with
Multiple Databases

Like many Windows applications, VersaImage, VersaCAR, and VersaView permit you to open and
work with more than one database at a time. This can be quite handy when you need to edit or view
related records that are in different files. If you are image enabled, you can switch back and forth
among your databases to view your documents. (Technically, you could do this with your film
reader also, but it would be a little impractical as you would need to keep switching rolls.)

Opening Additional Databases

To open an additional database, simply select Open from the File menu without closing the database
you already have open. When you open a database, VersaImage/VersaCAR opens it in full screen
mode. Any other databases you have open will still be “there”, just not visible.

Changing Databases

To look at the list of databases you have open and switch to the one you want, you use the Window
menu.

} To change databases

1. Open the Window menu (fig. 28.1).

2. You will notice that at the bottom of the menu is a list of
the databases you have open. The currently active one is
checked.

3. To switch to another from the menu, do one of the
following:

• Click the one you want to switch to with your mouse.

• Type the number that is in front of the one you want to
switch to.

• Move the highlight to the one you want and press Enter .

Note: The hot keys Ctrl  + F6  can also be used to switch from database to database. This is prob-
ably the easiest way to do it if you only have two or three open.

Displaying Multiple Databases

You can display your open databases at once in cascaded or tiled format. This makes it easier to
switch from one to another and is sometimes useful when you need to compare records:

} To display all your databases

1. Open the Window menu.

2. Select the display option you want:

28

Fig. 28.1. Window menu
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Cascade Displays the open database as a series of cascading windows (fig. 28.2).

Tile Vertical Displays the open databases side by side vertically (fig. 28.3).

Fig. 28.2. Cascade display

Fig. 28.3. Vertical tile display
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Tile Horizontal Displays the open databases one on top of each other (fig. 28.4). Only the top of
the screen will show.

All of the windows are fully functional. The main menu, tool bar, etc. can be used with the active
window. You can set up searches, switch to and from table displays, etc. To activate a window, just
click on it with your mouse and its border will change to show it is the active one. In a cascade
display, the active window will move to the front of the “stack.”

Changing the Window Display Mode

You can switch back and forth between window and full screen mode. You can also minimize your
windows if you want to get a database out of the way temporarily without closing it.

} To change display modes with your mouse

Click the control buttons in the upper right hand corner of the window:

Displays the window in full screen mode.

Displays the database in window mode.

Minimizes the window.

} To change display modes with the keyboard

1. Use Ctrl  + F6  to change the active window if necessary.

2. Press Alt  +  - .

3. Select the mode you want from the control menu:

Maximize Displays the window in full screen mode.

Restore Displays the window in window mode.

Minimize Minimizes the window.

Fig. 28.4. Horizontal tile display
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Note: To restore a minimized window, either click on the  or  buttons with your mouse or use
the Window menu.

Sizing Windows

You may have noted that, because the windows are smaller than your original screen, you may not
see all of your fields. If you need to see more of the screen, you can make the window larger. When
you resize one window, it will not change the size of another. They will overlap. You can also
shrink a window if one is in your way.

} To size a window with your mouse

1. Place your mouse pointer on the window border as follows:

• To expand or shrink the window horizontally, place your pointer on either side border.

• To expand or shrink the window vertically, place your pointer on either the top or the bottom
border.

• To expand or shrink the window proportionally, place your pointer on one of the corners.

2. Hold your left mouse button down and drag your mouse. Pull outward to make the window
larger and inward to make it smaller. An outline of the resized window will appear.

3. When the window is the right size, release the mouse button.

} To size a window with the keyboard

1. Use Ctrl  + F6  to move to the active window.

2. Press Alt  +  -  to open the window command menu.

3. Select Size from the menu.

4. Press an arrow key to move the cursor to the side of the window you want to drag:

!! Moves to the left side.

"" Moves to the right side.

##  Moves to the top.

$$ Moves to the bottom.

!! , ## Moves to the top left corner.

!! , $$ Moves to the bottom left corner.

"" , ##  Moves to the top right corner.

"" , $$ Moves to the bottom right corner.

5. Use the arrow keys to expand and shrink your window:

!!  and "" Horizontal sizing

##  and $$ Vertical sizing

If you have diagonal arrow keys, you can expand and shrink the box proportionally.

6. When the window outline is the size you want, press Enter .
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Moving Windows

You can also move the windows around on the screen, just like you can with dialog boxes, and pile
them on top of each other. The active window will appear on top. As long as you can see a piece of
a window, you can click it to make it active. If a window gets buried, just press Ctrl  + F6  as often
as necessary until you “unbury” it (or use the Window menu to bring it to the top). If things get too
confusing, you can always return to the Window menu and start from square one again.

Closing a Database Window

To close a database window, you use the Close Database command on the File menu of the
application menu bar (the individual windows do not have their own menu bar). To close a
database, do the following:

1. Make the window active.

2. Select File. Then select Close Database.

Note: You can also close the database by clicking the  control button in the database document
window.
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29 Using the Film
QC Function

Making corrections to your film database records can be done easily through the QC Film Indices
This option is not available in VersaView. QC Film Indices is a very powerful function that lets
you make global corrections to your databases as well as to individual records. It allows you to
perform operations above and beyond modifying record data, which you can do through the search
screen. Through the QC function, you may adjust frame numbers, make changes to data across
records, add missing records, and delete records.

Starting the QC Film Indices Function

} To initiate the QC Film function

1. Open the database you want to work on.

2. Select QC Film Indices (fig. 29.1). The QC Roll dialog box will
appear (fig. 29.2).

3. Enter the number of the roll you want to QC and click .

4. If there are records for the roll in the open database, the QC index screen (fig. 29.3) will appear
in table format.

29

Fig. 29.1. Selecting the QC
Film option

Fig. 29.2. QC Roll dialog box

Fig. 29.3. QC screen
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All records in the database that are associated with the roll will be listed in frame number sequence.
Global operations on your database will be performed from this screen. For operations on individual
records, you can switch to single record mode.

The QC tool bar contains several buttons that are used for initiating the QC functions:

Adds a record to the database.

Makes global changes to a selected group of records.

Deletes a record.

Adjusts frame numbering.

Scans or rescans an image. Enabled for image-enabled databases only.

Adjusting Frame Numbering

If a mistake was made during indexing that caused the frame numbers on all or part of the roll to be
“out of sync,” you can adjust them easily through the Frame Adjust option. For single-level
indexes, Frame Adjust starts with the frame you specify and increments (or decrements) all
successive frames by the number you specify. For two-level indexing, Frame Adjust will adjust the
file (folder) number, but not the page numbers. If you have records for individual pages, they will
have to be edited manually.

} To adjust frame numbering

1. Click the  button on the tool bar. The Starting Frame dialog box (fig. 29.4) will appear.

2. Enter the number you want to start the adjustment with. The frame number of the currently
selected record in the table will be displayed by default.

3. Press  and you will be prompted for the offset. The offset is the number that will be added
to each frame during the adjustment.

4. Enter the offset and press  to make the adjustment.

Fig. 29.4. Starting Frame dialog box

Fig. 29.5. Frame Offset dialog box
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If the entire list did not need to be corrected, or if further correction is needed, you can select a
frame with a higher number and use Frame Adjust to make further adjustments.

Hint: Frame Adjust is designed for situations where you have a large number of incorrect frames. If
you only have a few, use the editing feature (see page 228) to change the records individually.

Making a Global Change

If you have made an “across the board error” in a large number of records, such as spelling a
company name wrong or entering the wrong date or roll number, you may correct it globally
through the Change All option.

} To make a global change

1. Select the field column where the data you want to change is located by clicking on the heading
at the top of the column. To select several sequential columns, hold Shift  down and click on the
first column and the last column you want to include.

2. After you select a column, the  button will be activated. Click  and the Change Records
dialog box (fig. 29.6) will appear.

3. In the Find What text box, enter the text you want to change.

4. In the Replace with text box, enter the replacement text.

5. If you want your search text (the text in the Find What box) to match case when it looks for the
text (e.g., find only “Company” and not “company”), check the Match Case check box.

6. Press one of the following to start your search:

If you want to confirm each change before it is made.

If you want to make replacements globally without confirmation.

7. If you select , the program will stop on each change and ask you to confirm it. Click on
one of the following:

Makes the change

Leaves it as is

Cancels the operation and exits from the function. Pressing  will not affect any
changes you have made up to that point.

Adding a Record

If a record for a frame was accidentally skipped, you can insert it into the database through the Add
option. The Add option also permits you to add “intermediate” records to a database that is
organized in subgroups. For example, suppose that in a two-level index, you have index records for
your file blips. However, within each group are a number of multi-page documents and you want to

Fig. 29.6. Change Records dialog box
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have separate index records for the first page of each to make retrieval easier. You can use Add to
insert these records into the database. If you are image enabled and there is an image in the database
for the record, you will need to enter the image address (i.e., the path and name of the index file) in
order for it to display when the record appears.

For single-level indexes with folders, a couple of cautionary notes might be in order. Adding a
record through QC does not create a new folder. Therefore, if you have already scanned and/or
indexed your roll, you can add intermediate records to the database within folders. You cannot,
however, create a new group. If you have not scanned images yet for the database but plan to do so
in the future, bear in mind that VersaImage will create a new folder for each record. Therefore, you
may want to wait until you have scanned the film before adding these records.

} To add a new record

1. Select the line in the table where you want to add the record.

2. Press the  button on the tool bar. A blank record will appear immediate below the line you
selected. The current roll number and next sequential frame will appear as defaults.

3. Either highlight the blank record and click  or double-click on the blank record line to display
the screen (fig. 29.7).

4. Enter the information for the new record into the fields on the screen. If the default frame
number is not correct, be sure to change it to the correct one.

5. When you finish, click  or press Enter  and the record will be added and you will return to
the table display.

Note: If the next sequential frame number is already in use, a message will be displayed when you
try to add the record line. You may need to use Frame Adjust to adjust the numbers of the frames
that follow after you add the record.

Fig. 29.7. Screen for adding a record. Note the default roll and frame number.
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Scanning and Rescanning Images

If your database is image enabled and you have a film scanner, you can insert missing images and rescan
badly scanned images through the QC function. When you rescan an image, it replaces the image you have
selected. When you scan an image, it adds the image to the record. If there is a folder file associated with the
record, it adds the document to the end of file. A special Scan and Insert function allows you to scan a
frame and insert it into a specific place in the file.

} To rescan an image

1. Make sure the page you want to replace is displayed on the screen.

2. Find the frame you want to scan on the roll.

3. Either click  on the tool bar or select Rescan from the Scan menu. The frame will be
scanned and replace the currently displayed image in your database.

} To scan and add an image to a record

1. Find the frame you want to scan.

2. If you are adding an image to a folder, make sure you are in thumbnail mode.

3. Either click  on the tool bar or select Scan Single from the Scan menu to scan the frame.

• If there was no previous image associated with the record, VersaImage places the file name in
the Image Address field.

• If the record has a folder file associated with it, VersaImage adds the new image to the end of
the folder.

Note: The  button performs a rescan if there is an image page displayed and a scan if there is
no image or if the pages are displayed in thumbnail view.

} To scan and insert an image

1. Find the frame you want to scan.

2. Zoom out to thumbnail view.

3. Move your mouse pointer to the image that is in the location where you want to place the
inserted image.

4. Click your right mouse button on the page number label to select the image. The label will be
highlighted to show the image is selected.

5. Either select Scan and Insert from the Scan menu or press F3  to scan the frame.

6. The frame will be scanned and the image will be inserted in front of the selected page.

Deleting Records

If a record has been added by mistake, you can delete through the QC function.

} To delete a record

1. Select the record you want to delete from the table. If you want to examine it first, double-click
on it to view it in single record mode. The delete function works from either screen.
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2. Either click the  on the tool bar or press Del  on the keyboard. The record will be displayed
in single-record mode and a confirmation message (fig. 29.8) will appear.

• If you want to delete the record, click  and the record will be removed.

• If you want to cancel the delete operation, click . The record will remain in the
database.

Note: You may need to use Frame Adjust to correct frame numbering after deleting a record.

Editing Records

You may edit any record in the database individually through the QC function. You can also do this
through the search screen. However, the QC function also allows you to change roll and frame
numbers and image addresses.

} To edit a record

1. Highlight the record you want to edit in the table.

2. Either double-click your mouse on the record or press the  on the tool bar to display the
record in single-record mode.

3. The current data in the record will be displayed on the screen. Make whatever changes you need
to make to the record.

4.  Click  to make the changes and return to the table screen.

Exiting from the QC Option

} To exit from the QC option

Do either of the following:

• Click  on the screen.

• Select Exit QC from the Index menu.

Fig. 29.8. Delete confirmation box



30 Using the
Image QC Function

Database records that are tied to images can be corrected through Image QC option. This option is
not available in VersaCAR or VersaView. Through Image QC, you can make global corrections to
your databases as well as to individual records. You may add, delete and rearrange images, split
image folders, make changes to data across records, and delete records.

The difference between Image QC and Film QC is the way the database records are selected from
the database. The Film QC function selects all records in the database for a given roll number with
or without an image address. The Image QC selects records from the database for a roll or batch
with an image address. Databases that are not associated with roll film can only be corrected through
Image QC. Databases associated with roll film that also have images can be updated through either.
However, the Frame Adjust feature is not available since the selected records will not necessarily
include all records for the roll.

Starting the Image QC Function

The Image QC function allows you to select either a batch to process or all records in the database
without an associated image.

} To initiate the Image QC function

1. Open the database you want to work on.

2. Select Image QC (fig. 30.1) from the Index menu. The Select
Batch/Roll dialog box will appear (fig. 30.2).

3. Do either of the following:

• Select the batch or roll you want to QC and click .

• Click  to select all records in the database without images.

4. The Image QC screen (fig. 30.3) will appear in table format:

• If you selected a batch or roll, all records in the database associated with the batch or roll will
be listed in sequence by their image address.

• If you selected No Image, all records in the database without images will be listed.

30

Fig. 30.1. Selecting the
Image QC option

Fig. 30.2. Select Batch/Roll dialog box
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The Image QC tool bar contains several buttons that are used for initiating QC functions:

Makes global changes to a selected group of records.

Deletes a record and the image(s) associated with the record.

Scans or rescans the currently displayed image.

In addition to these buttons, most of the standard tool bar buttons displayed when you search your
database will also be available. Some of them are only available in single record mode. You will be
able to rotate, deskew and annotate images. You will not, however, be able to apply the image
correction options. They must be applied through the search screen.

Making a Global Change

If you have made an “across the board” error in a large number of records, such as spelling a
company name wrong or entering the wrong date, you may correct it globally through the QC
Change All option.

} To make a global change

1. Select the field column where the data you want to change is located by clicking on the heading
at the top of the column. To select several sequential columns, hold Shift  down and click on the
first column and the last column you want to include.

2. After you select a column, the  button will be activated. Click  and the Change Records
dialog box (fig. 30.4) will appear.

Fig. 30.3. Image QC screen
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3. In the Find What text box, enter the text you want to change.

4. In the Replace with text box, enter the replacement text.

5. If you want your search text (the text in the Find What box) to match case when it looks for the
text (e.g., find only “Company” and not “company”), check the Match Case check box.

6. Press one of the following to start your search:

If you want to confirm each change before it is made.

If you want to make replacements globally without confirmation.

7. If you select , the program will stop on each change and ask you to confirm it. Click on
one of the following:

Makes the change

Leaves it as is

Cancels the operation and exit from the function. Pressing  will not affect any
changes you have made up to that point.

Deleting Records

If a record has been added by mistake, you can delete it through the Delete Record option

} To delete a record

1. Select the record you want to delete from the table. If you want to examine it first, double-click
on it to view it in single record mode. The delete function works from either screen.

2. Click the  button on the tool bar. The record will be displayed in single-record mode and a
confirmation message (fig. 30.5) will appear:

• If you want to delete the record, click  and the record will be removed.

• If you want to cancel the delete operation, click . The record will remain in the
database.

Fig. 30.4. Change Records dialog box

Fig. 30.5. Delete confirmation box
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Removing Images without Deleting Records

You can clear the images from the records without deleting the records themselves. You can clear
all records in the batch globally or you can clear just a single record.

Deleting all images from your records

Global deletion may be useful in cases where the wrong images were indexed to the wrong records
or the wrong database. After they are removed, the records are no longer associated with the batch.
The batch of images may be reimported and reindexed and the records can be associated with a
different batch of images.

} To remove all images from the batch

1. Select the Image Address column in the table.

2. Click the  button on the tool bar.

3. A message box (fig. 30.6) asking for your confirmation will appear:

• To delete all records, press .

• To cancel the delete function, press .

Deleting individual images

When you delete individual images, they are deleted from the batch. You can no longer access them.

} To remove a single image from a record

1. Select the record you want and either click the  button or
double-click on the record display to it.

2. Tab to the Image Address field and press Del  on the keyboard.
A confirmation message (fig. 30.7) will appear.

3. Click  to delete the image. A message asking if you want
to change the image address will appear.

4. Click .

Important: When you press the Del  key, VersaImage assumes that you either want to delete the
value from the field or the image. If you click  in response to the Delete Image message, the
address will be removed but not the image. If you click  in response to the Change Image
Address prompt, the image will be removed but not the address.

Fig. 30.6. Image Address Delete Confirmation Message

Fig. 30.7. Delete image confirma-
tion

Fig. 30.8. Change image address confirmation
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} To remove an image from a folder

1. Zoom out to thumbnail view.

2. Select the image or images you want to delete by clicking on the page number labels with your
right mouse button:

• To select one image, right-click on the label of the image.

• To select more than one image, press Ctrl  and right-click on the labels of each image you
want to delete.

• To select consecutive images, hold Shift  down and right-click on the label of the first image
you want to delete. Then right-click on the label of last image you want to delete.

3. Press Del . A confirmation message (fig. 30.9) will appear:

• To delete your selected images, click .

• To cancel the delete operation, click .

Important: The delete function does not return images to the to-be-
indexed list. However, the Select Split Type function (see page
235) can remove images from a folder for reindexing.

Scanning Images

While in QC mode, you can scan and rescan images. This allows you to insert missing images and
rescan badly scanned images during QC operations. When you rescan an image, it replaces the
image you have selected. When you scan an image, it adds the image to the record. If there is a
folder file associated with the record, it adds the document to the end of file. A special Scan and
Insert function allows you to scan a frame and insert it into a specific place in the file. These
options are identical to the ones available from your search screen. However, a toolbar button has
been added to allow you quicker mouse access to the Scan and Rescan options.

Note: The  initiates the Rescan function if there is a page displayed and the Scan Single
function if there is no page displayed or if you are in thumbnail view.

} To rescan an image

1. Make sure the page you want to replace is displayed on the screen. If you are in thumbnail view,
left-click on the page you want to rescan to display it.

2. Place the page you want to scan in the scanner.

3. Do one of the following:

• Click the  button on the tool bar.

• Select Rescan from the Scan menu

• Press F6 .

4. The page will be scanned and replace the currently displayed page in your database.

} To scan and add an image

1. Place the page you want to scan in the scanner.

2. Do one of the following:

• Click the  button on the tool bar.

Fig. 30.9. Confirmation message for
deleting images from folders
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• Select Scan Single from the Scan menu

• Press F5

3. The page will be scanned and one of the following will happen:

• If there was no previous image associated with the record, VersaImage places the file name in
the Image Address field.

• If there was a single image previously associated with the record, VersaImage creates a folder
file and places both images in the folder file.

• If the record has a folder file associated with it, VersaImage adds the new image to the end of
the folder.

} To scan and insert an image

1. Place the page you want to scan in the scanner.

2. Zoom out to thumbnail view.

3. Right-click on the page number label of the image you want to select. The label will be
highlighted to show the image is selected.

4. Either select Scan and Insert from the Scan menu or press F3  to scan the page.

5. The page will be scanned and inserted in front of the selected page.

Rearranging Your Images

You can cut and paste images in your folders to rearrange them in a given folder or move them to
another folder. You can also copy an image to another folder. This allows you to place the same
image in more than one folder.

} To move an image to a different location in a folder

1. Display your folder in thumbnail view.

2. Hold Ctrl  down and left-click your mouse on the page number label of the image you want to
select.

3. To select additional images, keep Ctrl  pressed and left-click on the labels of any images you
want to add to the group.

4. Either open the Edit menu and select Cut or press Ctrl  + X  on the keyboard. The image will
remain displayed but its label will be grayed out.

5. Press Ctrl  and left-click your mouse on the image that is located in the position where you want
to put the new image.

6. Either open the Edit menu and select Paste or press Ctrl  + V  on the keyboard. The image will
be moved to this position and placed in front of the selected image.

} To move an image to a different folder

1. Display your folder in thumbnail view.

2. Hold Ctrl  down and left-click your mouse on the page number label of the image you want to
select.

3. To select additional images, keep Ctrl  pressed and left-click on the labels of any images you
want to add to the group.
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4. Either open the Edit menu and select Cut or press Ctrl  + X  on the keyboard. The image will
remain displayed but its label will be grayed out.

5. Click  to return to table-display mode and find the record you want to move the image to.

6. Either double-click on the record or click  to display it in single-record mode.

7. Either open the Edit menu and select Paste or press Ctrl  + V  on the keyboard. The image will
be placed at the end of the folder.

} To place a copy of an image in another folder

1. Display your folder in thumbnail view.

2. Hold Ctrl  down and left-click your mouse on the page number label of the image you want to
select.

3. To select additional images, keep Ctrl  pressed and left-click on the labels of any images you
want to add to the group.

4. Either open the Edit menu and select Cut or press Ctrl  + C  on the keyboard.

5. Click  to return to table-display mode and find the record you want to copy the image to.

6. Either double-click on the record or click  to display it in single-record mode.

7. Either open the Edit menu and select Paste or press Ctrl  + V  on the keyboard. The image will
be placed at the end of the folder.

Splitting Folders

The folder splitting function allows you to remove images from a folder and add them to the to-be-
indexed list as single images, folder files, or multi-page TIFFs.

} To split a folder

1. Display your folder in thumbnail view.

2. Right-click on the page label of the first image you want to select.

3. To select additional images, do either of the following:

• If the pages are consecutive, hold Shift  down and right-click on the label of the last page you
want to select.

• If the pages are not adjacent, hold Ctrl  down and right-click on the labels of the pages you
want to select.

4. After you have selected your pages, press F12 . The Select Split Type dialog box (fig. 30.10)
will appear.

Fig. 30.10. Select Split Type dialog box
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5. Select the type of split you want:

• If you select Copy Selected Images to new File Folder, a new folder file will be created for
the selected group of images with same name as the first image in the folder. The folder will
be added to the to-be-indexed list.

• If you select Copy Selected Images to new Multi-Image TIFF, a multi-image TIFF file will
be created. The new file will be placed in the batch folder and added to the to-be-indexed list.

• If you select Copy Selected Images as single TIFFs, each image will be added to the to-be-
indexed list as a TIFF file. If the pages are in a multi-page TIFF image, new TIFF files will
be created for them.

6. Click . The images will be removed from the folder and returned to the to-be-indexed list.

Editing Records

You may edit any record in the batch individually through the QC function. You can also do this
through the search screen. However, the QC function also allows you to change roll and frame
numbers and image addresses.

} To edit a record

1. Highlight the record you want to edit in the table.

2. Either double-click your mouse on the record or press the  on the tool bar to display the
record in single-record mode.

3. The current data in the record will be displayed on the screen. Make whatever changes you need
to make to the record.

4.  Click  to make the changes and return to the table screen.

Exiting from the Image QC Option

} To exit from the QC option

Do either of the following:

• Click  on the screen.

• Select Exit QC from the Index menu.



31 File Maintenance
Functions

VersaImage and VersaCAR provide you with built-
in functions to perform both routine maintenance and
recovery for your databases. The Repair Database
function repairs a corrupted database. The Compact
Database function compacts your database to opti-
mize disk space. These functions are available from
the Maintenance submenu (fig. 31.1), which is ac-
cessed from the File menu.

Note: Before you can open the Maintenance menu,
you must close all databases.

To run Repair Database, you must first obtain a
repair code from Image Vision technical support.
To run Compact Database, you must obtain a com-
pact code. These codes must be obtained each time
you use the function.

Repairing a Database

If a database ever becomes corrupted, you may be able to repair it instead of restoring it.
Database corruption does not occur as a general rule. However, if the system goes down while
you are working on a database or if there is a power failure or interruption, it is possible that the
database will be corrupted as a result. If it is, a message will appear when you try to open it again
to indicate that it has been corrupted. In this case, you can use the Repair Database function to
try to repair it.

Reminder: Don’t forget to obtain your repair code from Image Vision before you run this function.

} To repair a database

1. Close any databases you have open.

2. Select Maintenance from the File menu.

3. Select Repair Database from the Maintenance menu. You will be prompted for the repair code
(fig. 31.2).

4. Enter your repair code and click . The Repair Database dialog box (fig. 31.3) will
appear.

31

Fig. 31.1. Maintenance menu

Fig. 31.2. Repair Code prompt for Repair Database function
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5. Select the database you want to repair from the box and click  to begin the database repair.

6. When the repair is finished, you will see a completion message (fig.
31.4). Click  to exit from the function.

7. To find out if the repair was successful, open the database.

Note: This function can take from one minute to several hours
depending on the size of your database.

Compacting a Database

The Compact Database function optimizes your disk space by removing “gaps” left by deleted
records and compressing your file. This function should only be run after a large number of records
have been deleted from the database. It is not necessary or advisable on a regular basis.

Reminder: Don’t forget to obtain your compact code from Image Vision before you run this function.

} To compact a database

1. Close any databases you have open.

2. Select File from the menu bar. Then select Maintenance.

3. Select Compact Database and you will be prompted for the compact codes (fig. 31.5).

4. Enter your compact code and click . The Compact Database dialog box (fig. 31.6) will
appear.

Fig. 31.3. Repair Database dialog box

Fig. 31.4. Completion message

Fig. 31.5. Enter Compact Code
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5. Select the database you want to compact from the box and click . The message shown in
fig. 31.7 will appear.

6. Click  to start compacting the database.

7. When it is done you will see a completion message (fig. 31.8). Click  to exit from the
function.

Note: If your database is large, the procedure may take awhile.

Fig. 31.6. Compact Database dialog box

Fig. 31.7. Ready to compact message

Fig. 31.8. Compact Database completion message
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32 Exporting
Files

VersaImage and VersaCAR databases are unique to VersaImage and VersaCAR and cannot be used
by other applications except Microsoft Access. However, you can export your database files to
either a flat ASCII file or a comma-separated file. If your other applications can read either of these
types of files, this feature can eliminate the need for duplicate entry in cases where you need the
same data for other applications. You can also export image folders as multi-image TIFF files for
use in other applications or for archiving purposes. When you export database records, you can
create a new file or you can append your exported records to an existing file. This allows you to use
the export feature to archive records periodically.

Important: Although you can read VersaImage and VersaCAR databases in Microsoft Access, they
should not be modified in Access or unpredictable results may occur.

Exporting to an ASCII Flat File

When you export to a flat ASCII file, you can export your entire database or you can select a
specific hit list of records to export with the search function. You can, for example, specify a
particular roll, a range of invoices, or a specific customer.

Specifying your source and destination

To export to a flat ASCII file, you must open the database you want to export from and specify a
destination file for your exported data. You may optionally narrow down your records to a specific
hit list.

} To select your records and export destination

1. Open the database you want to export from.

2. If you do not want to export your entire database, select your records as follows:

• Enter the search criteria that will find the records you want.

• Click .

• Check the hit list to make sure the search yielded the result you wanted.

3. Select Export from the Tools menu.

4. Select Flat ASCII File from the Export menu (fig. 32.1).

The SaveAs dialog box (fig. 32.2) will appear.

32

Fig. 32.1. Selecting Flat ASCII File from the Export dialog box
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5. Find the folder where you want to save the exported file. If the folder does not exist, you may
create it (see Chapter 4 if you don’t know how to do this). Make sure the folder name is
displayed in the Save in box.

6. Enter the destination file name:

• If you are creating a new file, enter the file name in the File name text box. The extension
.TXT is suggested, but you should use whatever extension your application recognizes.

• If you are replacing an existing file or appending records to an existing file, click on the file
name to select it. Its name should appear in the File Name box.

Reminder: If the file you are replacing or appending to does not have a .TXT extension, select All
files from the Files of type list so all files will appear in the list.

7. Click and the Export to ASCII File dialog (fig. 32.3) will appear.

Fig. 32.2. Save As dialog box

Fig. 32.3. Export to ASCII File dialog
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Selecting fields to export

The left side of the screen contains the fields in the record and data from the first record in the data-
base. The right side contains your export options and a field for your export record. You do not
have to export all fields in the database record, only the ones you need. You can also specify the
order in which you want the fields exported. This allows you to tailor your data to specific
applications.

When you define your export record, select your fields in the order you want them placed in the
export record. If you need to insert extra space or characters in your record at certain points to
conform to record structure requirements, you can insert a fixed field of a specific length and fill it
with a character string. If you plan on exporting from this database more than once, you can create
an export template for your file. Then you will not have to define your record again.

Hint: It is highly recommended that you create a template if you will be exporting from this database
periodically and appending the records to an existing export file. Then you know the record structure
will always be the same.

} To select fields to export

1. On the left side of the screen, click the number of the field you want to export.

2. Click . A dialog box for entering the field length will appear. The field length
defined for the database will appear as a default:

• If the field is a numeric or date field, the dialog will contain a Length field and a Format
field (fig. 32.4).

• For other types of fields, the dialog will only contain the Length field (fig. 32.5).

3. Change the field length if necessary. If you enter a length that is shorter than your database field,
your data will be truncated to fit if necessary.

4. If the field is a numeric or date field, select the Format type.

5. Click . The data for that field from the first record in your file will be added to the export
record displayed on the right. The record length will be incremented accordingly.

Fig. 32.4. Select Export Format dialog with Format field

Fig. 32.5. Select Export Format dialog with Length field only
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} To add a fixed field

1. Click . The Fixed Field Definition dialog (fig. 32.6) will appear.

2. Enter the number of characters you are adding in the Field Length field.

3. Enter the character string in the Field Contents field. If you want space only, leave it blank.

4. Click . The fixed field will be added to the export record on the right.

Note: The next field you choose to export will be added immediately after your fixed field.

} To create a template

1. Select all the fields you want to export but do not start the export.

2. Click . The Save Export Template dialog (fig. 32.7) will appear.

3. By default, the template will be given the same name as your database:

• If you want to change it, change the file name in the file name field.

• Do not change the extension! The template must have the extension .TPX to be recognized as
an export template.

4. Click  to save the template.

Hint: If you will be exporting from this database periodically and will generally use the same
template, save it with the same name as the database (the default name). Then it will always be
opened for you when you export.

Fig. 32.6. Fixed Field Definition dialog

Fig. 32.7. Save Export Template dialog
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} To redefine an export record

1. Click  to remove all fields from the current export record.

2. Select the fields for the new export record.

Exporting a file

When you export your file, you may export your entire file or you may export your hit list only.
You may also delete the records you export from your VersaImage or VersaCAR database. This
makes it possible to archive older records or remove records you no longer actively need.

} To export the file

1. Either select the fields you want to export or click  to open the template that
contains your field definitions.

Note: If there is a template file with the same name as the database and a .TPX extension, it will
automatically be opened for you. You may change it or redefine the fields if necessary before you
export. To clear the current export record and start over, click .

2. Select your export options:

• If you only want to export the records in your hit list, check Export Hit List Only. This
option will be grayed out if you did not select a hit list.

Warning: If you do not check Export Hit List Only, your entire database will be exported, even if
you created a hit list first.

• If you want the records you export deleted from your VersaImage or VersaCAR database,
check Export with Delete. Note that to use this option, you must export a hit list.

3. Click  to start the export.

4. If the file you are exporting to already exists, you will be asked if you want to append the
records to the end of the existing file (see fig. 32.8):

• To add the exported records to the file, click .

• To overwrite the exiting file, click .

5. During the export, you will see a progress message on your screen.
When the export is finished, a completion message will appear (fig.
32.9). Click .

Exporting to a Comma-separated File

When you export to a comma-separated file, you may export the entire file, export records from a
hit list only, or export records for selected batches of images. The latter is available from image-
enabled databases only.

Fig. 32.8. Append to file message

Fig. 32.9. Export completed
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Selecting your source and destination

To export to a comma-separated file, you must open the database you want to export from and
specify the destination file. If you do not want to export the entire file, you will need to select the
records or batch you want to export.

} To export a hit list or your entire database

1. Open the database you want to export from.

2. If you do not want to export your entire database, select your records as follows:

• Enter the search criteria that will find the records you want.

• Click .

• Check the hit list to make sure the search yielded the result you wanted.

3. Select Export from the Tools menu.

4. Select Comma Separated File from the Export menu (fig. 32.10).

The SaveAs dialog box (fig. 32.11) will appear.

5. Find the folder where you want to save the exported file. If the folder does not exist, you may
create it (see Chapter 4). Make sure the folder name is displayed in the Save in box:

• If you are creating a new file, enter the file name in the File name text box. The extension
.CSV is suggested, but you should use whatever extension your application recognizes.

• If you are replacing an existing file, click on it to select it. Its name should appear in the File
Name box.

6. Click and the Export to Comma Separated File dialog box (fig. 32.12) will appear.

Fig. 32.10. Selecting Comma Separated File from the Export dialog box

Fig. 32.11. Save As dialog box
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} To select specific batches to export

1. Open the database that contains the index records for the batches you want to export.

2. Select Export from the Tools menu.

3. Select Multi Batch CSV Export from the Export menu. The Special Export dialog box (fig.
32.13) will appear so you can select the batches you want to export.

4. To select your batches, do the following:

• Highlight the batch in the list on the left.

• Click  and the batch will be placed in the list on the right.

5. To remove a batch from your selection, do the following:

• Highlight the batch in the list on the right.

• Click  and the batch will be removed from the list.

6. When you finish selecting your batches, click . The Save As dialog box will appear.

Fig. 32.12. Export dialog box for comma-separated file

Fig. 32.13. Special Export dialog
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7. Find the folder where you want to save the exported file. If the folder does not exist, you may
create it (see Chapter 4). Make sure the folder name is displayed in the Save in box:

• If you are creating a new file, enter the file name in the File name text box. The extension
.CSV is suggested, but you should use whatever extension your application recognizes.

• If you are replacing an existing file, click on it to select it. Its name should appear in the File
Name box.

8. Click  and the Export to Comma Separated File dialog (fig. 32.12) will appear.

Selecting the fields to export

The left side of the export screen contains the fields in your record and the data from the first record
in the database. The right side contains your export options and a field for your export record. You
do not have to export all fields in the record, only the ones you need. You can also specify the order
in which you want the fields exported. This allows you to tailor your data to specific applications.

When you define your export record, select your fields in the order you want them placed in the
export record. If you plan on exporting from this database more than once, you can create an export
template for your file. Then you will not have to define your record again.

Hint: It is highly recommended that you create a template if you will be exporting from this database
periodically and appending the records to an existing export file. Then you know the record structure
will always be the same.

} To select the fields for export

1. Click the number of the field you want to export on the left side of your screen.

2. Click :

• If the field is a numeric or date field, a dialog box will appear (fig. 32.14) so you can select
the format for export. Select your field and click . The data for the field from the first
record will be placed in the export record on the right.

• For other types of fields, the data will be moved to the export record on the right when you
click .

} To create a template

1. Select all the fields you want to export but do not start the export.

2. Click . The Save Export Template dialog (fig. 32.15) will appear.

3. By default, the template will be given the same name as your database:

Fig. 32.14. Select Export Format dialog with Format field
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• If you want to change it, change the file name in the file name field.

• Do not change the extension! The template must have the extension .TPX to be recognized as
an export template.

4. Click  to save the template.

Hint: If you will be exporting from this database periodically and will generally use the same
template, save it with the same name as the database (the default name). Then it will always be
opened for you when you export.

} To redefine an export record

1. Click  to remove all fields from the current export record.

2. Select the fields for the new export record.

Exporting the file

The records that will be exported when you export your file depend on the options you selected
before you opened your export dialog:

n If you did not select a hit list, your entire file will be exported.

n If you selected a hit list, you can either export the hit list or your entire file.

n If you selected batches for export, only records for those batches will be exported.

} To export the file

1. Select the fields you want to export or click  to open the template that contains your
field definitions.

Note: If there is a template file with the same name as the database and a .TPX extension, it will
automatically be opened for you. You can change it or redefine the fields before you export. To clear
the record and start over, click .

2. If you selected a hit list and want to export the hit list only, check Export Hit List Only. This
option will be unavailable if you did not select a hit list or are exporting batches.

Warning: If you do not check Export Hit List Only, your entire database will be exported, even if
you created a hit list first.

Fig. 32.15. Save Export Template dialog
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3. If you are exporting a hit list or batches and want the records you export deleted from your
VersaImage or VersaCAR database, check Export with Delete. This option will be unavailable
if you export your entire database.

4. Click  to start the export.

5. If the file you are exporting to already exists, you will be asked if you want to append the
records to the end of the existing file (see fig. 32.16).

• To add the exported records to the file, click .

• To overwrite the existing file, click .

6. During the export, you will see a progress message on your screen.

7. When the export is finished, a completion message will appear (fig.
32.17). Click .

Exporting Images

Exporting your images “as is” to use elsewhere needs no special function. You can easily copy them
to another drive, folder, or machine through Windows Explorer. However, there may be times
when you want to export image folders as multi-image TIFFs for use with other applications or to
archive. You can do this through the Multi-Image TIFF Export function. This function creates one
image file for each record. File folders are converted to multi-image TIFF files.

} To export images

1. Open the database containing the images you want to export.

2. Select Export from the Tools menu.

3. Select Multi Image TIFF Export from the Export menu. The Select Batch dialog box (fig.
32.18) will appear so you can select the batch you want to export.

Fig. 32.16. Append to file message

Fig. 32.17. Export completed

Fig. 32.18. Selecting a batch to export
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4. Highlight the batch you want to export and click . The Enter Export Path dialog box (fig.
32.19) will appear.

5. Select the folder where you want to save the exported files.

6. Click  and the image files will be saved in the folder you selected.

Fig. 32.19. Enter Export Path dialog box
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33 Exporting to CDs and
Other Removable Media

VersaImage contains functions that allow you to export your files and images to CD and also to use
your databases with images stored on CD or other removable media. CDs are a good way to make
documents available to independent workstations running VersaView. They are also excellent for
archiving purposes.

Exporting to CD

There are a number of reasons you may want to export your databases to CD. For one thing, it is an
excellent way to archive or back up large databases, complete with images. You can also use them
to make your databases available to independent workstations running VersaView. Regardless of the
reason, the VersaImage program will facilitate the CD export procedure.

Since there are many different manufacturers of CD-R (CD recording) equipment, VersaImage was
designed to “pre-master” the CD but not to actually write the CD. Most CD-Rs have an associated
hard drive where an image of the CD is placed. The VersaImage program writes your files to the
CD-R hard drive. The CD authoring software is then used to build the CD from the CD-R’s
dedicated hard drive.

} To export to CD

1. Open the Tools menu.

2. Select Build CD Image (fig. 33.1) from the Tools menu. The dialog
box shown in fig. 33.2 will appear.

3. Select the path to your CD-R’s hard drive (NOT to the CD itself) and click . The Build
CD dialog box will be displayed (fig. 33.3).

4. Select your format for the CD:

VersaView To use VersaImage or VersaView.

SimpliFiler To use with SimpliFiler.

5. To select batches, do the following:

33

Fig. 33.1

Fig. 33.2. Set Path to CD Hard Drive dialog
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• Click on the batch in the list on the left. To select consecutive batches, keep your left mouse
button pressed and drag your pointer over the batches you want to select.

• Click  and the selected batches will move to the list on the right.

6. To remove a selected batch, highlight the batch on the right and click .

7. When you have selected all the batches to copy, click  and VersaImage will copy the
batches.

Note: If there are any batches that are not completely indexed (images with no data), you will get a
warning message asking if you wish to proceed with the batch. If you answer No, the batch will be
skipped.

The CD will have a directory structure with a .CSV file in the root directory, a subdirectory
named the same as the Volume ID, and subdirectories in that directory for the batches selected.
For example, if the Volume ID entered was DISK0001 the following file structure will be created:

F:\DISK0001.CSV (Index file in Root Directory)
F:[DISK0001]

DISK0001 (subdirectory)

BCH00001 (first batch)
00001001.tif (TIFF images)

.

.
00001999.tif

BCH00002 (second batch)
00002001.tif (TIFF images)

.

.
00002999.tif

This is the directory structure that needs to be created on your CD. If you are using part of your
main hard drive to create the CDs, be sure to create the above directory structure on the CD itself.

Fig. 33.3. Build CD Image dialog box
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Using Images from Your CDs

If you have limited disk space, you can use the images for the CDs you’ve created with a database
that is on your hard drive. This allows you to remove older batches of images from your hard drive
after they are archived to CD but still access them from your database on your system. To do this,
you create your CD as described above. Once the CD is created, you delete the batches from your
hard drive and rebuild the database without the images through the Register CD function. After the
database is rebuilt, the image addresses in your database records will point to the image files on the
CD.

} To delete your batches

1. Open the database where the batches you want to delete are located.

2. Select Delete Batch from the Index menu. The dialog box shown in fig. 33.4 will appear.

3. Select the batches you want to delete as follows:

• To select a single batch, click on it with your mouse.

• To select consecutive batches, click the first batch you want to delete. Then hold the Shift  key
down and click on the last batch.

• To select non-consecutive batches, hold Ctrl  down and click on each batch you want to
delete.

4. When you are finished, click . The message shown in fig. 33.5 will appear.

5. Click  to delete the batches.

} To rebuild your database

1. Open the database where you want to rebuild the records.

2. Insert the CD containing the database records and images into your CD-ROM drive.

3. Select Register New CD from the Tools menu. The Register CD dialog box (fig. 33.6) will
appear.

Fig. 33.4. Selecting batches to delete

Fig. 33.5. Delete Batch confirmation
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4. Select your CD Drive from the CD Drive list box. The volume ID for your CD will be displayed
in the Volume ID field.

5. Click  to build your database records from the CD.

Moving Images to External Media

If disk space is limited, images can also be stored on removable media such as optical disks, Zip
drives, SyQuest drives, etc., and used with databases that are resident on your system. To do this,
you first scan and index your images. Then you move them to the removable drive. After the images
are moved, the image address will contain the path to the removable drive instead of the old address.

Note: Your removable drive must have a volume ID (i.e., label) for this procedure to work as
VersaImage uses this label in the image address. VersaImage will not start the move unless there is
a volume ID.

} To add a volume ID

1. Open Windows Explorer and navigate to your removable drive.

2. Right-click on the drive to open the context menu.

3. Select Properties from the menu.

4. On the General page, enter the volume ID in the Label field.

5. Click .

} To move your images

1. Open the database where the images you want to
move are indexed.

2. Select Move Images from the Tools menu. A
dialog for selecting your path (fig. 33.7) will
appear.

3. Select the path to your removable disk and click
. The Move Images dialog box will be

displayed (fig. 33.8).

4. To select your batches, do the following:

• Click on the batch in the list on the left. To
select consecutive batches, keep your left mouse
button pressed and drag your pointer over the
batches you want to select.

• Click  and the selected batches will move to the list on the right.

Fig. 33.6. Register CD dialog

Fig. 33.7. Enter Move Path dialog
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5. To remove a selected batch, highlight the batch on the right and click .

Note: As batches are added to the list, the totals at the bottom of the Batch/Roll to Move list will be
updated.

6. When you are finished, click . The images will be removed from your hard drive. The
image addresses in the index records will be changed to point to the image files on the removable
drive.

Fig. 33.8. Move Images dialog




